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Painter 4 Overview
Fractal Design PainterÆ is the worlds leading paint program for graphic designers. With Painter, 
you can simulate the tools and textures of Natural-MediaÆ, create amazing image-editing 
compositions, do frame-by-frame animations, design Internet graphics and create multi-user 
collaborative artwork. In addition, Painter integrates beautifully with Adobe Photoshop, Adobe 
Illustrator and Macromedia Freehand through its extensive import and export capabilities.

In Painter, youll find all your traditional artists supplies, from felt pens, charcoal, and colored 
pencils to watercolor and oils. As image-editing software, Painter provides many powerful options 
that let you sharpen, soften, and distort scanned photographs, apply marbling, or make your 
image appear as if it were viewed through glass. Painter includes a robust set of Bezier drawing 
tools for creating and modifying PostScript artwork. And Painters compositing skills let you float 
images--grouping, layering, and ordering them fluidly in a dynamic design environment. 

Our new Net-Painter features provide the first environment for collaborative art creation. Multiple 
users can log into a network session, and take turns creating a single design. Artists can work 
with art directors over the Internet and make changes to a concept in real-time.

The Makeup of a Painter Image
Painter has several components that allow you to create a complex image. Lets examine the 
structure of an image to get a basic feel for what these components are. Each concept will be 
described in more detail throughout the User Guide.

Composite Image
The Composite Image is what you see on your screen and is also what you will get when you 
print the file. It is the sum of the canvas, floaters, masks and any adjustments you may have 
made to them. 

Canvas
The Canvas is the visual foundation of your image. It is the base layer where you can paint, select 
areas, fill and apply effects. If you create a new file and start to paint, youll be painting on the 
canvas.

Canvas Mask
Because the Canvas is a bitmap layer, the canvas is always a square or rectangular space. The 
Canvas Mask is used to mark off areas of the canvas and define a variable shape area. The 
mask will tell Painter which parts of the canvas to protect and which parts to utilize.

The Masking brush and selection tools are used to create the canvas mask. Masking off areas of 
the canvas allows for special effects and compositing options. 

Objects
In addition to the canvas, a Painter image can contain independent elements called Objects. 
Although they are different, they share some common characteristics.

Objects are separate from the canvas and from each other.
Objects can be manipulated individually or in groups.
Objects can be named.
Objects are tracked and managed from one of the Object List palettes.

Painters objects include Selections, Shapes and Floaters.

Selections
Like masks, Selections are drawn to isolate areas of the canvas so you can fill or apply effects 
inside or outside of the boundary. Selections are really just another way of looking at masks.
Selections appear in your image as moving dotted lines, commonly known as marching ants or 
marquees. They can be generated using automatic tools or hand-drawn using the Lasso, Pen or 
Quick Curve Tools. Unlike masks, selections can be stored on the Paths List.



Floaters
Floaters are bitmapped image elements that hover above the canvas. You use the Floater 
Adjuster Tool to click inside a selection and float the selected part of the canvas. The selection 
hovers above the canvas so that it can be moved around and edited independent of the canvas. 

Floater Mask
Every floater automatically has a Floater Mask when the floater is created. Like the canvas, a 
floater would have a rectangular shape. Its the Floater Mask that allows the floater to have a 
unique variable shape.
By default, the floater will conceal the canvas underneath, but you can make changes to the 
Floater Mask to define parts of the floater as transparent. 

Shapes
Shapes are vector objects that hover above the canvas. Shapes can be stroked, filled or layered. 
Like any of the popular vector illustration programs, Shapes are created by drawing paths with the 
Pen or Quick Curve Tools.



Getting Acquainted with Painter
This section outlines Painters interface and basic functionality. The following discussion gives you 
an overview of Painters tools. Youll see what different palettes are available for you to use. Youll 
see how you can work with palettes and how to access the controls they hold. Youll learn how to 
use Grids, Rulers and Guides, how to navigate the Help system and how to set your preferences. 

Painter's Interface
Painters interface consists of several elements, including floating palettes. Floating palettes are 
the compressed palettes you see when the program starts up--the Tools, , Brushes, Art Materials, 
Objects and Controls palettes. These palettes contain Painters main controls for document 
creation.

The Document Window
Before reading this section, make a new document to view the document window. Choose File 
menu> New and click OK, accepting the default settings of the dialog box.

View Buttons
The View Buttons are located in the upper-right corner of the document window. The View 
Buttons include: Tracing Paper, View Grid and Mask Edit Mode.

Tracing Paper
The Tracing Paper button allows you to toggle Painters Tracing Paper feature on and off by 
clicking once on the button. Before you can use Tracing Paper, you must have an image you 
would like to trace as the source image. 

View Grid
Painter has an invisible grid you can use as a guide. The grid can be set up in a variety of ways. 
The View Grid button allows you to toggle the grid on and off by clicking once on the button. You 
may also choose Canvas menu> Guide> View Grid. 

Mask Edit Mode
Clicking once on the Mask Edit Mode button allows you to toggle between viewing and hiding 
Painters mask layers. By default, when you click the Mask Edit Mode button you will view the 
canvas mask. If a floater is selected, you will view the selected floaters mask. You may also 
choose Canvas menu> View Mask. 

The Mask Edit Mode is different from the View Mask Visibility button. The View Mask Visibility 
button allows you to view the mask as a red color in the RGB file. The Mask Edit Mode allows you 
to view only the mask in grayscale. This grayscale representation of the mask can be treated like 
its own image--apply effects to it, fill it with patterns or a gradation for unique effects.

You must generate a mask to view a change in the mask. 

For more information about Painters masking features, see Selections and Masks.

Drawing and Visibility Buttons
As you use Painter, there are modes that are always on. The Drawing and Visibility Buttons 
represent these modes.

You can access the Drawing and Visibility buttons at the bottom-left corner of the image window. 
Click and hold to see the button settings pop-up. The Drawing and Visibility buttons are also 
available in several different locations in the program including the Objects: P. List Palette.

The Drawing buttons determine how drawing and painting interacts with a selection or mask (not 
at all, inside or outside). The Visibility buttons describe how you will view a selection or mask (not 
at all, view mask, view selection).



Tools Palette
Painter puts a variety of tools at your fingertips. Many of them are familiar tools you already use, 
brushes and erasers, for example. In the Tools Palette, you can find tools for mark making, filling 
with color, viewing and navigation, path drawing and a variety of selection tools. If the Tools 
Palette is not displayed on your screen, you can display it by choosing Window menu> Tools.
 
A second palette, the Controls Palette contains options for the current selected tool. The Controls 
Palette updates as you select different tools to reveal the selected tools options. If the Controls 
Palette is not displayed on your screen, you can display it by choosing Window menu> Controls.

Some tools of similar function share a space on the Tools Palette. The icon for only one of these 
tools will be visible at a time. To select one of the other tools, press and hold on the icon that is 
visible. The tool icons pop-up under your cursor, so you can choose the tool you want. 

When one of these tools is selected, its companions are offered in the Controls Palette. You may 
also click these tool icons to switch between tools.

Magnifier Tool
Grabber Tool
Rotate Page Tool
Lasso Tool
Adjuster Tools
Brush Tool
Paint Bucket Tool
Dropper Tool
Selection Tools
Text Tool 
Shape Design Tools
Shape Objects Tools
Shape Selection Tools
Shape Edit Tools

See Also:
Palettes
Using Items in Palettes
Palette Drawers



Magnifier Tool (Zooming)
The Magnifier Tool allows you to magnify areas of an image when you are performing detailed 
work, or reduce them to get an overall view of an image. Click to zoom in, or hold the option key 
and click to zoom out. You can also use the Controls Palette to set the zoom level. 

Shortcut: You can use the Magnifier Tool while another tool is selected. Hold down x-Spacebar to 
zoom in and Option-x-Spacebar to zoom out.



Grabber Tool
The Grabber Tool gives you a quick way to scroll an image. You may also set the zoom level on 
the Controls Palette when the Grabber Tool is selected.



Rotate Page Tool
The Rotate Page Tool is used to rotate an image window to accommodate the way you draw 
naturally. You may also set the zoom level on the Controls Palette when the Rotate Page Tool is 
selected.

Shortcut: Hold down the Spacebar + Option keys to display the Rotate Page cursor. Continue to 
hold it down as you rotate the page with your stylus or mouse. To return the page to its original 
position, hold down the Spacebar + Option keys and click once in the image window. To constrain 
page rotation to 90 angles, hold down the Spacebar + Option + Shift keys while rotating 
the page.



Adjuster Tools
The Floater Adjuster Tool and the Selection Adjuster Tool are both used to select and manipulate 
objects.

The Floater Adjuster Tool
The Floater Adjuster Tool allows you to select and adjust floaters and shapes. Floaters and 
Shapes are image elements that float above the background. The Controls Palette lets you 
change opacity, feather edges, and choose compositing methods.

The Selection Adjuster Tool 
The Selection Adjuster Tool lets you select and manipulate selections. The Controls Palette 
provides feathering options for selections. 



Brush Tool
The Brush Tool is used to paint strokes on the canvas or a floater. Set Opacity, Grain, and 
Drawing Style (Freehand or Straight Lines) in the Controls Palette.



Paint Bucket Tool
The Paint Bucket Tool lets you fill an area. The Controls Palette shows choices for
 what area to fill and what to fill it with. 



Dropper Tool
The Dropper Tool lets you pick up a color from an existing image for use elsewhere. The Controls 
Palette shows you values for the color. When you select a color with the Dropper tool, that color 
becomes the current color on the Color Palette.



Selection Tools
The Selection Tools select an oval or rectangular area. When you create an selection, the 
coordinates are displayed on the Controls Palette.

Rectangular Selection Tool
The Rectangular Selection Tool allows you to create rectangular selections.

Oval Selection Tool
The Oval Selection Tool allows you to create oval selections.



Text Tool
The Text Tool defines text shapes. Use the Controls Palette to choose a font, point size and set 
tracking. If you want to use a text selection, create the text as a shape and convert it to a 
selection.



Shape Design Tools
The Pen Tool and the Quick Curve Tool are used to draw shapes. You can choose to close a 
shape or convert it to a selection on the Controls Palette.

Pen Tool
The Pen Tool lets you draw shapes and selections of two styles: Straight Lines and Bezier curves.

Quick Curve Tool
The Quick Curve tool lets you create shape paths by drawing freehand lines.



Shape Objects Tools
The Shapes Objects tools create rectangular or oval shapes. When you create a shape, the 
coordinates are displayed on the Controls Palette.

Rectangular Shape Tool
The Rectangular Shape Tool allows you to create rectangular shape objects.

Oval Shape Tool
The Oval Shape Tool allows you to create oval shape objects.



Shape Selection Tools
The Direct Selection Tool and the Whole Shapes Selection Tool are used to arrange and 
manipulate shapes.

The Direct Selection Tool
The Direct Selection Tool allows you to adjust points and line segments of shapes.

The Whole Shape Selection Tool
The Whole Shape Selection Tool allows you to manipulate shapes as a whole.



Shape Edit Tools
The Shape Edit Tools allow you to manipulate existing shapes.

Scissors Tool
The Scissors tool allows you to cut a segment. Once you click on a line or point to cut the path, 
the path becomes open.

Add Point Tool
The Add Point tool allows you to create a new anchor point. To add a point, click on a line 
segment.

Remove Point Tool
The Remove Point tool allows you to remove an anchor point from a shape path. Click on a point 
to remove it.

Convert Point Tool
The Convert Point tool allows you to convert between smooth and corner anchor points. Click and 
drag on a point to convert it.



Palettes
Painters controls are organized into palettes. Painter opens the first time with its five main 
palettes showing: Tools, Controls, Brushes, Art Materials and Objects.

Take a moment to look at the differences between the five palettes. The Tools and Controls 
Palettes are main palettes without drawers. The Brushes Palette is a main palette with pull down 
menu options and a drawer containing brushes. The Art Materials and Objects Palettes are main 
palettes that hold several subpalettes, with pull down menu options for each subpalette. To 
understand this better, lets examine each main palette.

The Tools Palette determines your current activity. For example, you use this palette to 
tell Painter whether you want to draw, zoom in on a document, or select part of an image.

The Controls Palette changes to reflect your selection in the Tools Palette and to give you 
instant access to the selected tools main functions. For example, when you have selected 
the Magnifier Tool, the Controls Palette shows zoom levels.

The Brushes Palette is where you choose from Painters wealth of drawing, painting and 
image editing brushes. Brushes can be moved from inside the palette drawer to the 
drawer front.

The Art Materials Palette is where you select your art materials, from the basics--like a 
color for your pencil--to unusual patterns and complex color gradations. The subpalettes 
of the Art Materials Palette are Color, Paper, Grad (Gradations), Pattern and Weave.

The Objects Palette is for performing Painters sophisticated compositing and advanced 
painting functions. The subpalettes of the Objects Palette are P. List (Path List), F. List 
(Floater List), Scripts, S. List (Script List) and Network.

See Also:
Rearranging Palettes
Viewing and Hiding Palettes
Viewing Additional Palette Controls
Using Items in Palettes
Palette Drawers
Tearing Off Palettes
Cleaning Up Palettes



Rearranging Palettes
You can drag a palette to any location thats convenient for your work. You can also stack palettes 
together to save space. When palettes are moved in close proximity, they will snap together.

Painter saves your palette arrangement, including locked items, so that it appears as you left it, 
the next time you start the program.



Viewing and Hiding Palettes
You can hide a single palette by clicking the close box in the upper left corner. You can display a 
palette by choosing its name from the Window menu or using the key combination shown on the 
Window menu.

To hide all the palettes, choose Window menu> Hide Palettes or press x-H. Choose 
Window menu> Show Palettes or press x-H again to redisplay all the palettes that were on the 
screen.



Viewing Additional Palette Controls
Many of Painters palettes have additional controls that can be displayed or hidden, depending on 
the task at hand. If you have opened a subpalette, you can expand it by clicking the grow box in 
the palettes upper right corner. For example, the Color Wheel can be expanded to display the 
Color Variability sliders. Click the grow box again to hide them.



Using Items in Palettes
To select an item from the front of a palette, click the items icon.

A red outline appears around the icon you have selected. If you have clicked on an icon 
representing a subpalette, the palette expands giving you the options for that subpalette. 
For example, when you click the Paper icon on the Art Materials Palette, the palette 
appears along with a drawer that has choices for different types of paper. You can 
collapse this subpalette by clicking its icon again.

To select a menu item from the front of a palette, choose it from a menu above an icon.

If this results in opening a subpalette, you would click the close box in the upper left 
corner to close it. For example, the Floater Palette can be opened by selecting it from the 
menu above the F. List subpalette and closed by clicking the close box.



Palette Drawers
You can open the drawer of a main palette or subpalette to see the other items inside the drawer. 
The pushbar indicates which palettes or subpalettes have drawers.

Storing items in closed drawers gives you more screen space. You will keep items on the drawer 
front that you use most often and retrieve other items when you need them. For example, you 
would keep the most often used paper textures on the front of the Paper subpalette. You would 
open the papers drawer to retrieve a paper texture you use occasionally.

To retrieve items from inside a drawer, open the drawer by clicking the pushbar. (A down arrow on 
the pushbar means the drawer can be opened). You can click anywhere on the pushbar to open 
and close a drawer. There are three options for retrieving items from drawers.



Tearing Off Palettes
There are times when youll want to work with palettes that usually arent available at the same 
time. For example, you might want to work simultaneously with the Color and Paper subpalettes. 
Normally choosing one from the Art Materials Palette replaces the other. But you can tear off as 
many palettes as you like. Just drag an icon off the main palette. The palette pops open as you 
drag it. Remember that one subpalette must remain displayed in the main palette. The selected 
palette will remain so you must drag one of the other palettes. If you want to tear off the current 
selected palette, select a different palette first. When you no longer need the palette, just click the 
close box in the upper left corner.Tools Palette:usingTools Palette:usingTools 
Palette:usingTools Palette:usingpalettes:tearing offpalettes:tearing 
offpalettes:tearing offpalettes:tearing offtearing off palettestearing off 
palettestearing off palettestearing off palettes 



Cleaning Up Palettes
You can choose [Window menu]> [Clean Up Palettes] to stack palettes in their collapsed state 
along the edge of the screen.



New Features in Painter 4
At Fractal Design Corporation, we strive to create the best, most feature-filled and usable 
software that we can. Painter 4 is our most ambitious and astounding version yet, with dozens of 
new artistic and production features that will absolutely WOW you!

Here are some of    Painter 4's new features:

Natural-Media Tools and Supplies
Painter contains a wide array of artist supplies that work just like their real-life counterparts. Brush 
types include pens, pencils, chalks, scratchboard tool, rakes, watercolor, as well as bristly 
brushes that paint with multiple dabs of paint. In combination with Painters paper textures, you 
can achieve an incredible variety of different looks. And if you need even more flexibility, brushes 
can be tweaked and finessed to produce an infinite number of new variations.

Combine Painters brushes and paper textures with another of Painters powerful features cloning 
and you can re-create an image in an entirely new medium. Turn a photograph into an oil painting 
or re-render your photo in the style of Van Gogh.

To make drawing even more natural, Painter 4 lets you rotate the on-screen page just as you 
would turn a sketchbook to suit the natural angle of your hand and arm. You can also enhance 
your images in Painter 4 with customizable gradations and patterns. Choose from an extensive 
gradations palette, or create your own, and quickly apply linear, sweep, circular, and spiral 
gradations. Our new patterns palette lets you create, store and scale seamless patterns. You can 
also make your own weaving designs in Painters virtual loom and use them as fills and 
backgrounds.

True to its heritage, Painter 4 includes some Natural-Media technologies that must be seen to be 
believed. The new Mosaic feature lets users design imagery in the style of historic tile mosaics. 
Start with a blank canvas or work from an existing photograph, and simply paint with mosaic tiles. 
Each tile is an independent object that knows about every other tile, and carves its shape so that 
it fits perfectly with existing tiles. Tiles can be erased and/or reshaped to create the perfect 
mosaic design.

Image Editing
Having an almost a limitless choice of painting tools and art supplies is just one aspect of Painter. 
Painters powerful image-editing capabilities make it possible to control the focus and orientation 
of an image and change its surface texture. Image Warp and Quick Warp, can distort the surface 
of an image as if it were a sheet of pliable film. Selective masking and color adjustment tools let 
you base selections on color and adjust a selections edge feather based on hue, saturation, or 
value. Our new Correct Colors command provides one of the most powerful, flexible tonal 
controls in any image editor.

Painter also contains the amazing Image Hose--one of the most unique tools ever found in a 
graphics application. The Image Hose paints with pictures instead of paint, casting a series of 
images with every brush stroke. It can create random natural and man-made textures or ordered 
tiled patterns. Even Video for Windows movies can be sprayed through the image. Painter 4 
allows Image Hose elements (or nozzles) to be stored in convenient scaleable libraries for 
immediate access.

Powerful Vector Editing Tools
Painter 4 includes the revolutionary, Shapes vector-editing technology. Shapes provides a 
complete vector drawing environment making Painter a combination image-editing/draw program. 
These tools operate similarly to those in Adobe Illustrator and Macromedia Freehand. Unlike 
traditional draw programs, however, Shapes renders anti-aliased vector objects, giving them a 
smoothness and quality not achievable in typical draw programs. In addition, PostScript objects 



can be made semi-transparent, or converted to bitmap floating selections and painted on.

Complex Compositions
In Painter, image editing isnt limited to special effects. Painter supports multiple floating 
selections--called floaters. Floating design elements allow for a totally flexible visual environment. 
Layer floaters, change the order of layers, group floaters, and ungroup them. Vary the 
transparency of each floater, feather it, and use masking brushes to refine or adjust the character 
of a mask. In addition, Shapes objects can be grouped and interleaved with Painters bitmapped 
floaters, allowing you to create artwork which would be impossible to author any other way.

Make Movies with Painter
Painter 4 is great for animators and video editors, with its ability to perform rotoscoping and 
frame-by-frame animations. Import AVI files, edit individual frames or apply Painters prerecorded 
sessions to multiple frames. Two-to-five-layer onion-skinning lets you see multiple frames, before 
and after the current frame. 

Net-Painter
Painter 4 is the first product to enable collaborative artwork creation. Using Painter 4s new 
networking feature, multiple users can log into a single artwork session and take turns using any 
of Painters brushes or effects across the artwork. Network Painter can work over the Internet, on 
local area networks, or on any connection that supports TCP/IP. Use Net-Painter to create design 
with other artists, or collaborate with an art director to get real-time feedback on your designs.

Web Painter
Painter 4 contains a variety of features crafted for the development of Internet graphics. You can 
create seamless background patterns and save images in GIF and JPEG formats with support for 
interleaved and transparent GIF images. In addition, Painter 4 can create Image Maps--graphics 
with embedded hot spots--for use in Web page designs. You can tag any floating selection as 
an Image Map element and give it a Web URL. When you save the image as a GIF or JPEG 
image the floating selections are used to create the click-able boundaries of the Image map 
elements. If you want to rearrange elements in your Image Map, simply open up your Painter file 
and move the floaters.



Libraries
A library is a saved collection of similar tools that can be loaded into a palette. For example, 
Painters built-in brushes (and their variants) are contained in the default brushes library, which is 
loaded when you launch Painter. As you customize brushes and other resources, you can save 
them into you own libraries.

Libraries are available for paper textures, patterns, gradations, weaves, brushes, brush looks, 
nozzles, paths, floaters, and scripts. You may have any number of libraries, but only one (of each 
type) will be open at a time. When you want other tools, you can load the alternate libraries. 

Libraries allow you to extend Painters tools and resources, without overloading the palette 
drawers.

The methods for working with all libraries are the same. You can create new libraries, add 
resources, and move items between libraries.

Its a good idea to limit the number of resources in a library. This makes it easier to find a 
particular tool and helps Painter manage memory.

See Also: 
Adding Resources to the Current Library
Customizing Libraries
Movers: Moving Items between Libraries
Modifying a Library
Default Libraries



Adding Resources to the Current Library
As you are working with Painter and create new resources, you can save them to the current 
library. The command for adding a resource depends on its type. In some cases, you click a Save 
button. In others, you choose a menu command. And in the case of paths and floaters, you drag 
them from the image into the library palette.

The method of adding a particular resource to the library is described in Customizing Libraries.

Loading Alternate Libraries
When you want to use the resources of a different library, you can load it.
When you save a resource, Painter puts it in the current library. If this is not where you want it, 
you should switch libraries before saving the resource. You can move items between libraries, but 
switching libraries before saving the resource will spare you that step.



Customizing Libraries
The tools for creating libraries and managing their contents are contained in the Movers. A Mover 
is provided on the palette menu for each resource supported by libraries--papers, patterns, 
gradations, weaves, brushes, brush looks, nozzles, paths, floaters, and scripts. 

To open the Brush Mover, for example, choose Brushes Palette: Brushes menu> Brush Mover.



Creating a New Library
Its a good idea to save libraries in the same place. This makes them easy to locate and load 
when you want them.

The new librarys name appears on the right-hand side of the Mover window. The area above the 
name is blank because this new library is empty. To put things in it, you can move them from 
other libraries.



Movers: Moving Items between Libraries
Movers copy resources from the library open on one side of the window to the library open on the 
other side. 

When you open a Mover, the resources of the current library are listed on the left. Often, this is 
the library youll want to move from. If not, you can open a different library as the source. Click 
Close to close this library, then click Open and select a different library file.

Open the destination on the other side. (If you just created a new library, it will be open--if not, you 
may open an existing library. Click Open and select a library file.)

When the source library is open on one side and the destination library is open on the other, you 
are ready to move resources.



Modifying a Library
WARNING>> Be careful when deleting a resource from a library. If you remove one of 
Painters default brushes by mistake, the only way to retrieve it is to reinstall Painter. 
When you reinstall Painter, youll lose any of the custom resources youve created. 

Deleting a Library
To delete an entire library, use the Windows 3.1 File Manager or the Windows 95 Explorer.



Default Libraries
When you launch Painter, the program loads the default libraries. If you would prefer to work from 
other libraries, you can change the default. Default libraries must be located in the folder with the 
Painter application program.

In the Libraries portion of the Preferences window, enter the file names for the libraries with which 
you want Painter to start.



Rulers

Ruler Options
To set the ruler units: Choose Canvas menu> Rulers> Ruler Options. You may also hold down the 
Option key and click in the ruler to bring up the Ruler Options dialog.

Use the pop-up to choose the units you want: Pixels, Inches, Centimeters, Points, or Picas.

Snap to Ticks
Each mark in the ruler is called a tick. If you want the guides you create to land precisely on the 
tick marks, choose Canvas menu> Rulers> Snap to Ticks.

Changing the Origin
Normally, the origin (0, 0) is in the top left corner. Sometimes you might want to choose a different 
origin to assist in measuring between points.

To change the origin: Drag from the box where the horizontal and vertical rulers meet down and 
right to the point in the document you want as the origin. When you release the mouse button, the 
ruler will update to describe this point as the zero.

This applies to the ruler only--not to floater placement or other location features.

To restore the top, left corner as zero, double-click the box where the horizontal and vertical rulers 
meet.



Guides
Guides are non-printing lines that help you align objects, like shapes and floaters.

After creating a guide, you can drag it (by its triangular marker) to any point on the ruler. To 
remove a guide, drag its marker off the edge of the document.

Guide Options
Each guide has an options dialog that lets you move it to a particular point and change its color.

If you want to lock a guide, enable the Locked Guide option. This makes the guide un-draggable. 
Youll need to open the guides options dialog again to unlock it.

You can clear all guides by clicking the Delete All Guides button.

Snap to Guides
If you want drag and click operations to snap to the guides, choose Canvas menu> Guides> Snap 
to Guides.

The following operations respect Snap to Guides:

Dragging with the Rectangle and Oval selection tools.
Drawing straight lines with the Brush Tool.
Clicks made with the Pen Tool.
Clicking with the Text Tool to create a text entry point.
Clicking and dragging with the Paint Bucket Tool and Magnifier Tool.
Dragging floaters, shapes, and selection paths. The edges of the floater rectangle and the 
selection rectangle for the shapes and paths snap to the guides. The cursor--wherever it might be 
in the object--also snaps to the guide.
Dragging the handles of floaters, shapes, and paths to scale or slant (skew) them.
Dragging with the Path Adjuster or Floater Adjuster tool to create a selection marquee.



Grid Overlay
 Painter has a grid layer to help guide you when laying down brush strokes or creating shapes. To 
activate the grid, choose Canvas menu> Grid> View Grid, or click the View Grid button on the 
right side of your image window. Your image now has a non-printing grid.

When you paint or draw with the grid turned on, youll see your brush strokes at 50% opacity. 
When you turn off the grid, the strokes will be at 100% opacity. To have 100% opacity when the 
grid is turned on, choose the Transparent Background option under Grid options. 

Grid Options
You can set up the grid to suit your working style by choosing Canvas menu> Grid> Grid Options. 
You can tab between the following fields:

Grid Type
Choose a command from the pop-up menu to determine whether your grid will be rectangular, 
have just vertical or horizontal lines, or be made up of small dots.

Horizontal Spacing
Determines the amount of space between horizontal lines. The unit of measure can be in pixels, 
inches, centimeters, points, picas, columns, or percent. Each column is equivalent to two-inches. 
Percent refers to the percentage of the images width/height. For example, if the user chooses 
10% for width and height in a 100 X 120 pixel image then grid lines will appear every 10 pixels 
going across (vertical lines) and every 12 pixels going down (horizontal).

Vertical Spacing
Determines the amount of space between vertical lines.

Line Thickness
Sets the width of grid lines.

Grid Color
Click the color square to change the color of the grid lines. Choose a color in the color picker, 
then click OK or press Return. The default color is a light blue.

Background
Click the color square to change the grids background color. Choose a color in the color picker, 
then click OK or press Return. The default color is white.

Transparent Background
Click Transparent Background if you want the grid to be transparent so that your image will 
appear at 100% opacity when the grid is turned on.



Setting Painter Preferences
Painter has several different preference dialogs:

General Preferences
To display the general Painter preferences dialog box, choose Edit menu> Preferences> General.

Cursor Setup
Painter gives you many choices for the appearance of your cursor. To choose whether the cursor 
will be a triangle or a single pixel, check the radio button next to Drawing Cursor. To determine 
the direction the cursor will point (depending on your design and whether youre left- or right-
handed), click the appropriate button in the circle above Orientation. To select a cursor color that 
will contrast with your working area and will therefore be clearly visible, click the appropriate 
rectangle above Color.

Setting the Default Libraries
Painter provides several libraries that contain many different brushes, paper grains, paths, 
floaters, and color sets, and you can create your own. By typing a file name in the text box next to 
Brushes, Papers, Paths, Floaters, and Color Set, you can designate which files will appear in 
drawers when you open Painter.

Choosing a Default Scratch Disk
To select the disk volume that Painter will put its temporary file on and will virtualize to, choose 
the volume name from the Temp File Volume pop-up menu. 

Auto-Save Scripts
While you create an image, Painter automatically saves your commands in a new script. The 
scripts are saved in the Objects Palette: Script List. The Auto Save Scripts preference governs 
how long scripts are saved before they are deleted.

Floater Pre-Feather
The Floater pre-feather box determines how much you can feather a floater. The default setting is 
16 pixels, making this the maximum setting allowed for the Feather slider in the Controls Palette: 
Adjuster Tools. You can change this default to any number up to 50. The change takes effect the 
next time you launch Painter.

Cloning Preference
When you clone an image, Painter uses the color information from the original as you fill in your 
clone. If you would like Painter to display what part of the original youre cloning, check the box 
next to Indicate clone source with cross hairs while cloning. 

Draw zoomed-out views using area-averaging
When looking at an image at less than 100% view, screen draw is faster if you leave this option 
unchecked, and slower but more accurate if checked.

Display warning when drawing outside selection
Checking this box enables the warning that appears when you draw outside a selection. The 
warning will not appear if this box is unchecked.



Pressure Sensitivity
When you draw with natural media, the amount of pressure you use with a tool determines how 
dense and how wide your strokes are. Using a pressure-sensitive stylus with Painter gives you 
this same kind of flexibility. How much each of us bears down on a drawing or painting tool is 
different. In Painter, you can actually program the computer to react to your individual touch just 
by dragging in the Brush Tracking dialog box. 

To display the Brush Tracking dialog box, choose Edit menu> Preferences> Brush Tracking.

To set how sensitive the stylus will be to your hand pressure and speed, move the stylus across 
the scratch pad area at a normal speed and with a normal amount of pressure.

Just as your signature varies, so will the way you work with the stylus at any given time, so youll 
set up Brush Tracking each time you start Painter. When you exit Painter, the Brush Tracking 
sliders go back to their default settings. 



Customizing Painter
Fractal Design has chosen colors and textures for Painters interface that we think are 
aesthetically pleasing and very legible. However, you may want to experiment with your own 
interface colors and textures.

You may save your interface preferences by clicking the Save button in the bottom right of the 
Interface Preferences dialog box. A directory box appears asking you to name the interface. Give 
it a descriptive name and click Save.

Plug-in Preferences
 Before Painter can display your plug-ins in the Effects menu, you must indicate where your plug-
ins are located on your hard drive. Choose Edit menu> Preferences> Other Raster Plug-ins. Then 
locate and select a plug-in in the dialog box. Painter will look for your plug-ins in only one folder, 
so you should keep all of your plug-ins in one folder. Once you show Painter where your plug-ins 
are, it will remember this location every time it starts up. Painter will need to be re-started to 
access plug-ins. 

Multiple Undo Levels
Undo levels apply across open documents. With five levels set, if you have two documents open 
and you have undone three operations on the first document, you can only undo two operations 
on the second. 

WARNING>> Multiple Undo can use a significant amount of disk space. If you perform multiple 
operations on the entire image, the whole image must be saved for each undo step. Thus, be 
very judicious with the number of Undo levels you choose to save. 

Shape Preferences
You can set the default fill and stroke in the Shape Preferences dialog. If you check Big Handles, 
the curve handles will appear enlarged. You may find it easier to work with them in the larger size. 
You can also specify colors for the wing color, point color and outline color 



File Formats
Painter has its own file format called RIFF. RIFF files have special properties. A RIFF will maintain 
floating objects so you can return to the file to rearrange floaters and shapes. As long as you have 
a RIFF file of a Mosaic, you can continue to edit, resize and render tiles at a higher resolution. A 
RIFF file will maintain watercolors in the wet layer so you can return to a file in a wet state. When 
you work in Painter, you should always work in RIFF format and save finished work in other 
formats.

Compatibility
Painter works with images created in other programs. It supports Fractal Designs own RIFF 
format, as well as TIFF, PICT, GIF, JPEG, PCX, BMP, and Targa formats. You can import files 
from Adobe Photoshop 3 and convert Photoshops layers into Painters floaters and visa-versa. 
Painter 4 even reads and writes files in Illustrator 5 format (supported by both Adobe Illustrator 
and Macromedia Freehand). You can access third-party raster plug-ins, such as Kais Power Tools 
and vector plug-ins such as KPT Vector Effects, from within Painter.



Creating a New Document
When you create a new document, you set the picture width and height, as well as the resolution, 
paper color, and picture type (Image or Movie). The resolution you choose will depend mainly on 
your output device.

Create a new document by choosing File menu> New. The New Picture dialog box appears. 

Canvas Size
The Canvas Size shows how much RAM the document requires. The saved size of the document 
is roughly one-half to one-fourth of this number, depending on how many colors are present in the 
document. A document with fewer colors or more white space can compress more than a 
document filled with many colors.

Setting Width and Height
When you begin a new document, the width field is highlighted in the dialog box. You can use the 
Tab key to move from field to field.

Choosing a unit of measurement 
The default settings are in pixels. You can change the measuring units by using the pop-up menu. 
Choose from pixels, inches, centimeters, points, picas and columns. Columns are two-inch 
columns, and you can indicate how many columns wide and tall youd like your image to be.

To set the width and height for a new document, enter a value for Width and a value for Height in 
the dialog box.

Setting Resolution 
Resolution refers to the number of dots per inch (dpi) that make up an image. When you enter a 
value for Resolution, there are three kinds of resolution to consider:

The monitors resolution, measured in pixels. Painter is preset to 75 pixels per inch. The 
resolution of your monitor may be different.

The documents resolution. You can assign the resolution when an image is scanned or 
when one is created in Painter.

The output devices resolution, measured in dpi, and, in the case of halftones, lines per 
inch (lpi). Output-device resolutions vary depending on the press and paper youre 
printing on. Generally, a photograph to be printed on glossy magazine stock will be output 
at a crisp 150 lpi, and at 85 lpi for more porous, and therefore more forgiving, newspaper 
stock.

In the New Picture dialog box, setting the documents pixels per inch is the same as setting its dpi. 
The default resolution setting of 75 pixels per inch means that your documents dpi will also be 75. 
The image on -screen at 100% is the size it will be when its output. On most printers, 75 dpi 
renders a coarse image, so you may want to choose a higher resolution value.

If you are using a personal laser printer, set your document size in inches, centimeters, points or 
picas at the dpi specific to your printer. Your file will be output correctly, at the best resolution for 
your laser printer and at the proper size.

If you are using a commercial printer or a more sophisticated output device, the dimensions 
should always be set to the actual size it will appear in the printed piece. For the resolution, a 
good rule of thumb is to set your documents pixels per inch to twice the desired lpi. So when lpi is 
150, the pixels per inch should be twice that, or 300; if the lpi is 85, the pixels per inch should be 
170. Its a good idea to check with your service bureau if you have questions about output-device 
resolution.



Resolution and Screen Appearance
Because Painter opens and displays an image at 75dpi, a 300dpi image will be displayed at four 
times its actual size. Each dot in the Painter image will occupy one pixel on your display. The 
display pixels are four times the size of your images pixels. Put another way, at 300 pixels per 
inch, your document will be approximately a quarter of its on-screen size when printed. In this 
example, if you want to view the image at actual size, set the zoom level to 25%.

Keep in mind, if you leave the dimensions in pixels, and then change the pixels per inch 
(resolution), the dimensions will be affected by the change. If you set your document size in 
inches, centimeters, points or picas and change resolution, the dimensions will not be affected by 
the change.

Setting Paper Color
You can choose the background paper color when you create a new document. This color will 
appear when you delete a filled area or use the eraser to remove color. If you want your 
background to be white, leave the paper color in the default position.



Technical Support
You will find the answers to most of your questions within the pages of the User Guide. If you 
need further assistance, you may contact Fractal Designs Technical Support in any of the 
following ways: 

Phone: 408 688-8800 between the hours of 8am and 5pm,
Pacific Standard Time

FAX: 408 688-2845

Internet: mac_support@fractal.com

Mail: Technical Support
c/o Fractal Design Corporation
P.O. Box 2380
Aptos, CA 95001-2380

For More Information 

For more information about Fractal Design products, see our World Wide Web site on the 
Internet:

www: http://www.fractal.com

To exchange tips and techniques with other users, see the following:

AOL: Keyword:    Fractal

CompuServe: GO GUGPRA



Shapes
Shapes are vector-based objects that you draw, stroke, and fill. Shapes can be simple lines, 
curves, text outlines, or any type of open or closed path.

The paths that create curves are known as Bezier curves. Curves consist of anchor points that 
are connected by line segments. When the path is a curve, wings extend from the anchor points. 
The wings are tangent to the curve. The wings have control handles on them. By dragging the 
wing handle, you can change the curvature of the segment. Shapes may be open (with 
endpoints) or closed (without endpoints).

Anchor points may be either smooth or corner points. A smooth point allows you to manipulate the 
segments on both sides of an anchor point by dragging a handle. A corner point restricts the 
manipulation of the segments to the one side of the anchor point that has a handle.

You can create and edit shapes with the precision of a drawing program and integrate them with 
Painters Natural-Media environment.

A shape may be open or closed with straight line or curved paths.

Shapes provides much of the vector-drawing functionality found in programs like Adobe Illustrator, 
Macromedia Freehand and CorelDraw! Painters Shapes feature doesnt replace the capabilities in 
these programs, rather, it allows Painter to work with these tools to manipulate and create artwork 
that simply could not be drawn in these programs. You can take vector shapes and make them 
semi-transparent, or allow them to use a compositing method such as Difference or Gel.

Draw and illustration programs like Freehand are fundamentally based on the PostScript page 
description language by Adobe Systems. They allow you to create drawings using basic 
PostScript constructs like Bezier curves, and stroke and fill attributes.

Painter lets you do things that go beyond the confines of PostScript, such as specifying 
transparency. One of the first things that youll notice is that Painter draws shapes in an anti-
aliased fashion. This anti-aliasing gives objects in Painter a smooth edge, as opposed to the 
jaggy edges they display in most drawing programs. Some clip-art objects actually look like 
photographic elements when they are imported in Painter and displayed with anti-aliasing.

These anti-aliased shapes are typically slower to draw to the screen in Painter than aliased 
objects are in drawing programs. Thus, you may want to do most of your object creation in your 
drawing program. Then you can import the vector artwork into Painter, tweak it with Painters 
drawing tools, and add some Natural-Media effects.

This ability to mix bitmap and vector graphics is one of the qualities that makes Shapes so 
compelling. Painters shapes can be interleaved with bitmapped floaters, so you can layer both 
styles of artwork in a single composition. And, you can convert vector objects and groups into 
bitmapped floaters, automatically. Then, apply any of Painters Effects or painting tools to this 
floating object to create Natural-Media artwork from vector objects.

Shapes can also be used to generate selections. You can convert shapes to selections and vice-
versa. The tools for adjusting shapes allow precise control over the outline path, so you will want 
to use shapes to create some of your selection paths.



Similarities Between Shapes and Floaters
Shapes, like floaters, are objects that exist above the canvas. The shapes you create appear in 
the Floater List with the image floaters. Many of the features for layering and manipulating floaters 
apply equally to shapes. 

The Floaters List section ### jump###    provides information on changing shape/floater layering 
and working with groups. 

For information on moving and aligning shape and floater objects, see Floaters

Click for more    information on shape a.

Shapes differ from floaters in that they are not pixel-based. Shapes are created from instructions 
that describe the outline path, stroke, and fill.

If you put pixel information into a shape, Painter automatically converts it to an image floater. For 
example, if you paint into a shape, the shape automatically becomes a floater.Floaters 

 Youll learn how to modify shapes, edit their outlines, and convert them to selections and floaters.



Saving Files with Shapes
Shapes are maintained when you save files in the RIFF format. In other formats, shapes are 
merged with the canvas. In the Photoshop 3 format, shapes are converted to image floaters and 
assigned to appropriate layers.



Shape Tools
The Shape manipulation tools reside in the six right-most icons on the Tools Palette. They are 
represented by:

The Shape Design Tools: The Pen Tool and the Quick Curve Tool are used for creating new 
shapes using Bezier curves.

The Shape Objects Tools: The Rectangle and Ellipse tools are used for creating simple geometric 
shapes. These shapes can be edited like any Bezier curve.

The Text Tool: The Text Tool creates text composed of Shape objects.

The Shape Selection Tools: The Direct Selection Tool (hollow arrow) is used for selecting an 
object, part of an object, or objects within group). The Object Selection Tool (filled arrow) is used 
for selecting entire objects or groups.

The Shape Edit Tools: The Shape Edit Tools are used for modifying curves and objects. The 
Scissors Tool is used for cutting a curve. The Add Point and Delete Point tools are used for 
adding and deleting Bezier anchor points. The Convert Point Tool is used for changing and 
anchor point from a soft point to a corner point.

The Floater Adjuster Tool: The Floater Adjuster Tool is used to move and resize both bitmapped 
floaters and shapes.



Creating Shapes
You may create shapes in any of several ways:

Use one of the five shape tools: the Pen, Quick Curve, Rectangular 
Object, Oval Object and Text Tool.
Convert a selection path to a shape.
Acquire an Adobe Illustrator 5 file through the Acquire menu.
Paste an Adobe Illustrator file through the clipboard.

As you create shapes, Painter gives them default attributes for stroke and fill. See the 
Preferences for instructions on setting the default Shape attributes.

After creating a basic shape, you can modify and edit it in a number of ways. 

Using the Shape Tools
You may use the Rectangular Tool, the Oval Tool, the Quick Curve Tool, the Pen Tool, or the Text 
Tool to develop shapes. 

Rectangle and Oval
The Rectangular or Oval Shape tool icon pops-up when you click and hold on the tool icon to let 
you select either version. You may also switch between the tools using the icons on the Controls 
Palette. 

The Controls Palette provides information on the size and location of the shape you create.



Quick Curve Tool
 The Quick Curve Tool allows you to create Bezier curves by drawing freehand lines, as if you 
were drawing with a pen or pencil.

Access the Quick Curve Tool from the Tools Palette.

Drag the Quick Curve Tool to draw freehand style.

When you let up on your mouse of stylus, the shape path appears.

You can add to either endpoint of a Quick Curve by selecting the endpoint, then dragging out from 
it. 

To select an endpoint, hold down the x key and click on or drag over the endpoint.



Shapes Selection and Edit Tools
Five tools are used for editing shapes. As you work, youll switch tools based on the type of 
changes youre going to make.

Direct Selection drags anchor points and control handles. From any other editing tool, 
you can toggle to the Direct Selection Tool by pressing the x key.

Scissors cuts the segment at the point you click.

Add Point adds an anchor point where you click on the curve.

Delete Point deletes the anchor point you click on.

Convert Point changes anchor points from being corner points to smooth points and vice 
versa.



Selecting a Shape and Adjusting Curvature
If you dont see the shapes outline path, youll want to select the shape--to display the path and 
anchor points--before proceeding. It is easier to work when you can see the path and points.

You can select a shape by clicking on it with the Floater Adjuster Tool or the Direct Selection Tool. 

If the shape has no fill, it might be easier to draw a marquee over all or part of the shape.

You can select a shape by clicking its name in the Floater List.

Moving anchor points 
You can move anchor points by dragging them. Before you can drag an anchor point, you must 
select it. You may select one or several points.

Adding Anchor Points
You can add anchor points to create new vertices or curves. 

Deleting Anchor Points 
You can delete anchor points to change the shape of the path, or if there are unnecessary points 
and you want to make the contour smoother. This might occur when you draw with the Quick 
Curve Tool.

Adjusting Curvature
A curve displays an anchor point and two wings. The angle and length of the wings determine the 
curvature of the segments on either side of the anchor.

Converting between Smooth and Corner Points
Two connecting curves (or straight lines) share one anchor point, which may be a smooth or 
corner point. The wings on smooth and corner points behave differently.

When you drag the handle on one wing of a smooth point, the curves on both sides of the point 
change. The wings remain co-linear.

When you drag the handle on one wing of a smooth point, only the curve on that side of the point 
changes.

With a corner point, you may adjust the angle of the wings independently. 

You can use the Convert Point Tool to convert between smooth and corner points.



Scissors Tool--Cutting a Segment
You may want to open a shape so that you can add new curves or connect another open shape. 
You can do this with the Scissors Tool.

When you split a curve, two new anchor points are created. These new points are on top of each 
other, and both are selected. If you try to drag one of them, both move. To separate the points, 
first deselect them, then drag the top point away.

If you want to remove a section of the path, click another place. Then use the Direct Selection 
Tool to drag the segment away.



Join Endpoints
 The Join Endpoints command allows you to connect any two endpoints--of the same shape or of 
different shapes.

If the points are at a distance from one another, a straight line is created between the two points.



Averaging
Averaging moves two or more anchor points with respect to each other in one, two, or both 
dimensions.

One of the basic uses for averaging is when you are going to join the endpoint of one curve to the 
endpoint of another. Averaging the endpoints (in both directions) brings them precisely on top of 
each other. Now, when you Join the endpoints, Painter merges them to a single point, through 
which the path continues. Without averaging first (if the points are just near each other), Painter 
Joins them with a segment. In some cases, this difference will be important to you.



Creating a Shape from a Selection Path
Converting a selection path to a shape enables you to edit the contour using the Bezier editing 
tools. When you are satisfied with the contour, you can convert the shape outline back to a 
selection path.

Working from a selection path also lets you create shapes based on the mask or regions of the 
image. For example, if you used the Magic Wand to select a region of common color, you could 
convert the Magic Wand selection path to a shape. 



Shapes from Adobe Illustrator and Macromedia Freehand
You may want to work with shapes youve created in Adobe Illustrator or Macromedia Freehand.

Painter lets you import the shape contents of files in Illustrator 5 format. If youre working with 
Freehand, save the file in the Illustrator 5 file format by using Freehands Save As command.

There are a number of Illustrator file options that are not supported by Painter, in particular, 
patterns, placed images, gradients, masks and text cannot be interpreted by Painter. If the file 
contains text, convert the text to outlines. To do this in Illustrator, select the text and choose Type 
menu> Create Outlines. In Freehand, use the Convert to Paths command.

When you are ready to bring the shapes into Painter, open a document.

Painter also supports PostScript-on-the-clipboard when pasting into a Painter document. This 
convention allows applications to exchange high-quality vector PostScript information. With 
PostScript-on-the-clipboard you can also copy and paste between Illustrator and Painter when 
both applications are running. Painter will read a clipboard in this format, but will only export 
bitmapped floaters and selections.

Exporting Shapes to Adobe Illustrator and Macromedia Freehand
Painter allows you to export shape data in Adobe Illustrator 5.0 format, which can be read by 
Illustrator and Freehand.

Exporting to Illustrator format will save only the Shapes, not the canvas or any raster floaters you 
have. Transparency and compositing methods are lost when exporting to Illustrator format (it 
doesn't support them). Anti-aliased edges are also lost.



Compound Shapes
In a compound shape, one outline path is used to cut a void in another path. Youll see this in 
many text shapes. 

The outline is one path, and the hole--in an A or O, for example--is a second path. The two paths 
are compounded into a single shape, which allows the hole to be open.

If you like, you may make additional holes by repeating the procedure, using this compound as 
the outer shape. 



Setting Shape Attributes
 There are several characteristics that you can specify for a shape, including whether it is stroked 
and filled.

Filling a shape refers to coloring the area that is enclosed by the outline. Stroking a shape refers 
to coloring a line on the outline path.

You may also control the width of strokes (lines) and the way line ends are drawn and joined. 

Stroke 
When you stroke a shape, you can choose the color, opacity, and width of the line that is painted 
around the shape.

To apply a stroke to the shape, enable the Stroke check box. To remove the stroke, disable the 
check box.

To choose a color for the stroke, click the shaded square. Then use the Color Palette to choose 
the color you want. You can access the Color Palette while editing this dialog box.

As an alternative, you may double-click the shaded square to bring up the Color Picker. 

To change stroke opacity, adjust the Stroke Opacity slider. Making a narrow stroke semi-
transparent is an easy way to anti-alias the shape.

To change stroke width, adjust the Width slider. This adjusts the thickness of the stroke. This 
slider is also available on the Controls: Shapes Palette.

Line Caps 
The line cap controls the endpoints of open shapes. There are three styles: projecting, round 
and butt.

To set a line cap style for selected objects, click the style you prefer in the Shape Attributes 
dialog.

Line Joins 
The line join style determines how corners are created when two segments meet at a corner 
point. There are three styles: miter, round, and bevel.

To set a line join style for selected objects, click the style you prefer.

Miter Limit 
If you have chosen the miter line join style, you can specify a Miter Limit. When mitered corners 
are joined at a sharp angle, a sharp corner is created. You can set the miter limit to smooth out 
the sharpness.

To set a miter limit for a selected object, adjust the sliders.



Fill 
When you fill a shape, you can choose the color and opacity of the fill.

To fill a shape, enable the Fill check box. To empty the shape (clear the Fill), disable the Fill check 
box.

To choose a color for the fill, click the shaded square. Then use the Color Palette to choose the 
color you want.

As an alternative, you may double-click the shaded square to bring up the Color Picker. 

To change fill opacity, adjust the Opacity slider. 

Fill Method
The Fill Method icons control whether intersecting areas of a shape are filled or not. The methods 
are:

Fill overlaps
Overlapping areas are filled with the same color.

Dont fill overlaps.
Overlapping areas are not filled, and multiple overlaps alternate being filled or not.



Flatness 

PostScript output devices create curved lines by linking a series of short, straight lines that 
progress in angle. Flatness controls how many straight lines the program uses to approximate a 
curve when printing. The smaller the flatness setting, the greater the number of straight lines and 
the more accurate the curve. 

Usually you do not need to change the flatness setting. You may want to change it to adjust for a 
particular high resolution printer or to avoid a PostScript limitcheck error. Check with your output 
service to find out if they have a recommended flatness setting.

To set flatness, first select a shape. Then adjust the Flatness slider. 

A change in flatness will appear only in your output, not on your screen.



Default Shape Attributes
You can change the default for how shapes are stroked and filled as you create them.

Choose Edit menu> Preferences> Shapes.

The options for stroke and fill let you specify how Painter should display shapes as you create 
them (On Draw) and when a shape path is closed (On Close).

The default setting is Stroke On Draw and Fill On Close. If you prefer a different method, enable 
the check boxes for the options you want.

The Big Handles option makes the anchor points and direction wing handles larger. This can 
make them easier to grab and drag. If you want big points, enable this option. 

The Artwork Color is used for the shape outline paths.

The Selected Point Color is used for selected anchor points. (unselected anchor points appear 
hollow.)

The Wing Color is used for the control wings and handles.



Grouping Shapes
Shapes can be grouped, allowing you to manipulate multiple shapes as a single unit. In addition, 
shapes and bitmap floaters can be grouped, allowing you to move these two types of graphics 
together. You can group and ungroup shapes from the buttons on the Floater List palette or via 
the Group and Ungroup commands in the Shapes menu. 



Modifying Shapes
This topic describes how to modify a shape as a whole--resizing, rotating, and skewing.    Shapes 
can be moved, cut, copied, and pasted like other floaters. 

Resizing
You can resize a shape or group of shapes by directly manipulating the objects with the Floating 
Adjuster Tool, or by using the Resize command.

To resize in one dimension, drag one of the side handles.

To resize in both dimensions, drag one of the corner handles. You can maintain the proportions by 
holding down the Shift key as you drag.

Drag in to shrink, drag out to stretch.

You can also use the Scale command, found under Effects menu> Orientation> Scale. This 
command works for both Shapes and bitmapped floating selections. The Scale command allows 
you to increase or decrease size by a fixed percentage. See Image Editing and Effects, for more 
information on the Scale command.

Rotating 
You can rotate a shape or group of shapes by directly manipulating the objects with the Floater 
Adjuster Tool, or by using the Rotate command.

You can also use the Rotate command, found under Effects menu> Orientation> Rotate. This 
command works for both Shapes and bitmapped floating selections. The Rotate command allows 
you to rotate by a fixed degree value. 
See Image Editing and Effects, for more information on the Rotate command.

You can also use the Distort command, found under Effects menu> Orientation> Distort. This 
command works for both Shapes and bitmapped floating selections.

Flipping

The Flip Vertical and Flip Horizontal commands found under the Effects menu> Orientation work 
for shapes and groups of shapes as well as for bitmap floaters.

See Also:
Floaters
Changing the Shape Outline
Image Editing and Effects



Duplicate a Shape
Duplicate creates a copy of the selected shape. A straight duplication isnt very special. Painter, 
however, allows you to duplicate with compound transforms, which leads to interesting 
possibilities.

All duplications are created according to the specifications in the Set Duplicate Transform window. 

To change duplication settings, choose Shapes menu> Set Duplicate Transform. Painter displays 
a window that lets you control the duplication.



Blend
Blend creates intermediate versions between two or more selected shapes. This is useful for 
morphing one shape into another, and is often used to simulate shading on irregular shapes. 
Blending applies both to the shape outline and to the stroke and fill attributes. 



Storing Shapes
Painter doesnt have a shapes library. However, because of the close relationship between shape 
outlines and selection paths, you can save shape outlines in the Paths library.

You can also export shapes as Adobe Illustrator files and re-acquire them as needed.



Converting Shapes to Floaters
Shapes are close relatives of floaters. They follow the same layering rules and you can 
manipulate them in many of the same ways.

Shapes differ from floaters in terms of the type of data they contain. Shapes are created from 
PostScript instructions. Floaters are constructed of pixels.

If you want to work with pixel information in a shape, you may convert it to a floater. In many 
cases, Painter will do this for you automatically. For example, if you paint into a shape, Painter 
converts it to a floater immediately to accept your brush strokes.

You may also deliberately convert a shape or group of shapes to a floater. 

To convert a shape to a floater, select the shape and choose Shapes menu> Convert to Floater. 

For more information about the properties that shapes and floaters share, see 
Similarities Between Shapes and Floaters.



Printing Images with Shapes
Painters Shapes capabilities allow you to seamlessly mix raster and vector data. However, many 
printers--PostScript printers in particular--dont have built-in support for some of Painters features 
such as transparency and compositing methods. Shapes can be interleaved with bitmap floaters 
in the floater list, which can affect the way your document will print.

Shapes are inherently resolution-independent: they're mathematical representations of curves, 
not actual pixels.

When you print, normally these curves are turned into PostScript paths and printed at the full 
printer resolution, although there are some exceptions.

Some effects that are possible with Painter Shapes are not actually printable with PostScript 
Level I or II, so they must be rasterized (turned into bitmaps) into your canvas before printing.

These include primarily transparency and compositing methods. It is important to note that 
anything that is touched by a rasterized shape causes that to be rasterized, as well. That is, if you 
have a Shape with transparency on top of a number of other shapes, all those shapes below must 
be rasterized as well as the top shape to preserve the transparency down to the canvas, even if 
the overlap area is small. Similarly, if you place a raster shape partially over a Shape, the Shape 
must be rasterized in order to print correctly.

This does not mean that your final output will look worse if your Shapes are printed as rasters 
instead of as PostScript paths. In particular, the anti-aliasing in Shapes provides very smooth 
transitions between elements in a composition.

For output at high resolution, there should be little visual difference between a rasterized and non-
rasterized Shape. On lower resolution devices such as laser printers, you will probably see slight 
variations.

To ensure that Shapes will print as PostScript paths, make sure they do not overlap with raster 
floaters, and that you do not make them transparent or set their compositing methods.



Selections and Masks
Selections and masks have a close relationship. Both features work by isolating areas; however, 
they differ in the way theyre created and what you do with them. Some operations in Painter 
require a mask, others work only with a selection. Depending on the artwork, sometimes you will 
choose to work with the mask and sometimes the selection is a better choice. You can easily 
convert between a mask and selection, so no matter which way you start working, you can reach 
the same ends



Selections
Selections are areas of an image that you isolate--either to copy, float, or to apply some effect. 

Selections are enclosed by a moving line of black and white dashes, called the selection 
marquee, or marching ants. You can exclude a region within the enclosure by creating a negative 
selection. Negative selections cut holes in the regular, positive selection. On screen, negative 
selections appear as red marching ants.

Selections are defined by the path the ants follow in their march. These selection paths are stored 
and controlled in the Objects> P. List Palette.

Selection paths are close relatives to Shape paths, and you can easily convert between these 
path types.

See Also:
Drawing and Visibility Modes
Creating Selections
Selection Tools
Converting a Shape to a Selection
Converting an Illustrator EPS File to a Selection
Converting a Mask to a Selection
Controlling Selections
Managing Selection Paths



Masks
The mask is an 8-bit overlay that protects areas from changes or marks off areas to be changed. 
When a selection is created, the mask responds to the selection according to how the drawing 
buttons are set, masking inside or outside of the selection.

The background (canvas) mask can also be used to control the appearance of floaters. By setting 
options for a floater, you can use the canvas mask to conceal or reveal part of the floater. 

Each floater has its own mask. In a floater, the mask controls the visibility of the floater image. By 
modifying the floaters mask you can change the appearance of a floater. 

See Also:
Drawing and Visibility Modes
Masking



Drawing and Visibility Modes
For working with the canvas mask and selections, Painter has three drawing and three visibility 
modes. The controls for these modes appear in the Objects> P. List Palette and as pop-ups in the 
bottom left of the image window. 

Drawing Modes
The drawing mode buttons determine whether the inside or outside of a selection is masked when 
you paint on an image.

Mask Disabled
The mask is turned off. Brush strokes are allowed anywhere in the document.

Masked Inside
The mask protects the areas it covers. Opaque areas of the mask prevent brush strokes from 
reaching the canvas. Clear areas of the mask allow brush strokes to go directly to the canvas. 
Where the mask is shaded, a portion of the brush stroke is applied semi-transparent.

Masked Outside
Masked Outside inverts the mask. Only the masked regions accept brush strokes.

Visibility Modes

Clear View
In this mode, you wont see the mask; however, it will still function according to the drawing mode 
setting.

View Mask
The mask is displayed in red. Brush strokes will reach the canvas only where you can see 
through the mask.

This mode has two main uses: to allow you to see where the mask protects the image and to 
allow you to paint in the mask.

In this mode, you can see the mask invert when you switch between Masked Inside and Masked 
Outside drawing modes.

The default mask color is red. You can change the color using the color chip at the bottom of the 
P. List Palette.

View Selection
The mask is displayed as a selection. By choosing this visibility mode, you can convert a mask to 
a selection.

A selection is active only when the ants are marching. Painter must be in this mode to create, cut, 
float, or apply an effect to a selection. 

In most cases, Painter sets the visibility mode automatically, according to the tool or command 
you use.

A shortcut between modes
When working with a selection in Show Selection mode, you can immediately set Painter to Mask 
Disabled/Clear View by choosing Edit menu> Deselect (x-D). You can then proceed without the 
selection or mask interfering.

When you want the selection back, choose Edit menu> Reselect (x-R). Painter switches to 
Masked Outside/Show Selection.



For more complete control of selections, use the P. List.



Creating Selections
To select the entire image, choose Edit menu> Select All.

If you want to select a portion of the image, you can specify the selection path in any of several 
ways:

By using one of the four selection generating tools, the Rectangular Selection Tool, the 
Oval Selection Tool, the Lasso Tool or the Pen Tool
By using the Magic Wand
By converting a mask to a selection with the View Selection Visibility button
By creating a Shape, then converting it to a selection
By importing an Illustrator 5 EPS file.

You may not create a selection inside a floater. You can get around this restriction by copying the 
floater to a temporary document and dropping it there. 

If you zoom in on your image, the selection tools behave as they would at 100%. This allows you 
to create precise selections.

You may choose to create Shapes, then convert them to selections. This requires an extra step, 
but allows you to edit the Shape paths before conversion.



Selection Tools
You may use the Rectangular Selection Tool, the Oval Selection Tool, the Lasso Tool, or the Pen 
Tool to create selections. 

The Rectangular and Oval Selection Tools
Choose the Rectangular or Oval Selection Tool on the Tools Palette. 

The Rectangle or Oval Selection tool icon pops up to let you select the other version. You may 
also switch between the tools using the icons on the Controls Palette: Selection Tools.

The dashed line icon is the Selection tool. The solid line icon is the Shape tool. 

Position the cursor in the image and drag diagonally. When the selection is the size you want, let 
up.

The Controls Palette provides information on the size and location of the selection you create.

After creating a rectangle or oval, you can move any corner by holding down the Shift key and 
clicking on the corner point you want.



Lasso Tool
The Lasso Tool lets you create a freehand path. On the Controls Palette, you can choose to add 
or subtract from an existing selection or close the path. Once you close the path, it automatically 
becomes a selection.

Choose the Lasso Tool on the Tools Palette. 

The Controls Palette: Lasso Tool offers three modes for creating selections:

New--Each path you draw creates a new selection, while disabling any previous 
selection.

Add to Selection--Each path you draw is added to the current selection.

Subtract from Selection--Each path you draw becomes a negative selection path, which 
voids any portion of the current selection that it overlaps. See Selections for more 
information on negative selection paths.

With the Lasso, you can draw freehand around the area you want.

The selection path must be closed. If you finish on top of the point where you began, Painter will 
close the path and create the selection automatically. 

If you finish some distance from the point, Painter assumes that you want to edit the path before 
closing it. In this case, Painter creates it as a shape path so you may edit it. See Shapes for 
information on editing shapes.

If you want to close an open path, click Close on the Controls Palette: Lasso Tool. Painter closes 
the path and converts it to a selection.



Pen Tool
Use the Pen Tool when you want to draw straight lines or smooth flowing curves.

The Pen Tool allows you to create shapes using Bezier curves. 

Click and drag to make a Bezier curve. Click and drag again to continue the curve.

You can constrain the placement of the points by displaying the grid. The anchor points 
will snap to the nearest grid intersection. 

If the curves dont turn out right immediately, dont worry. You can easily adjust them. 

Each click or drag adds to the path. If you make a mistake by clicking on the wrong spot, 
press the Delete key. Painter removes the last anchor point, so you can try again.

To create text shapes click the Text Tool and choose a font on the Controls Palette.

The Pen Tool is a Shape Tool that allows you to create a path using Bezier curves. Once a shape 
is drawn, it can easily be converted to a selection.

Choose the Pen Tool from the Tools Palette.

Click on each point you want as a vertex. Clicking creates straight lines between vertex points. 
You may drag to create curves between anchor points. 

See Shape Tools for detailed information on using the Pen Tool.

Click on the starting point to close the path. You may also click Close on the Controls Palette to 
close the path by joining its endpoints.

The path is still a shape, so you may use any of the Shape Edit Tools to adjust its outline. See 
Shape Edit Tools for more information.

When you are ready to convert the shape to a selection, click Make Selection on the Controls 
Palette: Pen Tool. Painter converts the shape to a selection. 

You may use this button to convert any selected shape to a selection.



Magic Wand
Pixels come in related groups of colors based on hue, saturation, and value. The Magic Wand 
allows you to select an area based on color similarity. You can adjust Painter to accept a narrow 
or wide range within one or several color groups.

You can add to the selected area in two ways: 

Hold down the Shift key and click or drag over additional areas in the image.
Adjust the HSV sliders to increase the range of colors. The colored regions of the HSV 
sliders describe each selected range. You can drag the limits of a range in either 
direction. As you work, the mask shows your changes to the selection.

By default, the Magic Wand selects only contiguous areas in the image. If you want to find all 
pixels of a color group, select the area with the Rectangular Selection Tool before using the Magic 
Wand. 

When youre satisfied with the masked area, click OK. Painter selects that area.



Converting a Shape to a Selection
In some cases, the path you want for a selection might exist as a Shape. This will be the case for 
text or if youve been editing the path.

Before you finish editing, make sure the Shapes path is closed. Selection paths must be closed.

See Shapes for information on editing shapes.

To convert a shape to a selection: Select the shape you want to convert. Choose Shapes menu> 
Convert to Selection.

If the Pen Tool is selected, you may also click the Make Selection button on the Controls Palette: 
Shape Design Tools. 



Converting an Illustrator EPS File to a Selection
You might have the selection paths you want in an EPS file you created in Adobe Illustrator 5 
format. Painter lets you open the file and convert it to a selection.

The paths in the EPS file must be closed. The paths must also be either stroked or filled. 
However, paths that are part of a compound object may have no stroke or fill. For example, the 
inside of an O.

To import an Illustrator 5 EPS file: Choose File menu> Acquire> Adobe Illustrator File. Painter 
displays a directory window that you may use to locate and open an EPS file.

Painter does not automatically recognize the paths that should be negative selections. Once you 
convert it to a selection, youll need to use the P. List Palette to make the cut out paths negative.



Converting a Mask to a Selection
In some cases, you might prefer to use masking tools to create a mask, then convert it to a 
selection. 

After creating a mask, you can convert it to a selection by choosing the Show Selection visibility 
mode. Refer to Drawing and Visibility Modes.

Converting a mask to a selection places it in the P. List, where it will be identified as a Mask 
Group.

A Mask Group in the P. List has certain characteristics youll need to learn about. 



Controlling Selections
Painter allows you to have multiple selection paths within a document. You control which 
selections to work with using the Selection Adjuster tool and the Objects> P. List Palette.

The P. List shows all selection paths in a document. The names of standard selection paths 
appear in blue. The names of negative selection paths appear in red. The names of mask group 
paths appear in green.

Unless otherwise specified, this section describes working in View Selection visibility mode. In 
most cases, Painter will select this mode automatically when you work with selection tools.

Selecting a Path or Group
When you want to identify which path to work with, you must select it. Many of the path 
adjustment operations, like resizing, require you to select the path to modify.

You may select and work with a path that is not active. In most cases, however, its easier to work 
when you see the ants marching along the path.

Active vs. Inactive paths
Any number of paths may be active at a given time. An active path appears in the document with 
the ants marching and is indicated in the P. List with a black, dashed circle to the left of its listing.

The current selection is comprised of all active paths. 

To disable a path, click the dashed circle to the left of the listing in the Path List. You may also 
disable a path or group by selecting it and pressing the Return or Enter keys. 

Path Group listings have no symbol. You may use the Return or Enter keys to control whether a 
group is active.

When a path is disabled, the circle appears dim and is not dashed. Disabled paths are not shown 
in the document.

To activate a path, click the dim circle beside the listing you want to make active. You may also 
activate a path or group by selecting it and pressing the Return or Enter keys. 

Positive and Negative Selections
Negative selections are used to cut holes in positive selections. Merely creating a path inside 
another one does not specify the inner path as a negative selection. You must identify which 
paths should be negative.

The symbol immediately left of the paths name in the Path List is the control for making selections 
negative. Positive selections are given a plus sign. Negative selections are given a minus sign.

Negative selection paths must be ordered above the path they cut into--that is, the negative path 
must be higher in the P. List than its associated positive selection. At first glance, this might seem 
like an arbitrary requirement. It isnt. It allows you to layer multiple positive-negative selections 
without confusion as to which negatives relate to which positives. For clarity, its best to group 
each positive-negative selection.

If necessary, drag the negative paths listing above the positive paths listing. In some cases, it 
makes more sense to move the positive selection instead.



To view the results of your change, set the visibility mode to Show Mask. If the mask doesnt 
describe the selection you want, return to Show Selection mode and make changes in the status 
of the paths or their arrangement in the list.

Mask Group paths cannot be made negative.

To convert a negative path back to a positive selection, click the icon immediately left of the path 
name. The icon reverts to a plus sign.



Managing Paths

Clear a Path
If youve finished working with a selection path, and you want to clean house by tossing it out; you 
may clear the path.

Select the path or group you want to clear. In the P. List Palette, click the Clear button.

Naming Paths
As the number of paths increases, it can become difficult to track which listing refers to which 
path. Painter lets you give the paths descriptive names, which makes them easier to identify.

To name a path: Double-click the paths name in the P. List Palette. Painter displays a Path 
Attributes dialog. Enter a descriptive name and click OK.

The Path Attributes dialog also gives the location of the square at the top, left corner selection 
region.

Grouping Paths
Group selection paths when you want to organize them or move them around as a single unit. 
You can move a closed path group in any of the ways youd move a single path.

You might also group paths to organize them. This is useful when you have several selections, 
each comprised of multiple paths. By grouping the paths, you can select or activate/deactivate all 
paths in the group at once.

To add a path to the group, drag its name into the group. To remove it from the group, drag it back 
out. 

You can add a group to group in the same way, by dragging the group name into the group. Drag 
a path out of a group to make it an individual path again.

Closing and Opening a Group
Before moving a group, you must close it. 

To close a group, click the arrow to the left of the group name. When the arrow points to the right 
and the names of the group members are hidden, the group is closed.

If you want to work with individual paths in a group or move them separately, you must open the 
group. 

To open a group, click the triangle to the left of the group. The arrow turns down, opening the 
group and revealing the names of its members. You may now select and work with them 
individually.



Manipulating Selections
Unless otherwise specified, this section describes working in View Selection visibility mode.

Painter allows you to move selection paths, disable them, change their shape, and transform 
them. 

Moving a Selection Path
After creating a selection path, you can move it in the document. You can use these same 
methods to move a path group.

The selection does not need to be active, but it helps by showing you the precise area enclosed.

Moving the path does not move the enclosed image. To move the image, you must float it. For 
more information about floating selections, see Floaters

Editing Selections
Painter provides some simple edit functions for re-shaping selection paths. For complete editing 
features, you may convert the selection path to a shape, where you can use the Shape Edit Tools 
and then convert the shape back to a selection path.

Smoothing 
Smoothing removes sharp edges, rounds corners, and straightens out wiggles in the path. 

Select the path you want to smooth. You may select several items, including a path group. 

This operation applies only to selected paths or groups, not to any active selection paths. 

In the P. List Palette, click the Smooth button. Youll probably need to click the button several 
times before you see the path become smoother. Continue clicking until the path is as smooth as 
you want it.

Feathering
Painter allows you to feather a selection to soften its edges. 

Set the selections you want to feather as the only active paths. 

This operation applies to all active selections. 

Positive and Negative selection paths can be feathered by choosing the Selection Adjuster Tool 
and moving the Feather slider on the Controls Palette: Adjuster Tools.

Mask groups have to be feathered differently. Choose Edit menu> Mask> Feather Mask. Painter 
displays a dialog prompting you to enter the feathering radius.

Enter a value and click OK. Painter creates a Mask Group selection that includes the feathering.

Inverting
Painter allows you to invert a selection. For example, you have an image of a boat on the water 
and youve created a precise selection of the boat. You can select everything but the boat by 
inverting the boat selection.

Set the selections you want to invert as the only active paths. 



This operation applies to all active selections

Choose Edit menu> Mask> Invert Mask. Painter creates a Mask Group selection that is the 
inverse of the previous selection. 

Converting a Path to a Shape for Editing
If you want greater control over the contour of the selection path, you may convert it to a shape. 
With the path as a shape, you may use all of the Shape Edit Tools to adjust it.

Exporting a Selection as an EPS File
Converting a selection path to an EPS file allows you to open it for editing in an application like 
Adobe Illustrator. You can bring the edited path back to Painter as a selection.

Choose File menu> Export> Adobe Illustrator File. A Save dialog box appears.

Enter a file name, choose a destination folder, and click OK. The path is saved as an EPS file. 

Stroking a Selection
In some cases, you might want to border a selected region with a brush stroke. Painter will do this 
for you, stroking the current brush along the selection path. This is an excellent way to get brush 
strokes to flow in specific contours.

Set the paths you want to stroke as the active selection. 

This operation applies to all active selection paths.

Choose the brush variant, color, and paper texture you want to use. The feature uses the current 
brush variant.

Choose Objects Palette: P. List menu> Stroke Selection. Painter applies a brush stroke to the 
canvas, following the selection path.

You may repeat the command to build strokes. Change brushes if you like. You might want to 
move the path a few pixels and choose the command again.

The Paths Library: Saving and Retrieving Paths
If you create a path that youll use again, you can save it in a Paths library. Painter provides a 
library of paths, but you can create as many additional libraries as you need.



Masking
The canvas has a mask layer, and each floater carries its own mask. These masks have four 
main functions:

1) The canvas mask protects areas of the canvas from change or marks them to be 
changed. This function depends on the drawing mode--Masked Inside, Masked 
Outside, or Mask Disabled. See Masks for more information.

2) The canvas mask can also be used to control the visibility of floaters. By setting 
options for a floater, you can use the canvas mask to conceal or reveal parts of the 
floater. In this way, you can interweave floater images with the background. See 
Floaters for more information.

3) The canvas mask can be converted to a selection by choosing the Show Selection 
visibility mode. This enables you to float the masked area or apply effects to it. 
Painters sophisticated masking tools make it easy to create a complex selection.

4) The floater mask controls what portion of the floater is visible. See Floaters for more 
information.

For the background and floater, the mask is an 8-bit image that you can modify. By changing the 
mask, you can control any of the functions described above.

At any moment, there is one canvas mask. To view it, select the View Mask visibility icon. By 
default, Painter displays the mask in red. Un-masked areas show through to the canvas image.

Floaters cover the canvas mask. You might want to shut the eye on floaters to see the mask 
completely.

You may also view the mask by putting Painter in Mask Edit mode. Click the color spectrum icon 
near the top, right corner of the image window. The icon becomes a black circle and the image 
window displays the mask as a grayscale image. When youre finished in Mask Edit mode, click 
the icon again to return to Image mode.

You may also use Mask Edit mode to view an image floaters mask. First select the floater, then 
click the color spectrum icon to choose Mask Edit mode.

See Also:
Creating and Editing Masks
Basic Masking Commands
Automatic Masking Features
Mask Edit Mode
Bringing in Masks from Other Programs
Masking Brushes: Painting into a Mask 



Creating and Editing Masks
Painter provides several ways to generate and modify masks. Many of the tools work in a floaters 
mask as well as the background. 

When no floater is selected, you will modify the canvas mask. 

When a floater is selected, you will modify the floaters mask. 

The easiest way to set up a canvas mask is from a selection. Selections translate directly to the 
mask

Selections are not allowed inside of floaters. 

You may generate or modify a mask with one of the automatic masking features. 

In Mask Edit mode, you may paint the mask with any brush variant and apply Effects to 
the mask image.

You may paint the mask manually using any Masking brush variant. 

You may fill the mask using the Paint Bucket.

You may modify a mask when you paint with the Image Hose. Enable the option Add to 
Mask on the Nozzle Palette before painting, found under the Brushes Palette menu> 
Nozzle.

You may modify the canvas mask when you drop a floater. Enable the option Drop with 
Mask on the F. List Palette before dropping.

You can also acquire a canvas mask by opening a document created in another program. 
Poser renderings, ColorStudio, and Photoshop documents may contain a mask. 

When importing into Painter, Photoshop files must be in RGB mode. Painter will use any mask 
information contained in channel 4 of these images.

Creating a Canvas Mask from a Selection
Use any tool or method to create a selection. 

Set the visibility mode to Show Mask. The selection now forms the canvas mask. 



Basic Masking Commands

Clearing the Mask
If you want to clear the mask so you can start fresh, choose Edit menu> Mask> Clear Mask (x-U).

Inverting the Mask
If you want the mask inverted to change the control of your brush strokes, you can switch the 
drawing mode between Masked Inside and Masked Outside. 

To actually invert the mask image, choose Edit menu> Mask> Invert Mask. This type of inversion 
is necessary if you intend to generate a selection from the mask.

Feathering a Mask
You can feather a mask to soften the transitions between masked and un-masked areas. 

If the effect is not what you intended, Undo it and try again with a different feathering radius.



Automatic Masking Features

Auto Mask 
Auto Mask creates a mask based on your choice of image characteristics. The Invert option 
allows you to invert the mask you create.

Paper Grain
Paper Grain creates a mask using the current paper texture.

3D Brush Strokes
3D Brush Strokes creates a mask based on the difference between the current image and the 
clone source. 

You must establish a clone source for this option to be available. 

Original Mask
Original Mask imports the mask from the clone source document. You can use this feature to 
transfer a mask from one document to another. For best results, the dimensions of the source and 
working document should match. You must establish a clone source for this option to be 
available. 

Image Luminance
Image Luminance creates a mask based on the current images light and dark areas. This is 
especially useful for creating masks to protect line drawings before using the Cartoon Cel Fill 
method. Luminance will also efficiently mask high contrast photographs.

Original Luminance
Original Luminance produces a mask in the current document based on the clone sources light 
and dark areas. This option lets you import an image to the mask. You must establish a clone 
source for this option to be available. 

Current Color
Current Color creates a mask protecting pixels of the current primary color. Enabling the Invert 
option means that everything but the current color will be masked. 

You might want to use the Dropper Tool to pick a color from the image before using this 
command.

Color Mask
The Color Mask feature lets you create a mask based on a range of colors.



Mask Edit Mode
Mask Edit mode allows you to work in the mask as though it was a regular image. Working in 
Mask Edit mode offers three advantages:

You can see the mask of the canvas or floater as a grayscale image.
You may use any brush variant to paint or modify the mask. 
You may apply Effects to the mask image.

Because of the close relationship between selections and the mask, you may not work with 
selections in Mask Edit mode.



Bringing in Masks from Other Programs
When you open a ColorStudio 1.5 document in Painter, whatever is in the mask layer will appear 
in Painters canvas mask layer. Be sure to save the ColorStudio file in the RIFF format.

When you open a Poser rendering, the figures are automatically masked.

RGB Photoshop 3 documents saved in the Photoshop format can also be opened in Painter. 
Anything in the first alpha channel will appear in Painters canvas mask layer. When floating a 
selection made in an image imported from Photoshop, you should click the second Floater Mask 
Visibility button, Masked Inside, on the F. List Palette.



Masking Brushes: Painting into a Mask 
Another way to create or modify a mask for a floater or the canvas is by painting with one of the 
Masking brushes. These brushes paint only into the mask layer, so Painter automatically sets to 
View Mask when you choose one of them. 

When no floater is selected, you will modify the canvas mask. 
When a floater is selected, you will modify the floaters mask. 
The value of the mask paint controls mask density.
When you paint with a Masking brush, you use white, black, or a shade of gray as the 
primary color. This is because the mask carries 8 bits of information and you need only to 
set a level in that range.

In the canvas mask
When the drawing mode is set to Masked Inside or Mask Disabled, painting in a mask with black 
creates opaque areas. Painting with white erases the mask. And using a shade of gray gives you 
a relative level of opacity. 

Because Masked Outside drawing mode inverts the mask, it also transposes the effects of 
painting with black or white. In this case, painting with black erases the mask and painting with 
white adds to it.

In a floater mask
In a floater, the masked region establishes the visibility of the floater. You can change the extent 
of a floater image by modifying its mask. The following information will help you choose a value 
for mask paint, depending on the floater visibility mode.

Masking Disabled
The floaters masking information is ignored, so the entire floater rectangle is visible

Masked Inside
The masked region of the floater rectangle is rendered invisible, so the background image shows 
through. Regions of the floater rectangle outside the mask are visible.

In this mode, painting in white reveals more of the floater image. Painting with black renders that 
area of the floater rectangle invisible, which reveals the background.

Masked Outside
In this mode, only the masked region of the floater rectangle is visible. The background image 
shows through the un-masked regions. This is the normal mode for a floater.

Painting with white conceals more of the floater image, which reveals the background. Painting 
with black reveals more of the floater rectangle, which hides more of the background.

Mask View Color
The color that the mask appears in View Mask mode is not associated with the primary color you 
paint with. The mask image appears in red by default. You can change this color by clicking the 
color chip in the Objects> P. List Palette and choosing another color in the Color Picker. 

The Transparent Mask option in the P. List Palette lets you dim the mask so you can see through 
to the background. This might help you work in some cases.

To paint with a Masking brush, choose a Masking brush. Painter sets the visibility mode to View 



Mask. You must view the mask to paint with a masking brush.

Painter comes with a set of masking brush variants; however, any brush can be turned into a 
masking tool by changing its Method Category to Mask. The Mask brush method applies brush 
strokes only to the mask layer. See Advanced Painting for more information on brush methods.

You may also use any brush when working in Mask Edit mode.

Check the drawing mode. 

Use either Mask Disabled or Masked Inside if you want to start with a clear mask and paint to add 
the masked area.

Use Masked Inside if want to start with a solid mask and paint to erase portions of it. The 
Transparent Mask option on the P. List Palette is useful when working this way.

Remember that you can invert the mask. If you wanted, you could start in one drawing mode, 
then invert the mask, and continue in the other mode.

Select black, white, or a grayscale value as the primary color. Paint in the image to modify the 
mask.

In the canvas mask, youll see the strokes appear in the mask color. In a floater, you wont see the 
strokes directly; however, you will see their effect as the floater image shrinks or grows beneath 
your brush.

Masking Brushes
Following are examples of how the masking brush strokes appear.

Masking Pen
The Masking Pen draws smooth, anti-aliased lines. The Masking Pen is pressure-sensitive in 
terms of stroke width.

Masking Airbrush
The Masking Airbrush paints misty, anti-aliased strokes.

Masking Chalk
The Masking Chalk variant draws semi-anti-aliased lines that interact with the paper texture.

Grainizer
The Grainizer produces broad, grainy, anti-aliased strokes. The grain is based on the paper 
texture.

Single Pixel Masking Pen
The Single Pixel Masking Pen draws with a single pixel. This brush is useful when zoomed in.

Big Masking Pen
The Big Masking Pen produces broad, solid, anti-aliased lines. This brush is good for filling in 
large areas.



Filling the Mask
Choose the Paint Bucket Tool.

In the Controls Palette: Paint Bucket Tool, select Mask for What to fill and choose the medium to 
fill with. Note that only the value is considered.

Make sure Painter is in Show Mask visibility mode.

Click in the region you want filled.

See Applying Art Materials for information on controlling the Paint Bucket threshold



Keyboard Shortcuts

Click a topic to learn about keyboard shortcuts associated with that topic:

Palettes 
Menu Selections 
Tools Palette 
Screen Navigation 
Painting and Art Materials 
Paint Bucket 
Dropper 
Lasso Tool 
Selection Tool 
Adjuster Tool 
Shape Tools
Frame Stack Navigation 
Lighting
Magic Wand 
Scripts 



Palettes - Keyboard Shortcuts

Tools Ctrl-1
Brushes Ctrl-2
Art Materials Ctrl-3
Objects Ctrl-4
Controls Ctrl-5
Color Sets Ctrl-6



Menu Selections- Keyboard Shortcuts

Click a menu title to learn about keyboard shortcuts for menu selections.

File Menu 
Edit Menu 
Effects Menu 
Canvas Menu 
Shapes Menu 
Window Menu 



Tools Palette - Keyboard Shortcuts

Brush (Freehand) B
Brush (Straight-Line) V
Dropper D
Floater Adjuster F
Magnifier M
Pen P
Paint Bucket C
Rectangular Selection R
Text Selection T
Lasso H



File Menu - Keyboard Shortcuts

New Ctrl-N
Open Ctrl-O
Close Ctrl-W
Save Ctrl-S
Get Info Ctrl-I (capital i)
Print Ctrl-P
Quit Ctrl-Q



Edit Menu - Keyboard Shortcuts

Undo Ctrl-Z
Redo Ctrl-Y
Cut Ctrl-X
Copy Ctrl-C
Paste (Normal) Ctrl-V
Drop Current Floater Shift-Ctrl-D
Select All Ctrl-A
Deselect Ctrl-D
Reselect Ctrl-R
Auto Mask Shift-Ctrl-M
Clear Mask Ctrl-U
Invert Mask Shift-Ctrl-I (capital i)



Effects Menu - Keyboard Shortcuts

Last Effect Ctrl-/
Second-To-Last Effect Ctrl-;
Fill Ctrl-F
Equalize Ctrl-E
Adjust Colors Shift-Ctrl-A
Super Soften Shift-Ctrl-S
Quick Warp Shift-Ctrl-F



Canvas Menu - Keyboard Shortcuts

Tracing Paper Ctrl-T
Resize Image Shift-Ctrl-R



Shapes Menu - Keyboard Shortcuts

Group Ctrl-G
Ungroup Shift-Ctrl-G



Window Menu - Keyboard Shortcuts

Hide/Show Palettes Ctrl - H
Zoom In Ctrl-+
Zoom Out Ctrl--
Full Screen Window Ctrl-M



Screen Navigation - Keyboard Shortcuts

Scroll Image with Grabber Space Bar
Center Image Space Bar-Click
Zoom In Space Bar-Ctrl
Zoom Out Space Bar-Ctrl-Alt
Rotate Image Space Bar-Alt
Constrain rotate to 90 degrees Shift-Alt-Space Bar
Un-rotate image Space Bar-Alt-Click
Define magnification area Space bar-Ctrl-Click and Drag



Painting and Art Materials - Keyboard Shortcuts

Brush Controls
Wet Layer
Cloning
Colors 
Gradations 
Mosaics
Tesselations



Brush Controls - Keyboard Shortcuts

Resize Brush Ctrl-Alt
Build Brush Ctrl-B
Constrain to 45 Degrees 

(Straight-Line mode) Shift
Adjust Opacity in 10% increments 1-0 keys
Load Nozzle Ctrl-L



Wet Layer - Keyboard Shortcuts

Post-diffuse Shift-D



Cloning - Keyboard Shortcuts

Set clone source Ctrl-Click
Re-link clone source Alt-Clone command



Colors - Keyboard Shortcuts

Add current color to color set Shift-Ctrl-K
Replace current color in set Alt-Dropper Tool
Correct Colors K
Bring up Color Talk dialog k



Gradations - Keyboard Shortcuts

Edit Gradation Shift-Ctrl-B
Adjust spirality for 
spiral gradations Ctrl-Angle Adjuster



Mosaics - Keyboard Shortcuts

Make Mosaic Ctrl-Alt-M
Get tile color Ctrl-Click tile
Get tile shape Alt-Click tile
Delete Tile Shift-Click tile

Tile Selection Tool

Select all tiles a
Deselect all tiles d
Change to current color c
Tint with current color t
Vary Tile color v



Tesselations - Keyboard Shortcut

Make tesselation Ctrl-Alt-V



Paint Bucket - Keyboard Shortcuts

Limit fill extent Click-and-Drag Paint Bucket



Dropper - Keyboard Shortcuts

Dropper access
Ctrl-Brush Tool
Ctrl-Paint Bucket Tool
Ctrl-Rectangular Selection Tool
Ctrl-Floater Selection Tool

Measure mask density Shift
Replace current color in set Alt



Lasso Tool - Keyboard Shortcuts

Close path Enter



Selection Tool - Keyboard Shortcuts

Rectangular Selection Tool
Constrain to square Shift
Adjust current rectangular selection Shift-Ctrl
Edit Rectangular Selection Shift-Ctrl-E

Oval Selection Tool
Constrain to circle Shift



Adjuster Tool - Keyboard Shortcuts

Click a topic to learn about keyboard shortcuts associated with that topic:

Floater Adjuster
Floater List
Selection Adjuster
Path List
Dynamic Adjustment



Floater Adjuster - Keyboard Shortcuts

Duplicate Alt-Click
Move floater by one screen pixel Arrow keys
Hide/Display marquee Shift-Ctrl-H
Delete selected floaters Delete
Select Floater in image Click on Floater
Deselect all Floaters in image Click outside Floaters
Attribute dialog for current floater Enter
Adjust opacity in 10% increments 1-0 keys



Floater List - Keyboard Shortcuts

Attribute dialog for current floater Double-Click item
Floater layer order Click-and-Drag item
Select/De-select Shift-Click item



Selection Adjuster - Keyboard Shortcuts

Duplicate Alt-Click
Move selection by 

one screen pixel Arrow keys
Render/Unrender toggle Enter
Delete current selection Delete
Select Path Click inside Path
Deselect Path Click outside Path



Path List - Keyboard Shortcuts

Attribute dialog for current selection Double-Click item
Selection layer order Click-and-Drag item in list
Select/Deselect multiple list items Shift-Click
Render/Un-render path Enter

Drawing Buttons
Drawing Button 1 (Unconstrained Draw) Shift-1
Drawing Button 2 

(Draw Outside and Mask Inside) Shift-2
Drawing Button 3 

(Draw Inside and Mask Outside) Shift-3

Visibility Buttons
Visibility Button 1 (View Canvas) Shift-4
Visibility Button 2 (View Mask) Shift-5
Visibility Button 3 (View Selection) Shift-6



Dynamic Adjustment - Keyboard Shortcuts

Resize Drag Corner Handles
Resize--preserve aspect Shift-Drag Corner Handles
Resize--one dimension Drag Side Handles
Skew Ctrl-Drag Side Handles
Rotate Ctrl-Drag Corner Handles



Shape Tools - Keyboard Shortcuts

Shape Selection Tool toggle Ctrl

Shape Design Tool
Shape Objects Tool
Shape Selection Tool



Shape Design Tool - Keyboard Shortcuts

Pen
Make corner point Click on last point

QuickCurve
Add to current endpoint Click and Draw from Endpoint



Shape Objects Tool - Keyboard Shortcuts

Rectangle
Constrain to Square Shift

Circle
Constrain to Circle Shift



Shape Selection Tool - Keyboard Shortcuts

Direct Selection
Select start point of shape Home
Select end point of shape End
Select previous point in shape Page Up
Select next point in shape Page Down

Whole Shape Selection
Move path by one screen pixel Arrow Keys
Delete selected shape Delete



Scripts - Keyboard Shortcuts

Record a 5-second delay to script _ (underscore)



Frame Stack Navigation - Keyboard Shortcuts

Play Movie Shift-Ctrl-P
First Frame Of Stack Home
Last Frame Of Stack End
Next Frame Page Up
Previous Frame Page Down
Stop at Current Frame Alt-Stop Button
Stop and Return to Current 

Starting Frame Ctrl-. (period)



Lighting - Keyboard Shortcuts

Lighting Mover Shift-Ctrl-L



Magic Wand - Keyboard Shortcuts

Add color to selection Shift-Wand
Find all instances in area Selection Wand



Saving Files

Documents
To name and save a document, choose File menu> Save As. Use the pop-up menu next to the 
word Type to save your document in any of the formats Painter supports.

RIFF Format
We recommend that you save working files (files in-process) in RIFF format.
RIFF lets you compress files and save disk space with a lossless compression method. This 
option is dimmed with other formats.
Select the RIFF format and uncheck the box next to the word Uncompressed. 
RIFF also is the only format in which you can save floaters and shapes keep them floating. When 
you have completely finished working with a file, you can save it in another format.

GIF File Format
Painter 4 allows you to save documents in GIF file format. GIF is an 8 bit (or less) file format used 
to exchange files on CompuServe or to display graphics on the Internets World Wide Web 
(WWW). 
When you save a file as a GIF, you can choose from 4 up to 256 colors. You can choose how 
your colors will be displayed and what part of your image will be transparent. 

You will pick an Imaging Method to determine how your 24-bit Painter document will be converted 
to the limited number of colors that GIF uses. If you choose Quantize to Nearest Color, Painter 
will look at each pixel and will pick the nearest color. If you choose Dither Colors, Painter will 
apply a pattern to the colors chosen to generate a more accurate, less banded result. Use the 
Preview Data button to see how the GIF file looks. 

If you want your image to have transparency, click the checkbox for Output Transparency. Most 
programs that display GIF files support transparency, but for those that dont, you need to specify 
the color of the transparent area. If your image will be displayed on the World Wide Web, click the 
radio button for Background is WWW Gray. You can also choose to use the background color of 
your Painter document by clicking the radio button for Background is BG color.

For programs that support transparency, your mask layer will determine which areas are 
transparent and which are not. The Threshold slider determines what mask value becomes 
transparent. Use the Preview Data button to see how the Threshold slider is affecting the 
transparency of your image. Transparency is displayed in the Preview window by a rectangular 
lattice. You may toggle between the Preview window and your Save As GIF options to get exactly 
what you want.

Click the checkbox for Interlace GIF File if your image will be displayed on a WWW page. This will 
make your image appear and display faster, rather than drawing from top to bottom.

JPEG File Format
Painter 4 supports the Joint-Photographic-Experts-Group (JPEG) file format. Because of its small 
file size and high quality, JPEG is commonly used to transmit files via modem. Unlike GIF, JPEG 
displays a full range of colors. 

JPEG allows you to compress your file on a scale of Fair to Excellent, where quality is directly 
proportional to file size. These quality settings will let you achieve compression ratios of less than 
10-to-1, to greater than 100-to-1. JPEG is a lossy file format, meaning that a decompressed 
JPEG file will not be pixel-for-pixel identical to the original. However, because the JPEG algorithm 
takes into account the sensitivity of the eye to different colors, the higher quality settings should 
achieve visually satisfying results. 

To save a file as a JPEG, choose File menu> Save As and select JPEG from the list of file types. 



Click the Save button and the JPEG Encoding Quality dialog box appears. Excellent will 
compress the least but will retain the most data. Fair will compress the most but will lose the most 
data. 

It is best not to de-compress and re-compress a file multiple times. Although JPEG can compress 
and discard data that is not visible or obvious, the degradation of the data can affect the condition 
of your file. When a file has lost a significant amount of data, blocky patterns may appear in areas 
of the image. If you try to use Painters Apply Surface Texture feature on a JPEG file, you may find 
it will accent the blocky patterns.

Photoshop 3.0 files
Painter 4 supports the reading and writing of image data in the Photoshop 3 file format, including 
the conversion of Photoshop layers into Painter floaters, and vice-versa.

Layers
When reading in a Photoshop 3.0 file with layers, each Photoshop layer is automatically trimmed 
and converted to a Painter floater with the appropriate opacity. These layers become very efficient 
floaters, which can be moved and manipulated with Painters Floater Adjuster Tool. All of 
Photoshops layer blending modes are supported by Painter. However, due to differences in the 
way Photoshop and Painter deal with color conversions, a few blending modes will look slightly 
different in Painter than in Photoshop. Once brought back to Photoshop, the file will look exactly 
the same as it did before it was brought into Painter. 

Painters Pseudocolor compositing method is not supported in Photoshop. Pseudocolor is mapped 
to Photoshops Normal compositing method. Note that in Painter, Normal and Default methods are 
identical. Normal is included for compatibility with Photoshop. 

Photoshops user-defined layer masks are automatically consolidated in the mask layer for each 
floater within Painter. When you bring images with layer masks back to Photoshop from Painter, 
the layer masks will have been combined with the non-editable transparency mask for each layer. 
In addition, Photoshops ability to clip layer data to the layer below is not supported by Painter.

When saving Painter documents as Photoshop files, each Painter floater is converted to a 
Photoshop layer. Opacity and composite methods are maintained whenever possible. Grouped 
floaters become separate Photoshop layers.

Paths
Photoshop paths are converted to Painter paths and vice-versa. Painter is also compatible with 
Photoshop subpaths. If the Photoshop path consists of subpaths that are completely separate 
from each other (i.e. they dont intersect), each of these subpaths will be converted to an 
individual Painter path. If any of the subpaths have holes in them (i.e., some subpaths lie 
completely inside other subpaths), each Photoshop subpath with holes will be converted to a 
Painter path with holes.

When saving Painter documents as Photoshop files, each Painter path will be converted to a 
Photoshop path. If a Painter path consists of holes, the path will be converted to a Photoshop 
path consisting of the original path and subpaths for each hole. Painters grouped paths will be 
opened as individual paths in Photoshop.

Masks & Channels
When reading a Photoshop 3.0 file with channels, Painter will read in the fourth channel as a 
Painter canvas mask. When saving a Painter document with a mask as a Photoshop 3.0 file, the 
mask of the image will be saved as the fourth channel in the Photoshop file. Painter does not 
support transparent images. Therefore, when you import a transparent Photoshop 3 file, Painter 
will automatically create a blank background on which all of the layers will sit.

Saving in EPS



Painters EPS files conform to the Desktop Color Separation format (EPS-DCS 5-file format). 
Although Painter save files in EPS-DCS, it cant read EPS-DCS. If you plan to save an image in 
EPS-DCS, its a good idea to save it in another format first so you will have a copy of it that you 
can reopen in Painter.

When you save a file in EPS-DCS, youll see the EPS Options dialog box. 

Hex (ASCII) Picture Data
This is just another way of storing PostScript information. Some programs, such as PageMaker, 
require that this option be checked. The file sizes will be approximately twice as large when saved 
with this option.

Suppress Dot Gain
Painter provides controls for dot gain in its PostScript Setup dialog box. You may, however, prefer 
to set dot gain in your page-layout program. To disable Painters dot gain adjustments, check the 
box next to Suppress Dot Gain.

Suppress Screen Angles
Like dot gain, screen angle can be designated in Painters PostScript Setup dialog box. To disable 
Painters screen angle adjustment, check the box next to Suppress Screen Angles.

Use Page Setup Settings
Painter includes a file called Printer Settings, which is calibrated for an imagesetter at 133 lpi, 
standard screen angles, and a dot gain of 16%. If you wish to override these settings and use 
your own settings in the Page Setup dialog box, click the box next to Use PostScript Setup 
settings. For more information on these printer settings, see    Printing.

Spot Type
TheSpot Type pop-up menu gives options for the shape of the dots that make up your halftone 
screen grid. Most of the shapes listed in the pop-up menu, such as Dot, Line, and Ellipse, are 
self-explanatory. The Custom setting lets you create your own spot shape using a PostScript 
command. Youll have to know the PostScript language to do this. In a text file, write the 
PostScript equivalent of the spot you want to design. For example, heres how to describe a shape 
that resembles a diamond:

180 mul sin exch 180 mul sin add 2 div

Next, name the text file Custom Screen and place it in your Painter folder. Now go back into 
Painter and choose Custom from the Spot Type pop-up menu. Painter will access this Custom 
Screen document and make your dots resemble diamonds. If you create a few PostScript spot 
shapes, each will have its own text file, and youll use them one at a time, renaming each file 
Custom Screen so Painter can find it.

Save PostScript data into main file
To save a printable preview of an EPS-DCS document, check Save PostScript data into preview 
file. The two radio buttons under this checkbox tell Painter whether the preview data should be 
saved in black and white or color.

If you have an older laser printer, you may have to use the black and white preview to print these 
files on your laser printer. Although the preview or display is black and white, the color information 
remains intact.



Painting
In Painter, you can paint by simply selecting the Brush Tool, choosing a brush from the Brushes 
Palette and making marks on the canvas. The particular variant of that brush you choose, 
determines the appearance of the marks you make. Painter provides a drawer full of different 
brushes, each with its own characteristics. Many of the brushes are digital equivalents to the 
traditional media youre familiar with. Using these brushes, you can create images that look like 
they were hand painted on real canvas or textured paper.

Some brushes contain special image-editing capabilities. These brushes--including the Image 
Hose, Cloners Brush, and Water--take advantage of the computers power to produce effects that 
wouldnt be possible with traditional media alone. 

Many of Painters brushes respond to the additional control provided by a stylus and graphics 
tablet. Brush strokes fade in and out, change width, or penetrate based on the pressure of the 
stylus. 

Because you use a stylus the same way you draw and paint with pencils, pens, and brushes, the 
stylus has a familiar feel. You can apply your experience with the traditional tools directly to the 
Painter canvas and youll get natural-looking strokes.

Painters brushes overflow with features. This section covers Painters brushes and the basics of 
painting. Youll learn how to make marks, choose a brush and variant, resize a brush and create 
and save new variants. The built-in brush variants will be described in detail. 

See Also:
Starting to Paint
Selecting Brushes and Variants
Texture
Selecting Colors
Basic Brush Controls
Using a Stylus versus a Mouse to Make Brush Strokes



Starting to Paint
To paint, youll need to choose a brush, choose a variant, select a color, and mark in the document 
window.

One thing to consider when choosing a brush is whether it applies color that builds up or covers. 
A real-world example of build-up is the crayon: Scribble on the page with blue, then scribble on 
top of that with green, then red. the scribbled area keeps getting darker--approaching black. Even 
if you were to apply a bright color like yellow, you couldnt lighten the scribble, it would stay dark; 
this is build-up.

An example of cover is oil paint. No matter what colors you paint, you can always apply a layer of 
paint that completely hides the underneath. Even with a black background, a thick layer of yellow 
will be pure yellow. 

Build-up and Cover are called methods. Methods are categories that describe brush behavior. 
The brush methods are build-up, cover, eraser, drip, mask, cloning, wet. Brush methods are 
described in Advanced Painting.

Another important quality is the degree of anti-aliasing. Anti-aliased brush strokes have soft 
edges. The color dissipates over a few pixels to the background. 



Selecting Brushes and Variants
Painters brushes are stored in the Brushes Palette. You can show the Brushes palette in any of 
three ways: select Window menu> Brushes, press x-2, or double-click the Brush Tool in the 
Tools Palette.

Painter provides a number of different brushes: pencil, eraser, ink, etc. Each of these brushes is 
further divided into variants. A variant is a specific version of that brush. For example, the Pencil 
brush offers the following variants: Colored Pencils, Thick & Thin Pencils, a 2B Pencil, a Sharp 
Pencil, a 500 lb. Pencil, and a Single Pixel Scribbler.

Complete descriptions of each brush and variant are in Built-in Brush Variants.

To select a brush from the palette, click the icon for the brush you want. You may have to open 
the palette drawer to find a particular brush. When the drawer is open, you may also select a 
brush from the Brushes pop-up menu.

Painters built-in brush variants are so cool that many artists will use them with only the basic 
adjustments--size, opacity, and the amount of paper grain revealed by the stroke. If you want to 
customize a variant, however, Painter offers a number of sliders that let you modify the brush 
effect. To retain these specific adjustments for future use, youll need to save the variant.    
Advanced Painting provides detailed information about customizing brushes and saving variants. 



Texture
In the natural world, a marking tool has different effects on surfaces of different textures. Painter 
allows you to control the texture of the paper to achieve the results youd expect from natural 
media on a given surface--pencil on watercolor paper, markers on cotton paper, paint on canvas, 
etc. 

The different brush variants interact with the canvas texture at different levels. You can control the 
texture of brush strokes in three ways: 

By changing the paper texture Applying Art Materials.
By changing the Grain slider on the Controls Palette: Brush Tool.
By changing the stroke of the stylus on the pressure tablet. In most cases, a light stroke 
colors only the peaks and ridges of the paper grain. A heavy stroke fills color deep into 
the pockets and valleys. 



Selecting Colors
Before painting, youll want to choose a color. Usually, youll pick colors from the Art Materials: 
Colors Palette. You could also sample colors from an existing image using the Dropper Tool.

Click or drag in the ring to select the hue.

Click or drag in the triangle to select a color.

To easily select black, drag from anywhere in the triangle, to the lowest point of the triangle. To 
select white, drag up instead of down. 

The color you select appears in front on the overlapping rectangles. This is the Primary Color. 
The back rectangle shows the Secondary Color, which is used to create two-color brush strokes 
and two-point gradations.

To choose the secondary color, click the back rectangle, then select a color. 

Selecting a color on the Color Palette is just the beginning of working with color in Painter. Painter 
offers a powerful range of color features, including random color variability and color sets. See 
Applying Art Materials for more information.



Basic Brush Controls
The basic brush controls for Opacity and Grain are found on the Controls Palette when the Brush 
Tool is selected.

Opacity
The Opacity slider controls the degree the stroke covers or builds up on the underlying colors. 

When Opacity is at maximum, the color is solid, completely covering, or building up, on the 
underlying colors.

With Opacity low, the color is thin. Youll see through to the underlying colors. 

Grain
The Grain slider controls how much color penetrates into the paper. 
Moving the Grain slider to the right intensifies penetration of the color. This allows less paper 
grain to show through. 
Moving the slider to the left reduces the strokes penetration, which reveals more paper grain. 

Brush Size
Painter offers a number of features for resizing and shaping brushes. Resizing brushes becomes 
technical quickly. This information is covered in detail    in Advanced Painting

In some cases, the brush must be built. Press x-B to build the brush or choose If you try to paint 
with an un-built brush, Painter will alert you.

If resizing the brush has made its stroke broken, youll need to adjust Spacing. See Advanced 
Painting.

Making Strokes
With an open document and a selected brush variant and color, youre ready to start drawing or 
painting. 

Some qualities of your strokes will vary, depending on whether youre using a stylus and pressure 
tablet or a mouse. With a stylus, you can adjust the pressure to control the weight of the stroke. A 
mouse can access certain options, you just need to make adjustments in the Sliders palette. For 
more information, see    Advanced Painting.

Freehand stroke
With the Brush Tool selected in the Tools palette, set the Draw Style to Freehand by clicking the 
radio button in the Controls: Brush Palette.

Position the cursor where you want to start painting. 

Push down on the stylus, or press the mouse button, and drag. A stroke of color will flow from the 
cursor. When youre finished, let up on the stylus or release the mouse button.

With complex brushes, such as the Van Gogh brush and the Hairy Brush, you wont see the stroke 
immediately. These complex brush strokes must be precomputed, which delays their appearance 
on screen. A dotted line will follow the cursor. When you release, the stroke will appear. These 
brushes work best when you apply them in short strokes. Wait until the stroke appears before you 
start another one.

Drawing    in Straight Lines



With the Brush Tool selected in the Tools palette, set the Draw Style to Straight Lines by clicking 
the radio button in the Controls Palette.

1) Click the stylus or mouse where youd like your stroke to start. An origin point marker 
will appear there.

2) Click and hold where you want your stroke to finish. A thin line connects the two 
points. Before you release, you can move the cursor around and place the finishing 
point exactly where you want it. When you release, Painter draws a brush stroke 
between the two points.

To constrain your line to a 45 degree or 90 degree    angle, hold down the Shift key as you click 
your second point. Lines automatically are constrained to a grid if the grid is turned on.

If you click without dragging, Painter will connect the points with a stroke. Continue to click, 
adding as many segments as you like. You can connect the last point to the origin (to close the 
shape) by pressing the Return key. 

If you want to disconnect from the last point, click the radio button for Freehand drawing style, 
then click the Straight Lines radio button again.

Recording and Playing Back Strokes
Painter will repeat any stroke you record, anywhere you click. This is a great way to create a 
series of identical strokes, for example, in hatching.

You might use Auto Playback with a faint or stipple stroke to scatter color across an image. 

This feature can produce some amazing results when you use a cloned image as the color 
source. Auto Playback with a cloned photograph as the color source can quickly produce an 
image that appears to be a painted version of the photograph. The brush variant you choose and 
the stroke shape you record will determine the media and technique of the painting. See    Cloning 
and Tracing for more information.



Using a Stylus versus a Mouse to Make Brush Strokes
Most stylus and graphics drawing tablets provide 256 levels of pressure information. The mouse 
has no pressure information. The mouse is either on--button down, or off--button up. 

Many of Painters brushes respond to the pressure information provided by the drawing stylus. 
Greater pressure increases the width of a brush stroke, the penetration of color, the amount of the 
secondary color, or the degree of some other effect, depending on the variant. 

If you are using a mouse with Painter, you can modify individual brushes to respond to 
information other than pressure. The easiest way to modify a brush is with the basic controls 
(opacity, grain, and size) before drawing a series of strokes. This will compensate for brushes that 
vary these factors according to pressure.

Another way to modify a brush is with the Brushes Palette: Controls menu> Sliders Palette. Here 
you can modify the brush to respond to factors like velocity and direction instead of pressure. See 
Advanced Painting, for information on using the Sliders palette. 

The following descriptions of the variants outline the behavior of a brush when pressure 
information is available. If you are using a mouse to paint, youll want to modify a brush to achieve 
those pressure-sensitive effects. Modifying brushes will help you get the most out of the mouse 
as an input device.



Built-in Brush Variants

Brush
The Brush provides effects youd expect from oil paints and acrylics. All of the Brush variants 
cover underlying brush strokes, and many are capable of multi-colored strokes.

See Applying Art Materials, for information on defining the colors for multi-color brushes. 

Some of the Brush variants, like Loaded Oils, give the striated effect of real bristles. Using these 
variants with Apply Surface Texture in the Effects menu produces some great oil or acrylic-like 
brush strokes. 

Hairy Brush
The Hairy Brush simulates strokes made by a bristle brush, showing semi-anti-aliased brush hair 
lines. The Hairy Brush interacts with paper grain and is pressure sensitive in terms of opacity and 
stroke width. The Hairy Brush can paint multi-color strokes. 

You can customize the Hairy Brush dramatically by adding bristles and opening up space 
between them. For instructions, see    Advanced Painting.

Graduated Brush
The Graduated Brush is ideal for shading. It paints semi-anti-aliased brush strokes of just the 
primary color or the primary and secondary color, depending on pressure. It interacts with paper 
grain, and its stroke width is also determined by pressure. 

See Applying Art Materials, for instructions on selecting primary and secondary colors.

Cover Brush
The Cover Brush produces brush strokes that have soft, anti-aliased edges. It does not interact 
with paper grain. Stroke width and opacity are determined by pressure. 

Penetration Brush
This brush has hard, aliased edges. Its strokes look like acrylics when you apply surface texture 
to them using the Effects menu (described in Image Editing and Effects). The Penetration Brush 
reacts to paper grain. Pressing lightly with a stylus allows more paper texture to show through; 
pressing heavily reveals less texture. 

Oil Paint
The Oil Paint brush gives you strokes that have hard, aliased edges. Its strokes interact with 
paper grain. Stroke width and opacity are determined by pressure.

Camel Hair Brush
The Camel Hair Brush gives soft, anti-aliased strokes. Dragging quickly narrows each bristle; 
dragging slowly widens each bristle. Opacity depends on pressure.

Rough Out
Rough Out acts like a fast, dry brush and is ideal for roughing out ideas. The faster you drag your 
stylus, the thinner the lines. Dragging slower produces thicker lines. The amount of paper grain 
revealed by this brush depends on pressure. Pressing lightly reveals more paper grain; pressing 
harder reveals less grain.



Big Rough Out
This variant is a wider version of Rough Out.

Huge Rough Out
This variant is an even wider version of Rough Out.

Digital Sumi
The Digital Sumi Brush variant is a multiple-bristle brush made up of single-pixel bristles. 
Pressure affects width.

Loaded Oils
The Loaded Oils brush simulates the look of a traditional loaded brush--a brush dipped in more 
than one color. Use Color Variability to adjust how loaded oils appear. For more information about 
Color Variability see Applying Art Materials.

Small Loaded Oils
This variant is a narrower version of Loaded Oils.

Big Loaded Oils
This variant is a wider version of Loaded Oils.

Big Wet Oils
Big Wet Oils is a wide loaded brush that mixes with the colors in the image.

Brushy
Brushy is a multi-bristle brush that runs out of paint toward the end of a stroke and picks up colors 
its dragged through.

Fine Brush
The Fine Brush is a very fine-hair brush that changes scale quickly based on pressure.

Sable Chisel Tip Water
This variant is a fine-hair brush that uses water to smear the colors in an image.

Coarse Hairs
The Coarse Hairs brush produces a stroke with a small number of coarse hairs that change scale 
quickly based on pressure.

Smaller Wash Brush
The Smaller Wash Brush has a multitude of fine, closely spaced bristles that mix and smear the 
current color with colors in an image.

Ultrafine Wash Brush 
This variant is similar to the Smaller Wash Brush but with a larger bundle of finer bristles.



Big Wet Ink
Big Wet Ink is a thick striated brush, loaded with ink. It has a soft appearance and looks like the 
bristles are spread apart.

Big Dry Ink
Big Dry Ink is like Big Wet Ink, but with a bit harder edge.

Artists
The Artists brush helps you paint in the styles of the master artists. Paint in the style of Vincent 
Van Gogh, where your brush strokes are multishaded, or in the style of Georges Seurat, where 
multiple dots combine to form an image. 

With all the Artists variants, dragging quickly produces narrower strokes, dragging slowly 
produces wider strokes. Use Color Variability to adjust how the artists strokes appear. For more 
information about Color Variability see Applying Art Materials.

Van Gogh
One of the things that made Vincent Van Goghs style special was his use of multicolored brush 
strokes. The Van Gogh brush recreates this style with a multicolored, anti-aliased brush stroke 
that hides underlying colors. 

This is a complex brush and the strokes must be pre-computed; hence the dotted line that follows 
the cursor during the stroke. For best results, use shorter strokes with this brush, and wait for 
them to render before making new strokes.

Van Gogh 2
Van Gogh 2 has about the same look as Van Gogh but it paints interactively--the strokes do not 
have to be pre-computed.

Seurat
Georges Seurat painted in the pointillist style, a neo-Impressionist technique of using clusters of 
dots to represent the subject. The Seurat brush automatically creates multicolored, anti-aliased 
dot clusters. To add more dots, drag over the area again.

You can regulate dot size on the Size Palette accessed from the Brushes Palette:
Controls menu>. Move the Size slider to the right to make the dots bigger.

Impressionist
This brush re-creates the style of the Impressionists who painted with flattened dabs of color. The 
direction you drag determines the angle of the dab. 

You can use the Impressionist variant to push around existing paint in an image by moving the 
Opacity slider to the left.

Auto Van Gogh
This variant works in conjunction with the Effects menu> Esoterica> Auto Van Gogh command. It 
produces similar results as the Impressionist variant, in terms of directional strokes, but achieves 
the look in a different way. With Auto Van Gogh, the direction of the individual brush dabs is 
determined by the brightness of the areas in the clone source. 

See    Cloning and Tracing for information on using Auto Van Gogh, and Image Editing and Effects 



for information on basing brush stroke direction on Original Luminance.

Flemish Rub
This variant creates an effect similar to the Impressionist and Auto Van Gogh variants. The 
difference is that Flemish Rub smears existing color instead of applying new color. Use this 
variant to apply an impressionistic effect to an existing image.

Piano Keys
This variant creates a colorful ribbon-like effect that follows the direction of your stroke. Piano 
Keys uses a closely spaced, thin captured rectangular tip to produce the effect. 

Liquid
The Liquid variants treat the underlying image as though it was floating on a thick liquid. The 
brush stroke drags image colors behind it.    This can be particularly useful when working with 
cloned photographs. These brushes can create a palette knife painting effect.

To smear existing paint--without adding color--move the Opacity slider all the way to the left. 

To smear while adding some color, move the Opacity slider to the right. 

Stylus pressure affects paper texture differently for the Liquid variants (drip method). More paper 
texture is visible when you press heavily, and less paper texture is apparent when you press 
lightly. This follows the natural behavior of smearing--the harder you smear the paint, the more 
you will uncover the paper.

Drag these brushes slowly. The amount of pressure determines how much of the image you 
smear.

The Grain slider controls the strength of distortion a Liquid brush exerts on an image. 

Distorto
This variant moves paint around without adding color. Dragging quickly produces a thinner stroke; 
dragging slowly creates a wider one.

Smeary Bristles
This variant smears the primary color into the image. This variant is paper-grain sensitive. 
Dragging quickly produces a thinner stroke; dragging slowly creates a wider one.

Total Oil Brush
This variant is similar to Smeary Bristles, but produces a tighter stroke.

Smeary Mover
This variant is similar to Smeary Bristles, but it smears existing paint without adding color.

Coarse Smeary Mover
This variant is a semi-anti-aliased version of Smeary Mover.

Coarse Smeary Bristles
This variant is a semi-anti-aliased version of Smeary Bristles.



Coarse Distorto
This variant is a semi-anti-aliased version of Distorto.

Thick Oil
Thick Oil smears with a stroke loaded with the primary color.

Tiny Smudge
Tiny Smudge is a single-pixel, multi-bristled smudging tool.

Water Color
The Water Color brush variants produce some of the nicest effects in Painter. Using these 
variants youll produce natural looking watercolor paintings.

The Wet Layer
Water Color brushes are different from the other brushes. Water Color brushes paint into the wet 
layer, which has special properties that enable the colors brushed into it to flow and mix. 

The wet layer floats over the image. This separation of layers enables effects and techniques that 
wouldnt otherwise be possible. You can edit the watercolors, including erasing and blurring, 
without changing anything in the image layer. For example, you can draw pencil outlines in the 
image layer, then overlay watercolor shading without smudging the pencil lines. 

You cant edit the wet layer with image-layer tools. If youre using the image eraser and it has no 
effect on a brush stroke, that stroke may be in the wet layer. Use the Wet Eraser instead. 

You cant use selection tools to select and delete an area in the wet layer. To clear the wet layer, 
choose Canvas menu> Dry and then select an area and press the Delete key, or use the Wet 
Eraser.

Drying the Wet Layer
When you are finished working in the wet layer, you can dry it by selecting Canvas menu> Dry. 
Drying the wet layer drops the watercolor image onto the paper. 

Once the watercolor image is dried, you cant do any more wet modifications to it. For this reason, 
you might want to save a copy of the file while the wet layer is still wet.

Water Controls
Water Color brushes have two special controls: Diffusion and Wet Fringe. These sliders are 
available on the Brushes Palette: Controls menu> Water Palette accessed through the Brushes 
Palette: Control menu. 

Diffusion
Diffusion controls the amount a stroke spreads out and blurs. High diffusion creates wonderful, 
soft, feathery edges. In terms of natural watercolors: low Diffusion is like painting on dry paper, 
and high Diffusion corresponds to painting on wet paper. 

Set diffusion before making strokes on the Brushes Palette: Controls menu> Water Palette. You 
can also use the post-diffuse key short-cut (Shift-D) immediately after you make a stroke. Use 
the key short-cut a second time to increase diffusion.



Wet Fringe 
When you paint with the Water Color variants, youll notice that color collects at the edges of the 
stroke. This pooling follows the behavior of natural watercolor. 

By adjusting the Wet Fringe slider you can control the amount of color at the edge for all strokes 
in the wet layer. You cant adjust pooling after you dry strokes. 

Watch the edges of your water color strokes darken as you drag the slider to the right. To 
minimize pooling, move the slider to the left. 

Strokes created with Diffusion have soft edges and, therefore, no fringe. So the Wet Fringe slider 
has no effect on diffuse strokes.

To get different pooling amounts for individual strokes: Adjust the Wet Fringe slider for one or 
more strokes, then dry them. Paint more watercolor strokes, and adjust the Wet Fringe slider 
again. 

The Water Color Brush Variants
All of the Water Color variants, except Wet Eraser, interact with the paper texture. The Grain 
slider works differently with the Water Color brushes than with the other brushes. With Water 
Color variants, moving the slider to the right makes paper texture more pronounced. Moving the 
slider to the left reduces the grain interaction.

Stylus pressure affects the width of the brush stroke for all the Water Color brush variants except 
Wet Eraser. Increased pressure widens the brush stroke; less pressure narrows the stroke.

Simple Water
The Simple Water variant leaves a stroke of the primary color without bristles.

Water Brush Stroke
This variant is a watercolor bristle brush. When you first make a stroke, a dotted line appears 
while Painter computes the stroke. 

Wet Eraser
The Wet Eraser removes watercolor strokes from the wet layer. The Wet Eraser is pressure 
sensitive. Pressing heavily erases more quickly. 

If youve dried the wet layer, use the regular eraser to remove the stroke from the image.

Pure Water Brush
This variant behaves like the Water Brush Stroke variant except without adding color. Use this 
variant to spread and blend the colors of existing watercolor strokes. If you want the colors of 
adjacent areas to blend, increase Diffusion.

Spatter Water
This variant spatters water randomly with each stroke.

Broad Water Brush
This variant paints a wide brush stroke that shows its bristles. 

See    Advanced Painting, for ways to customize bristle brushes.



Large Water
This variant paints a broad wash of color.

Large Simple Water
This is a larger version of the Simple Water variant.

Diffuse Water
This variant produces a stroke with diffuse edges (refer to the description of Diffusion at the 
beginning of the Water Color section).

Airbrush
The Airbrush applies a fine spray of color. The Airbrush covers underlying colors. Stylus pressure 
determines the concentration of color. 

Fat Stroke
The Fat Stroke Airbrush variant covers a large area with a soft, anti-aliased paint stream. 

Thin Stroke
This variant covers a smaller area than Fat Stroke.

Feather Tip
Feather Tip is a small sized variant that paints soft, anti-aliased lines of varied widths. The width 
variation is more apparent when you widen the brush size. 

Spatter Airbrush
The Spatter Airbrush introducing a random texture into the airbrush spray. This variant produces a 
semi-anti-aliased stroke. Stylus pressure determines how much paper grain is revealed. 

The results vary with different paper textures. Experiment with different textures and see how the 
brush stroke is affected.

Single Pixel Air
This variant is a single-pixel airbrush. Color builds up based on pressure.

Pencils
Pencils are great for anything youd use real pencils for, from rough sketches to fine-line drawings. 
Like their natural counterparts, Pencils interact with paper texture. 

All the Pencil variants build to black. Pencils are pressure sensitive in terms of opacity. The 
Colored Pencils variant is an exception. Colored Pencils have uniform opacity regardless of 
pressure.

With the Colored Pencils, 2B Pencil, Sharp Pencil, and 500 lb. Pencil variants, dragging quickly 
produces a thinner line; dragging slowly leaves a thicker line. 

The thick-to-thin variation becomes more apparent as you move the n the Brushes
Palette: Controls menu> Size Palette accessed from the Brushes Palette: Controls menu to the 
right. 



Colored Pencils
The Colored Pencils variant produces lines with semi-anti-aliased edges. 

Thick & Thin Pencils
With this semi-anti-aliased variant, line width depends on the direction of your stroke.

2B Pencil
This variant is a soft lead pencil that produces thin, anti-aliased lines. 

Sharp Pencil
This variant is a hard lead pencil with semi-anti-aliased strokes. 

500 lb. Pencil
The 500 lb. Pencil creates fat, semi-anti-aliased lines. 

Single Pixel Scribbler
The Scribbler has a one-pixel pencil point. Pressure affects opacity.

Eraser
Painter has two ways to remove color: the Eraser variants, which erase down to the paper color, 
and the Bleach variants, which erase to white. Darkeners are Eraser variants that increase color 
density, building colors toward black. Darkeners are the inverse of Bleach. 

With all the Eraser variants, pressure determines how much you erase. To erase lightly, press 
gently. 

If youre using a mouse, the Opacity slider controls how much you erase. With an eraser variants 
opacity at 100%, it will completely remove color at one stroke. With opacity low, the eraser 
removes color gradually.

Flat Eraser

Fat Eraser

Medium Eraser

Small Eraser

Ultrafine Eraser

Fat Bleach

Medium Bleach

Small Bleach

Ultrafine Bleach

Single Pixel Bleach

Fat Darkener

Medium Darkener



Small Darkener

Ultrafine Darkener

Water
Water smudges and dilutes existing colors in the image. It doesnt add any color. All of the Water 
variants are pressure sensitive--the harder you press, the more youll smear the image. 

The Water variants work in the image layer. They are not associated with the wet layer or the 
Water Color brushes. 

Just Add Water
This variant smudges with smooth, anti-aliased strokes. It removes paper grain and responds to 
the velocity of your stroke, smearing more when you drag slowly. 

Grainy Water
This variant reacts to paper grain. It is ideal for smearing existing textured strokes because it 
helps them maintain their graininess. You can also use it to add texture to smooth strokes.

Frosty Water
This variant smears with a hard-edged, brittle stroke. Try choosing other paper textures for some 
different results.

Tiny Frosty Water
This variant is a sharpened version of Frosty Water.

Big Frosty Water
This variant is a large version of Frosty Water.

Single Pixel Water
This is the smallest Water brush available, similar to wetting a single hair and using it to smear an 
image.

Water Spray
This variant sprays pixels of water onto the image.

Water Rake
This variant is a multi-bristle water applicator.

Chalk
Chalk produces the thick, rich texture of the natural pastel sticks. Chalk covers with strokes that 
interact with paper grain. 

The Chalk variants are pressure sensitive in terms of opacity. Adjust the Opacity slider to get the 
same effect with a mouse. 

Artist Pastel Chalk



This variant produces a medium width, semi-anti-aliased stroke.

Sharp Chalk
This variant is a sharper version of Artist Pastel Chalk.

Large Chalk
This variant is a wider version of Artist Pastel Chalk.

Square Chalk
This variant uses a captured rectangular tip to produce a chiseled edge.

Oil Pastel
This variant slightly smears the underlying color. It uses a captured triangular tip to produce a 
chiseled edge.

Charcoal
Charcoal leaves covering strokes that interact with paper grain. Both Grain and Opacity are 
pressure sensitive.

Gritty Charcoal
Gritty Charcoal gives deep-toned, semi-anti-aliased strokes. The width of the stroke depends on 
the direction you drag. 

Default Charcoal
This variant produces heavily textured, semi-anti-aliased strokes.

Soft Charcoal
Soft Charcoal produces a soft, anti-aliased stroke.

Pen
The Pen variants give you ink pens that never clog, spatter or run dry. 

Fine Point
The Fine Point variant produces a ballpoint pen stroke that reveals paper texture.

Smooth Ink Pen
This variant behaves like the traditional fountain pen. Strokes get darker as you layer them. 
Stroke width and paper grain depend on pressure. Heavy pressure produces a wide stroke that 
penetrates the grain. Light pressure produces a narrow stroke that reveals grain. 



Calligraphy
The Calligraphy Pen is great for old fashioned lettering. The line width varies with the direction of 
the stroke. 

Heavy pressure produces a wide stroke; light pressure produces a narrow stroke.

Keep the Opacity slider in its default position for the most ink-like lines. 

With variants where direction determines stroke width, you can set the angle where the width 
changes. See    Advanced Painting, for information.

Pen and Ink
With the Pen and Ink variant, the width of the stroke is determined by how fast you drag. The 
faster you drag, the thinner the lines become. 

Flat Color
This variant lets you cover large areas with even color.

Scratchboard Tool
To create a scratchboard drawing: open a new document and choose black as the paper color. In 
the Art Materials: Color Palette, select white, or any other color, as the primary color.

Now you can scratch out your design with this variant. Line width depends on pressure.

The scratchboard variants work just as well with dark colors on a light background or with clone 
colors on any kind of background.

Scratchboard Rake
This variant is a multi-toothed version of the Scratchboard Tool. This brush is ideal for crosshatch 
shading. Line width depends on pressure. 

Pixel Dust
Pixel Dust sprays a random distribution of pixels.

Single Pixel
The Single Pixel variant draws with a single pixel brush. 

This variant is not pressure sensitive. 

Use this variant with the Straight Lines drawing style to draw single-pixel lines.

Leaky Pen
This variant leaves a scattering of drops, like youd expect from a leaky pen. The slower you drag, 
the bigger the drops.



Felt Pens
The Felt Pens variants draw smooth, anti-aliased lines that build toward black as you layer 
strokes. Pressure determines opacity for all of the Felt Pens.

Fine Tip Felt Pens
This variant draws narrow strokes. 

Medium Tip Felt Pens
This variant draws medium-width lines. Drag quickly for a narrow stroke. Drag slowly for a wider 
one. 

With variants where drag speed determines stroke width, you can adjust the width range and the 
smoothness of transitions between wide and skinny in the Size Palette. 

Felt Marker
The Felt Marker produces a softer shade than the Felt Pens. The direction of the stroke 
determines its width.

With variants where direction determines stroke width, you can set the angle where the width 
changes. See    Advanced Painting, for information.

Dirty Marker
The Dirty Marker produces shades that build toward black more quickly than those made with the 
Felt Marker. The direction of the stroke determines its width.

Single Pixel Marker
This variant is a one-pixel Felt Pen. Pressure affects opacity.

Crayons
The Crayons produce semi-anti-aliased strokes that interact with paper texture and build up as 
you layer them. Pressure determines opacity and grain. 

Default
This is a basic crayon.

Waxy Crayons
This variant smears the primary color with the underlying colors.

Masking Brushes
Masking Brushes paint in the mask layer. They are described in Selections and Masks.

Dodge
Dodge lightens the colors of the image. 



In the traditional world, dodge is a photographers technique. A photographic print is made in the 
darkroom by projecting the negatives image onto light-sensitive paper. While making a print, a 
photographer might mask a small portion of the image for a few seconds. The photographer 
keeps the mask moving, dodging it over the paper, so that it wont leave an outline. When the 
exposure is finished, the area that was dodged received less light. When the paper is developed, 
the dodged area is lighter.

Burn
Burn darkens the colors of the image. 

In the traditional world, burn uses the same technique as dodge, but with the opposite mask--one 
that covers most of the image. The un-masked portion receives more light during the exposure, 
so it develops darker. 

Image Hose
The Image Hose is a special brush that applies full-grown images instead of color. The images it 
paints come from Nozzle files.

For complete information on creating Nozzle files, loading them, and controlling the Image Hose, 
see    Image Hose.



Floaters
Floaters are images, or portions of images, that float above the canvas. You can copy and move 
floaters around in the document to create just the composition you want.

Each floater is a separate image, so each floater you add to a document introduces another layer 
of information. Because each floater is distinct, you can move them around and edit them without 
interfering with the canvas image--or other floaters. Likewise, you can work in the canvas without 
interfering with any of the floaters. 

In RIFF format, Floaters stay floating even when you save the file, so you can make changes 
easily. Theres no need to redo the entire composition; just rearrange the floaters. The result is a 
dynamic and flexible design environment. 
Because you can manipulate floaters independently, they are considered objects. Painter has 
three types of floater objects: shapes, image floaters, and reference floaters. These object types 
have the floating characteristic in common, but differ in how you create them and what you can do 
with them.

In RIFF format, Floaters stay floating even when you save the file, so you can make changes 
easily. Theres no need to redo the entire composition; just rearrange the floaters. The result is a 
dynamic and flexible design environment. 
Because you can manipulate floaters independently, they are considered objects. Painter has 
three types of floater objects: shapes, image floaters, and reference floaters. These object types 
have the floating characteristic in common, but differ in how you create them and what you can do 
with them.

Shapes
Shapes are vector-based objects with instructions for stroke and fill. Shapes tools make it easy to 
create uniformly filled image objects, like text.
Shapes do not contain pixel information. You may convert a shape to an image floater, and in fact, 
some operations, like painting in a shape with a brush, or filling with a gradation, will convert the 
shape automatically. 
Shapes have excellent controls for adjusting the outline path. You can create shape paths and 
then convert them to selections.

See Also:
Image Floaters
Creating a Floater
Creating a Reference Floater
Saving files with Floaters
Dropping Floaters
Reference Floaters
Transforming a Reference Floater
Converting a Reference Floater to an Image Floater
Floaters as Image Maps for the Internets WWW



Image Floaters
Image floaters are discrete images that float above the canvas. Image floaters are stored as pixel 
information with a mask to define the image shape and opacity. You may paint and apply effects 
in image floaters.

Image floaters (or floaters) are used primarily for compositing images--moving portions of an 
image within a document, moving images between documents, and maintaining layers within a 
document.



Creating a Floater
Creating a floater is a two-step process; it involves making a selection and floating it. You have 
several options for accomplishing either step.

Making Selections in Floaters
You may use any of Painters selection tools. The Rectangle Tool, the Ellipse Tool, the Outline 
Tool, the Lasso and the Magic Wand are all useful. You also may create a shape and convert it to 
a selection.

You may also use any of the masking tools for selecting an image area: Auto Mask, Color Mask, 
and the masking brushes. 

When youve masked the area you want, turn it into a selection by choosing the third Visibility 
Button (View Selection) at the bottom of the document window. The selection must be active 
(displayed as marching ants) before you can float the image.

Floating Selections
With an image area selected (marching ants), you can float it.

On the Tools Palette, choose the Floater Adjuster Tool. Then click inside the selection to float it. 

If you are trying to deselect a floater, you dont want to click in the canvas as you might in other 
applications. Instead use the Edit menu> Deselect (x-D).

Another way to create a floater is by Copying or Cutting, then Pasting. Anything you Paste from 
the Clipboard appears in the Painter document as a floater. 

The Effects menu> Orientation commands: Rotate, Scale, and Distort, automatically float the 
image selection they are applied to. 

Creating a floater is just the beginning. You can move, copy, and use any of Painters tools and 
effects to modify a floater. You can also save a floater to a library for later use. 



Creating a Reference Floater
Reference floaters are temporary, low-resolution versions of image floaters. Youll convert an 
image floater to a reference floater when you want to transform it (rotate, resize, slant) by 
dragging its handles. When youve finished with such transformations, you may convert the 
reference floater back to an image floater

The reference floater state is just for transformations. If you try to paint in a reference floater, 
Painter immediately commits the transform and converts the reference to an image floater.

You may also work with a reference floater in terms of a Pyramid data structure. The Pyramid 
structure enables you to edit at a low resolution, then have Painter extrapolate your editing script 
to the high-resolution original. 

See Also:
Selections and Masks

Shapes, image, and reference floaters have the following characteristics in common:
They are subject to the layering hierarchy in the Floater List. This includes the related controls for 
selecting, hiding, naming, and grouping.

These features are described in Floater List.
They may be Cut, Copied, Pasted, moved onscreen, and aligned in the same ways. 
These features are described in Arranging Floaters.
They obey the floater composite method, which controls how the floater interacts with underlying 
images.
These features are described in The Composite Method: A Floaters Special Effects.



Dropping Floaters
Floaters continue to float even when deselected. When youre finished working with a floater and 
want it merged with the canvas image, you may Drop it. 
If you Drop a shape, it will be converted to an image floater and then dropped.
For information on the Drop with Mask option, see ®Drop with Mask®.



Saving files with Floaters
You can save your document in the RIFF format with live floaters. The floaters will be intact when 
you reopen the file. The RIFF format is the only format that saves floaters. If you save in another 
format, the floaters are automatically composited with the background.

When you save in Adobe Photoshop 3 format, floaters are assigned to appropriate image layers. 
Floaters in an image are listed in the Objects> F. List Palette



Reference Floaters
A reference floater is a special kind of image floater. It gets its image information from an external 
source--a reference image--which may be a standard floater in the current document or a 
separate file.

The reference floater is a low resolution, stand-in for the original image. Because it is low 
resolution, a reference floater can be quickly transformed in ways that would otherwise be 
prohibitively slow. 

Working with a reference floater allows you to transform a floater onscreen by dragging its 
handles. Possible transformations include resizing, rotating, and skewing. Transformations 
happen immediately. 

After transformations, you can convert the reference floater to an image floater. During 
conversion, Painter refers to the original image to improve the resolution. This makes the image 
cleaner.

Editing the image--with a brush or effect--is not allowed in a reference floater. When youve 
finished transforming the floater, you can convert it to an image floater, which you can edit.

Reference floaters (and the transformations they allow) are particularly useful when compositing 
high resolution images. 

See Also:
Creating a Reference Floater



Saving Files With Floaters
You can save your document in the RIFF format with live floaters. The floaters will be intact when 
you reopen the file. The RIFF format is the only format that saves floaters. If you save in another 
format, the floaters are automatically composited with the background.

When you save in Adobe Photoshop 3 format, floaters are assigned to appropriate image layers. 
Floaters in an image are listed in the Objects> F. List Palette



Floater List Palette

The F. List Palette keeps track of all the floaters in a document and provides special features for 
controlling them.

To open the F. List Palette: Click the F. List icon on the Objects Palette. 

The F. List Palette lists all of the floaters in the current document, with any selected floater 
highlighted and in bold type. If no floaters are selected, everything in the list appears in plain type. 
The floater list is arranged according to the layers, with the highest layer on top.

Icons identify each floater type.



Selecting Floaters
When you want to work with a particular floater, you must select it. 
To select a floater, click on it with the Floater Adjuster Tool. The floater selection marquee outlines 
the floater. You may also click the floaters name on the F. List Palette to select it.

To deselect a floater, click outside of it with the Floater Adjuster Tool. You may also choose Edit 
menu> Deselect (x-D). On the F. List Palette, you can deselect a floater by clicking in the empty 
space below the names. 

A deselected floater continues to float. That is, even though you dont see a selection marquee 
and the floater image appears to blend with the background, the floater is still a distinct object. 
Changes you make to the background will not affect the floater. This can lead to confusion. For 
example: If a floater is not selected--but you try to paint into it, your brush strokes will go to the 
canvas. Because the floater is concealing that part of the canvas, you wont see the strokes. To 
avoid this, remember to select the floater before you try to paint into it.

If you want a floater to stop floating, you must Drop it.



Hiding a Floater
If you want to hide a floater, click the Eye icon next to its name in the F. List. When the Eye is 
shut, the floater is invisible. To see the floater again, click the Eye to open it.

Hiding the Selection Marquee 
You can hide the selected floaters selection marquee by disabling the Show Selection Marquee 
option at the bottom of the F. List Palette or by pressing x-Shift-H. 



Naming Floaters
As the number of floaters in a document increases, it can become difficult to track which listing 
refers to which floater. Painter lets you give the floaters descriptive names, which makes them 
easier to keep track of.
 
The Floater Attributes dialog also gives the location of the top, left corner of the floater. You can 
move the floater to a specific location by changing the Top and Left values in the attributes dialog.

The Objects Palette: F. List Palette provides a way to organize and track the many floaters in an 
image. It lets you change the ordering of overlapping floaters and allows you to group floaters so 
that you can move them as a unit.



Ordering Floaters
All floating objects (shapes and floaters) appear in the Floater List. In the document, the floaters 
are displayed in order--that is, a floater higher in the list appears in front of the ones below it. 
Floaters that overlap in the document are layered--the foreground floater obscures the one behind 
it. 

By changing the ordering, you can control the composition of the several floating objects. There 
are two ways to do this--using the Objects Palette: F. List Palette or with the Controls Palette: 
Adjuster Tools.
The Controls Palette: Adjuster Tools is displayed when youre using the Floater Adjuster Tool.



Grouping and Ungrouping Floaters
Group floaters whenever you want to control them as a unit. You can move a closed floater group 
in any of the ways youd move a single floater. For example, after creating text shapes, you might 
want to group the words.

Painter allows you to create a mixed group--Shapes and image floaters. 

You can scale a group and create drop shadows for a group, but grouping does not allow you to 
paint across a set of image floaters with brush strokes.

You can ungroup the floaters any time. If you like, you can copy a group (Option-click) and save it 
in a floater library.

You can add a group into anther group in the same way--by dragging the group name into the 
group. Drag a floater out of a group to make it an individual floater again.

Closing and Opening a Group
Before moving a group, you must close it. 

To close a group, click the arrow to the left of the group name. When the arrow points to the right 
and the names of the group members are hidden, the group is closed.

If you want to edit individual floaters in a group or move them separately, you must open the 
group. 

To open a group, click the triangle to the left of the group. The arrow turns down, opening the 
group and revealing the names of its members. You may now select and work with them 
individually



Collapsing a Floater Group 
If you want to unite the group as a single floater, click the Collapse button on the F. List Palette. 
Collapsing reduces the group to a single image floater. You cannot isolate the original group 
members after collapsing.
If the group contains shape objects, Painter converts them to image floaters before collapsing 
them.



Moving Floaters
Once a floater is selected, you can drag it anywhere in the image with the Floater Adjuster Tool. 
You can also nudge the floater one pixel at a time by pressing the Arrow keys on your keyboard.
If moving an image floater leaves a hole in the canvas, Undo (x-Z), then hold down the Option key 
before dragging. This copies the floater. 



Moving a Floater to a Specific Location
Double-click the floaters name in the F. List Palette. The Floater Attributes dialog box appears. 
The Top and Left boxes show the floaters location with respect to the top, left corner (0,0) of the 
document. 
The reference point for the floater or group is the top, left corner of the floaters rectangle (or the 
groups selection marquee).
Enter the new values in the Floater Attributes dialog box. Increasing the Top value moves the 
floater down. Increasing the Left value moves the floater to the right. 
Positive and negative values that place the floater partially, or wholly, outside of the document are 
allowed.
Click OK. The floater moves to the specified location.



Copying Floaters
You can Copy the selected floater to the Clipboard, then Paste as many copies as you like. You 
can also move to another document and Paste the floater there.
The Floaters Palette is a convenient place to store image floaters until you need them. You can 
put a floater in the library by dragging it from the image window to the palette drawer.



Aligning Floaters
Often, when you work with several floaters, youll want to position them relative to one another. 
Painters Align command makes this easy.
You may align the objects horizontally, vertically, or in both dimensions. And you may align the 
objects to either side, top, bottom, or center. 
Left, Right, Top, Bottom refer to the respective edges of the objects. 
For example: In a Horizontal: Left alignment, the leftmost object stays in place. And all other 
objects are moved to bring their left edges in line with the stationary object.
As you change the settings, the sample objects in the window display that alignment. 
When youve set the alignment you want, click OK. Painter closes the window and moves the 
selected objects to that alignment.



The Composite Method: A Floaters Special Effects
When a floater is above another image--either the canvas or another floater--Painter can use the 
overlapping color information to create special effects.
The effects are variations of the floaters Composite Method. Each floater may have its own 
method. You can change the Composite Method any number of times without actually changing 
the images. This gives you the freedom to experiment without risking an unwanted, permanent 
edit.

Default
In the Default method, the floater covers (hides) the underlying image.

Gel
The Gel method tints the underlying image with the floaters color. For example, a yellow floater 
gives the underlying image a yellow cast.

Colorize
The Colorize method replaces the hue and saturation of the canvas pixels with the hue and 
saturation of the floater pixels.
You can use this feature to convert a color image into grayscale and vice versa. A black floater 
turns the underlying color image into a grayscale image. A colored floater adds color to an 
underlying grayscale image. 

Reverse-Out
In the Reverse-Out method, the floater inverts the colors behind it. Reverse-Out is a great way to 
drop out type. Place a floater over black type and the type turns white.
A colors inverse, also known as its complementary color, is the color on the opposite side of the 
color wheel.
With Reverse-Out, the colors in the floater are not considered--only the area it covers.

Shadow Map
Shadow Map blocks light, letting you create shadows without changing the image.

Magic Combine
Combines the floater with the underlying image based on luminance. The parts of the floater that 
are lighter than the underlying image appear within the bottom image. 
One way to use this command is for filling type. With a photograph as the top floater and black 
type as the underlying image, choosing Magic Combine fills the type with the image.

Pseudocolor
The Pseudocolor method translates the floaters luminance into hue. You can use this method to 
turn a grayscale floater into a spectrum of color.

Normal
The Normal method is Photoshops default mode.

Dissolve
Dissolve results in combining the image color with the floater color, depending on the opacity.

Multiply
Multiply combines colors to create a darker color.



Screen
Screen combines colors to create a lighter color.

Overlay
Overlay combines colors while preserving the highlights and shadows of the image color.

Soft Light
Soft Light darkens or lightens colors depending on the luminance of the floater color.

Hard Light
Hard Light multiplies or screens colors, depending on the luminance of the floater color.

Darken
Darken takes the darker of the image or floater color and uses that color.

Lighten
Lighten takes the lighter of the image or floater color and uses that color.

Difference
Difference subtracts one color from the other, depending on which color has a greater brightness 
value.

Hue
Hue creates a color by combining the luminance and saturation of the image color with the hue of 
the floater color.

Saturation
Saturation creates a color by combining the luminance and hue of the image color with the 
saturation of the floater color.

Color
Color creates a new color by combining the luminance of the image color and the hue and 
saturation of the floater color.

Luminosity
Luminosity creates a new color from the hue and saturation of the image color and the luminance 
of the floater color. This is the opposite of Color.



Image Floaters
Youll use floaters to move image selections around in a document and to move images to other 
documents so you can composite them. In fact, whenever you Copy and Paste image selections, 
they come in as a floaters. This is handy because you can easily drag the floaters where you 
want them.
You can use floaters for manipulating masks. For example, you can use a floater to modify a 
canvas mask or to move the mask from one document to another. 
You can also use floaters to create Image Hose Nozzle files. See Image Hose, for more 
information. 

Working with Image Floaters
Because each floater represents a separate image (above the canvas), youll need to let Painter 
know which image you intend to work in. As you work, youll switch layers--first working on the 
canvas, then in one floater, then in another, then on the canvas again. 
When you want to work with a particular floater, you must select it. 
To select a floater, click on it with the Floater Adjuster Tool. The selection marquee (the marching 
ants) outlines the floater. You may also click the floaters name on the F. List Palette to select it.
You can hold down the Shift key and click on another floater to add it to the selection. You can 
move a multi-floater selection, but you cannot paint across them. 
To deselect a floater, choose Edit menu> Deselect (x-D). On the F. List Palette, you can deselect 
a floater by clicking in the empty space below the names in the list. 



Trimming a Floater
When Painter creates a floater, it captures a larger, rectangular region, then masks it down to the 
shape of the selection. The larger rectangle gives you room to work and allows you to feather the 
image beyond the original selection.
The margin between the selection and the rectangle is a default setting called the Floater pre-
feather. You can change it in Edit menu> Preferences> General.
Trimming reduces the floaters dimensions to the minimum rectangle that will contain the masked 
image. Trimming floaters is good housekeeping, but dont do it until youre satisfied with the 
feathering and finished adding a drop shadow. Your options for modifying the floater image and 
mask are reduced after trimming.
To trim a floater, select a floater, then click Trim.



Expanding a Floater
Expand does the opposite of Trim. It enlarges the selected floaters rectangle. Expanding adds 
blank image area, so it wont help if you want to increase the feathering beyond the pre-set 
distance.
To expand a floater, select the floater, then click Expand. Painter displays a dialog that lets you 
specify the number of pixels and direction to expand the floater.

Using the Controls Palette: Adjuster Tools
The Controls Palette: Adjuster Tools is displayed when youre using the Floater Adjuster Tool. The 
palette describes the selected floaters rectangle and provides several editing options. 

Opacity
Drag the Opacity slider to change the selected floaters visibility. Decreasing Opacity allows 
underlying images to show through.



Feathering Floaters
Feathering controls the softness at the edge of the floating image. Feathering works by blurring 
the border of the mask.
Floaters created from shapes cannot be feathered.
To feather the edges of a selected floater, move the Feather slider in the Controls Palette: 
Adjuster Tools.
The selection marquee appears in the center of the feathering. If feathering is set to 16 pixels, the 
marching ants have 8 pixels of feathering on either side of the selection.
How much you can feather a floater is determined in the General Preferences dialog box. Choose 
Edit menu> Preferences> General. Notice that the Floater Pre-Feather is preset to 16 pixels, 
making this the default setting of the Feather slider. You can change this default to any number up 
to 50. The change takes effect the next time you start Painter.



Adding a Drop Shadow
Often, youll want to add a shadow to a floater. Shadows can improve the appearance of text and 
are often used when developing floaters for an Image Hose Nozzle. You can add a drop shadow 
to a single floater or to a floater group.
The X and Y offset describe the distance the shadow shape is offset from the center of the floater 
image.
Opacity sets the darkness of the shadow. Increasing Opacity darkens the shadow.
The blurring of the shadow edge is controlled with the Radius, Angle, and Thinness settings. 
These controls apply Motion Blur to the shadow shape, thereby softening its edges.
Radius sets the amount of blur. The radius is half the distance across the blurred region. If you 
set Radius to zero, youll get a sharp edge on the shadow.
Angle sets the direction that the shadow is blurred. 
Thinness applies blur perpendicular to the Angle. If the blurring shows streaks, you can increase 
Thinness to soften them.



Collapse to One Layer Option
Drop Shadows are normally created as a separate floater, grouped with the original. This enables 
you to select the drop shadow floater and modify it independently. 
If you want the shadow and the original united in a single floater, enable the Collapse to One 
Layer option at the bottom of the Drop Shadow dialog. If you are preparing floaters for a Nozzle, 
this saves you from collapsing each group manually. 



Editing Floater Images
Nearly all of Painters brushes and effects work with floaters. You can paint in a floater, change its 
opacity, feather its edges, and enhance its image with commands from the Effects menu. 
You can also edit the floater by modifying its mask. By changing the mask, youll reveal or conceal 
parts of the floater. You may paint on a floater with a masking brush or use any of the advanced 
masking features, like the Auto Mask.



Painting in a Floater
To paint in a floater, select a floater and start painting. Your brush strokes appear only in the 
floater.
You may use any of Painters brushes to paint or draw in a floater, with the exception of the Water 
Color brushes--a floater doesnt have a wet layer.
You can move a floater to a temporary document, drop it with its mask, and use the Water Color 
brushes there. Because you dropped the floater with its mask, you can easily re-float the modified 
image to bring it back.
You cannot paint across a floater group. If this is something you want to do, you need to Collapse 
the group.
The drawing mode (in terms of the floater mask) is controlled by the drawing mode icons on the 
bottom of the image window. You can paint across the entire floater rectangle, or within the mask 
area. 
To paint on the canvas, deselect all floaters before you start painting. When no floaters are 
selected, your brush strokes go to the canvas.
This can be interesting if a floater covers the area where youre painting. In this case, you might 
not see the brush strokes. Youll need to deal with the floater by moving, hiding, or dropping it to 
see what youre painting.



Floaters Mask
The floater mask is created when you float a selection. The mask defines the area of the color 
layer that is visible. 
These tools toggle mask display, so you can go back to image display by choosing the command 
again.



Floater Masking Modes
A floater mask will be in one of three modes: Disabled, Masked Inside, or Masked Outside. By 
changing the mode, you change how the floater appears.

Masking Disabled
With Masking Disabled, Painter ignores the mask and displays the entire floater rectangle.

Masked Inside
Masked Inside inverts the mask--masked regions of the floater rectangle are rendered invisible. 
Regions outside the mask are visible.

Masked Outside
Masked Outside uses the mask to reveal only the shape of the floating image. The unmasked 
regions are invisible. This is the default mode for a floaters.

How the canvas mask interacts with a floater
You can use the canvas mask to conceal or reveal parts of a floater. 
The floater/canvas mask interaction will be in one of three modes: Disabled, Masked Inside, or 
Masked Outside. By changing the mode, you can immediately alter the composition.
The attribute for interacting with the canvas mask is contained in the floater, so each floater may 
use a different interaction mode.

Masking Disabled 
The floater isnt affected by the canvas mask. This is the default mode for a floater.

Masked Inside 
The canvas mask reveals the floater. Only regions of the floater that coincide with masked canvas 
regions are visible.
When Masked Inside is selected, painting with white in the canvas mask reveals more of the 
floater. Painting with black conceals more of the floater, while revealing the canvas. 

Masked Outside 
The canvas mask conceals the floater. Only regions of the floater that coincide with un-masked 
canvas regions are visible.
When Masked Outside is selected, painting with black in the canvas mask reveals more of the 
floater. Painting with white conceals more of the floater, while revealing the canvas.
The three floater masking modes combine with the three canvas interaction modes to produce 
nine options for compositing a floater. If you set up the floater and canvas masks properly, any 
composition is possible.



Editing a Floaters Mask
By modifying a floaters mask, you can change how much of the image is visible. The most useful 
way to modify a floater mask is with a masking brush. By painting with a masking brush in a 
floater, you change the extent of its mask, revealing or concealing more of the floater image layer. 
When you conceal more of the floater, you reveal more of the canvas. 
All of the masking brushes and commands--except Magic Wand--are available for modifying a 
floater mask. 
For more information on modifying a floater mask, see Editing Masks in Selections and Masks.



Restoring a Floater Mask
If you modify a floaters mask, but then decide that you dont like the changes; you can return the 
floater to its original condition.
To restore the floater mask, click the Restore button on the bottom of the F. List Palette

Drop with Mask
The Drop with Mask option at the bottom of the F. List Palette lets you decide what to do with the 
mask of a floater you drop. When this option is disabled, only the floater image merges with the 
image on the canvas. 
When Drop with Mask is enabled, the floater images merge with the canvas image and the 
floaters mask merges with the canvas mask. 
There are a number of ways Drop with Mask can be useful. For example, if the canvas mask is 
clear (x-U), the dropped floaters mask becomes the canvas mask. (Use the Masked Outside 
interaction button to prevent the floater image from merging with the canvas image). You can use 
this technique to move a mask from one document to another.

The Floaters Palette
The Floaters Palette is a convenient place to store floaters youll want to use again.
To display the Floaters Palette: Choose Objects Palette: F. List menu> Floaters.
To add a floater to the palette, drag the floater from the image window into the Floaters Palette. 
As the floater enters the palette, youll see the selection marquee shrink to icon size.
When you drop the floater in the palette, Painter will give you an opportunity to rename it. If you 
havent already given the floater a descriptive name, do so now.
To use a floater from the palette, simply drag its icon into the image window.
You can create your own custom libraries to organize floaters by category. When youre creating a 
library, keep in mind that the smaller the library, the easier it will be to see its contents at a glance.



Creating a Reference Floater
There are two ways to get a reference floater into a document:
Convert an image floater to a reference floater.
Place an image

To convert an image floater to a reference floater:
1 Select a floater.
2 Choose Effects menu> Orientation> Free Transform.
In the Floater List, the icon beside a reference floater shows the eight handles.

To 
To place an image file as a reference floater:
If the image you want exists as a separate file, you can use the Place command to bring it into the 
document. You must have a document open to use Place.
Important: While working with a placed image, do not delete, move, or rename the reference 
original. Painter must be able to refer to the image data in that file. 
1 Choose File menu> Place. Painter displays a directory window that lets you choose an image 
file.
2 Select an image file and click Open. Painter displays the Place options dialog.
When you move the cursor into the image window, a rectangle shows how large the floater will 
be. This lets you see the scale of the floater in relation to the current document.
When youve set the options, you can finish placing the image:
To place the floater in a particular location, click in the document where you want the image 
centered.
To Place the floater in the center of the document, click OK. 



Horizontal and Vertical Scale 

Vertical Scale
When you place a file, Painter suggests a scale for the image that will fit in the current document. 
If you want to change the size, enter a different scaling percentage in the Horizontal Scale and 
Vertical Scale fields 

Constrain Aspect Ratio
When this option is enabled, Painter maintains the proportions of the image. You can disable this 
option if you want to distort the image.

Retain Mask
The image you place may carry a mask. If you want to keep the mask, leave this option enabled. 
When the image is placed, the image mask becomes the floater mask. If you disable this option, 
Painter discards the mask.

Create Pyramid
Enable this option if you want to create a pyramid data structure. Pyramid structures are files that 
contain multi-resolution information. When you create a Pyramid file, the file contains several 
versions of the image at different resolutions. When you place the Pyramid, it will place the 
appropriate size for the current open file.

Pyramid files work in conjunction with scripting. You can work at a low resolution and then play 
the script back at a higher resolution. Painter will play back the Pyramid at the appropriate 
resolution for the current open file.



Transforming a Reference Floater
A selected reference floater has eight handles on its selection rectangle--one on each corner and 
one on each side. Youll drag these handles to transform the floater.

To select a Reference floater, click on it with the Floater Adjuster Tool or click on its name in the 
Floater List.

Free Transformations
You may resize, rotate, and slant a reference floater by dragging its handles.

Choose the Floater Adjuster Tool and select the reference floater you want to manipulate.

Resizing
Drag a corner handle in the direction you want to resize. 

To maintain proportions, hold down the Shift key as you drag.

To resize in one dimension only, drag a side handle.

Rotate
Hold down the x key and drag a corner handle. 

Slant (Skew)
Hold down the x key and drag a side handle.

Notice the cursor change as you position the floater over a handle.

Set Transform
After creating a reference floater, the Set Transform dialog allows you to perform numerical 
transformations. Set Transform is useful for returning the floater to its original condition. 



Converting a Reference Floater to an Image Floater
When you are finished with transformations, you can convert the reference floater back to an 
image. 

If you try to apply an effect or paint on a reference floater, Painter automatically converts it to an 
image floater. 

During the conversion, Painter examines the reference original and brings the best pixel data 
possible to the transformed floater. For this reason, youll see the image quality improve.

Notice that the floaters icon in the Floater List changes.



Floaters as Image Maps for the Internets WWW

The image map is a WWW feature that allows a client to hyperlink to different locations by clicking 
on specific areas within an image. In Painter, you can specify a floater as a clickable region.

For more information about Web authoring and Painter, see ®Painter for Web Authoring® in the 
Tutorial manual.



Printing
You can print Painter images on many kinds of printers including PostScript and GDI printers and 
high-resolution imagesetters. 

Although your final goal may be to print high-quality color prints, it is a good idea to first print 
proofs on any printer you have available. 

You can use a black and white printer to check page size and placement of images on the page. 
If you have a color printer, you can print proofs to get a general impression of what your image 
looks like. Keep in mind that the proof will not be an accurate representation of a final product 
produced by an offset printing process. The print process, inks, and paper types all affect the final 
output.

Color Matching
In an ideal world, each color on your monitor would match the respective color on the printed 
page. Due to the number and kinds of things that effect the color at each point in the process 
(from a monitor adjustment to the competence of the person who mixes inks, to the porosity of the 
paper) a perfect match of all the colors used is unlikely. Nevertheless, it is important to adjust 
those elements that you can control. 

For starters, you can tell Painter to display only colors that are printable. 

See Also:
Using Printable Colors
Printing Shapes
Page Setup Dialog Box
Print Dialog Box
ColorStudio Printer Settings 



Using Printable Colors
Your monitor can display more colors than can be printed on a offset press. To display only colors 
that are printable, click the Printable Colors Only checkbox on the Art Materials> Colors Palette. 
Once this option is selected, colors will be restricted to showing only printable colors.

To display your entire image as printable colors, choose Effects menu> Tonal Control> Printable 
Colors. Then click OK in the Enforce Printables dialog box.

Color Calibration
Color calibrators are hardware devices that use software to balance the color and gamma 
(brightness and contrast) of your monitor. You can purchase a calibrator.

Calibration software can be used to adjust your monitor to reflect what your printed piece would 
look like. This is done with printer profiles that are either packaged with a software program or 
that you can create with the program. Cachet (produced by Electronics for Imaging) is an 
example of such a product. Some image-editing software packages, such as ColorStudio have 
these capabilities built in. 

Trial and error
In the final analysis, calibration is a matter of trial and error. If you have no calibration software, 
but you do have access to the output device, you can print your file, hold it up next to your 
monitor and see how closely the match may be. Use the brightness and contrast controls on your 
monitor to make adjustments. If you have software that can adjust the RGB values of your 
monitor, use them to get an even closer match. 



Printing Shapes
Shapes can be interleaved with floaters in the F. List, which can affect the way your document will 
print.

Shapes are inherently resolution-independent--they're mathematical representations of curves, 
not actual pixels. When you print, normally these are turned into PostScript paths and printed at 
the full printer resolution, although there are some exceptions. 

Some effects that are possible with Painter Shapes are not actually printable with PostScript 
Level I or II, so they must be rasterized into your canvas before printing. These include primarily 
transparency and compositing methods. 

It is important to note that any object in a lower position on the F. List that is touched by a 
rasterized shape causes that to be rasterized, as well. That is, if you have a Shape with 
transparency on top of a number of other shapes, all those shapes below must be rasterized as 
well as the top shape to preserve the transparency all the way down to the canvas, even if the 
overlap area is small.

Similarly, if you place a raster shape partially over a Shape, the Shape must be rasterized in order 
to print correctly. 

To ensure that Shapes will print at the full resolution of your printer, make sure they do not overlap 
with raster floaters, and that you do not make them transparent or set their compositing methods.



Page Setup Dialog Box
Options in the Page Setup dialog box can vary depending on several factors--the output device, 
color versus black and white printing, and whether or not you are printing separations.

Choose File menu > Page Setup to display the Page Setup dialog box.

Miscellaneous printing options 
These options are available in all printing situations.

Size to Fit Page
Choose this option if you want Painter to shrink an image that is larger than a selected page size. 
For example, when this option is checked, a 12 x 12 image would be resized to fit on an 8 1/2 x 
11 page. Painter resizes the image to fit the page. 

If an image is larger than the page size and you havent checked Size to Fit Page, when you print, 
you see an alert message. Click Continue, and the image will be clipped to fit the page. Click 
Cancel to stop printing. You can open the Page Setup dialog box and Size to Fit Page. 

Printer/Press Dot Gain
Your print shop should be able to tell you what the dot gain will be for a specific job. Dot Gain is 
the amount any halftone dot grows when it is printed. Depending on the type of printing press, 
paper, and ink you use, halftone dots may grow, causing an image to become darker than you 
wish.

To account for this dot gain, Painter allows you to enter a percentage of dot gain that will adjust 
halftone dots so they print at the size you intended. For example, if a 50% dot on film grows to 
70% after it is printed, the dot gain is 20%. If the dot gain setting is too high, the printed results 
will be too light. If the dot gain percentage is too low, the printed results will be too dark. Typically, 
web offset presses have dot gains of around 25% and sheetfed presses have dot gains of 5% to 
10%. 

Monitor Gamma 
The gamma, or brightness, of your monitor and the printing gamma must be the same if what you 
print will look like what you see on your monitor.

If you havent used a third-party optical hardware calibration device to change your monitors 
gamma, youre pretty safe leaving the Monitor Gamma at the 1.8 default setting. If you do use one 
of these calibration devices, we recommend that you set it to 1.8. If, however, youve set your 
monitor to another gamma, change the Monitor Gamma in PostScript Setup to the same number. 

Halftone Screens Settings for PostScript Printers 
When you select a PostScript printer in the Chooser, several other factors are available in the 
Page Setup dialog box--Screen Frequency, Angle, and Spot Type. These options are related to 
creating halftones.

A halftone is an image composed of a series of dots of various sizes. In grayscale printing 
(newspapers), the varying dot sizes suggest different shades of gray to the eye. In process color 
printing (cyan, magenta, yellow, and black), varying dot sizes and screen angles give the illusion 
of millions of colors. Keep in mind that a halftone dot is composed of pixels. The dots are 
arranged on an imaginary grid, the halftone screen. 

Screen Frequency 
Screen frequency represents the fineness of the halftone screen, which is made up of rows of 
dots. The spacing between halftone dots is referred to as lines per inch or lpi. The paper porosity 
and the type of press determines what the halftone frequency will be. Newspapers, for example, 
are very porous and usually print at 85 lpi. A high-quality magazine on slick paper will print at 150 
lpi.



If you are printing a separation, Painter lets you set the screen frequency for the four process 
colors: cyan, magenta, yellow, and black. 

Be sure to consult with your service bureau for specific recommendations for particular 
recommendations on screen frequency. 

Angle
This is the angle at which your halftone screen rests on your image. When printing separations, 
these angles can be set for each of the process colors. 

Spot Type
The Spot Type pop-up menu gives you options for the shape of the dots that make up your 
halftone screen grid. 

Options for Files Saved as EPS
Painter files that have been saved as EPS files conform to the Desktop Color Separation format 
(EPS-DCS 5-file format). Remember, when you save a file as EPS-DCS, Painter uses the Printer 
Settings file in your Painter folder to make the separation files. If you want to use the screen 
angles and frequency specified in the Page Setup dialog box, check the box next to Use Page 
Setup settings in the EPS Save As Options dialog box. For more information about this dialog 
box, see Saving in EPS.



Print Dialog Box
 Once you have chosen options in the Page Setup Dialog Box, you are ready to print.

Check GDI Printing if your printer uses Windows GDI interface. (A common color GDI printer is 
the Hewlett-Packard DeskJet.) You cannot print separations to GDI printers. The Page Setup 
options of Printer/Press Dot Gain, Spot Type, and screen frequencies have no effect on printer 
output.

Check Color PostScript if you plan to print to a color PostScript device. (The QMS ColorScript and 
Tektronix color thermal printer are examples of PostScript printers.) PostScript printers take 
advantage of the Printer/Press Dot Gain, Spot Type, Screen Frequency, and Angle options in the 
Page Setup dialog. 

Check Separations to print separations. The output consists of four pages, one each for cyan, 
magenta, yellow, and black. You can print separations from Painter with any PostScript device, 
including high-resolution imagesetters. Good separations depend on the right screen frequency 
and angle. Printer/Press Dot Gain and Spot Type are also crucial for producing quality color 
separations. Check with your imagesetting service bureau about the kind of setup that is 
necessary for the kind of equipment you are outputting files to. 

Painter places a color bar, registration marks, and color name on each of the four separated 
plates. If you wish to print negatives of your separation, check the Negative box in the Windows 
Printing Options dialog box. If you are using a service bureau to print your separations, check with 
them on the proper setup for their equipment. 

Check the Black and White box if you are printing on a black-and-white PostScript laser printer. 



ColorStudio Printer Settings
 Painter includes a Printer Settings file that contains color calibration information for obtaining a 
quality color separation on a high-resolution imagesetting device.

The Printer Settings Dot Gain is set to 16%, Screen Frequency for all four process colors is 133 
lpi, and Angle is set to 15 degrees for cyan, 75 degrees    for magenta, 0 degrees    for yellow, and 
45 degrees    for black.

Painters Printer Settings file was made in ColorStudio, using ColorStudios color calibration 
software. If you have ColorStudio, you can use your own ColorStudio printer settings with Painter.

The Standard file within the main Printer Settings file is now the default settings file for Painter.



Net Painter
The Net Painter feature supports real-time collaboration across a network. Net Painter allows you 
to share a document with other Painter users on a TCP/IP network. As you paint and make 
changes, your strokes and effects appear in the image window on your partners screen. 

When youre done painting, you can turn over the controls so other members can pick up where 
you left off. Other members work will appear in the document on your desktop. Take turns working 
until the project is finished. 

You may use Net Painter across a local area network or across the Internet to connect with 
anyone running Painter 4.0, or later. It doesnt matter if the members of your collaboration are 
across the hall or across the country. 

You may even have several users in a session. One person paints while the others watch. A 
famous artist might demonstrate his technique while a dozen students watch. Anyone connected 
can communicate with the rest of the group by typing in the chat window.

Net Painter sends instructions--not pixels--over the network. The one copy of Painter tells the 
other copies what tools, colors, and effects to choose and how to apply them. 

Some operations take advantage of local resources, like custom paper textures, patterns, brush 
variants, Brush Looks, Nozzles, plug-in filters, or objects, like floaters and paths. Such resources 
must be shared before you can use them effectively on the network project.

Window operations are not conveyed across the network. This means that zooming and panning 
are not duplicated on the partners system. 

See Also:
Net Painter Technical Requirements
Crossing a Firewall
Joining a Net Painter Collaboration
Sending and Receiving Files Using    Net Painter
Net Painter Chat Window
Traffic Control in a Net Painter Session



Net Painter Technical Requirements
Net Painter uses the TCP/IP communications protocol. All computers connecting for a Net Painter 
session must be networked according to TCP/IP. If your computer is TCP/IP-capable, youre ready 
for Net Painter.

If you can use Netscape to browse the WWW, youre computer is TCP/IP-capable.

The methods of TCP/IP setup differ between operating systems. If your computer is not yet ready 
for TCP/IP communication, contact your network administrator for assistance.

If networking by modem, a 28.8K bps modem (V.34) is recommended for optimum results. A 
14.4K bps modem will be adequate if you intend to collaborate using only Painters default 
libraries and not transfer any files. 14.4K bps is very slow if you intend to transfer images and 
library files to other members.

File transfer from within Painter can be slow on a local area network as well. It would be more 
efficient for local members to manually copy any large files from the network into each of their 
Network Folders. Once the file is copied the collaboration lead can open the file on their machine 
and it will appear on the other members machines automatically.

Net Painter    works on Macintosh, Power Macintosh and Windows 95 systems. Net Painter does 
not work on machines operating under Windows 3.1 or earlier systems.



Crossing a Firewall

Some companies isolate their local area network from the Internet using a firewall. The firewall 
acts as a filter, allowing some types of information transfer, while preventing others. 

Net Painter uses its own protocol based on User Datagram Protocol (UDP). Some firewalls may 
obstruct the transfer of Net Painter information. If you are working from within such a firewall, you 
may be unable to use Net Painter beyond the local area network. You should try it and see if the 
firewall causes any problems.

Contact your network administrator if you think a firewall might be interfering with your Net Painter 
connection. The firewall software can be reprogrammed to recognize the Net Painter UDP and 
allow it passage. The latest information on the Net Painter UDP and firewalls, including sample 
code, can be found in Support Services at the fractal.com WWW site.



Joining a Net Painter Collaboration
Make sure of the following:

Both you and the members of your collaboration are on the network. 

All members are running Painter 4.0, or later. 

All members have set up Net Painter to use the same port number.

All members are idle until everyone is connected. This means no files can be open, no 
one can be painting. If you have a file open and you try to join a group you will get an 
error message explaining you cant join because you have an open file.

Multiple users may join the project by connecting to any current members machine. The 
procedure for additional users connecting is identical. All users must connect from the outside. 
Someone who is outside the group can join to anyone within the group. Someone who is in the 
group cannot connect to another machine. A Net Painter group may not join another group.

When all members are joined to the group and the first person begins painting, the group 
becomes locked. No one can join once the collaboration commences. If you try and join into a 
group once the painting starts you will get an error message explaining that you cant join because 
the group is currently collaborating.



Sending and Receiving Files Using    Net Painter

Sending    Files Using Net Painter
The current artist may send files to the connected group. There are two reasons for doing this: 

To provide everyone with needed resources, like Nozzle files and brush, floater, paper, or pattern 
libraries.

Some operations take advantage of local resources, like custom paper textures, patterns, 
brush variants, Brush Looks, Nozzles, plug-in filters, or objects, like floaters and paths. 
Custom resources may be unique to a machine and using them will disrupt the project.

For example, if you paint with a customized variant called Twisty Brush, the chances are 
other members wont have that tool available. Painter will display a message informing 
those connected of the situation. Each users Painter will choose a different variant and 
proceed with the project. 

Before starting a project, you should share resources you anticipate using. The best way 
to do this is to create special libraries of custom resources, then send the library files.

To share the project file.
When the collaboration is going to begin with an existing file, every member in the group 
must have a copy of that file in their Network Folder. First remain idle until all members 
have joined. Second, initiate painting either by clicking on the green light or using the pull 
down menu. Third, if you are the first person to go green then you can send the file. The 
file will be sent to all members of the collaboration. When you open the file on your own 
machine, Painter will automatically look into the Network Folders and open the file on the 
other members machines.

Receiving Files Using Net Painter
Files sent through the Send File on Net command are automatically saved to the Network Folder. 
If you are expecting a file, look for it here.

Keep only files used in collaboration in your Network folder. If someone sends you a file by the 
same name as an existing file in your Network Folder, the existing file will be deleted without 
warning.

You want to leave library files you receive in the Network Folder. When the current artist uses a 
resource not available in your current library, Painter will search the library files in the network 
folder. When Painter finds the resource, it proceeds with the project.



Traffic Control in a Net Painter Session
Only one person may paint at a time. The controls for negotiating permission are in the traffic 
light.

If you want to paint, click the green light. You may also choose Network menu> Start 
Painting.

If someone else is working now, the traffic light will turn yellow. Yellow means youre waiting to 
paint. When they finish and its your turn, the light turns green. Go ahead and paint. 

When youre finished painting, click the red light. You may also choose Network menu> 
Stop Painting. This turns over permission to the next user in line.

The traffic status of each user connected appears in the top panel of the Network Palette. 

The artist who is now painting has the green light. This is the current artist.
Artists who are waiting to paint have a yellow light. Someone who is waiting to paint has 
asked to paint--either by clicking the green traffic signal or by choosing Network menu> 
Start Painting. 

People who are waiting to paint are queued. They will receive permission in round-robin order as 
shown in the list on the Network Palette.

A user who is just watching has a red light



Net Painter Chat Window
The chat feature lets you type messages to other users in the session. For example, you might 
suggest an effect, ask for an opportunity to paint, or say Thats Cool! 

Chat is always active--even when you dont have the green light. You can type messages, and 
youll see the messages from others regardless of your traffic status.

Chat messages appear in the lower panel. Messages you enter appear in black. Messages from 
other artists appear in color. Chat messages do not update while the computer is computing.

Example of typical chat:
Mike> My turn
Leo> in a minute
Rem> Make it darker
Leo> I want to air brush the clouds
Mike> WAIT. Let me mask my angels!
Leo> Okay

At which point, Leonardo clicks the red light to stop painting. Michelangelos traffic light turns from 
yellow to green, and he goes on to mask his precious angels.



Scripts
Scripts allow you to record what you do in Painter. Painter transparently records every action you 
take into an always script. You can also record a deliberate set of actions you take into a specific 
script. Scripts are like video tape in a sense. You can record them and play them back at will from 
the Objects: Scripts palette. But, theres more! You can now edit the script step-by-step using the 
new Objects:
S. List Palette. This gives you more control over recorded action sequences than ever before.

When you playback a script, sit back and watch Painter do the work. You may record anything in 
a script--from a single edit command to an entire work session. 

There are a number of ways to take advantage of scripting:

Scripts offers the ultimate in Undo. If you record your work, you can revert to any stage in 
the project by playing the script and stopping it at the stage you want.

You can use scripts to create macros. If you have a repetitive task, or an operation you 
use frequently, you can record that series of commands. Whenever you want Painter to 
perform the task, play the script. Let the script do the work for you.

You can playback a script at a different resolution. This enables you to record at a low 
resolution, then automatically produce the same results at a higher resolution.

You can record a script that will play back using the current art materials. For example, 
you could record a script for a complete pencil drawing. Then you decide youd like to see 
the same drawing in chalk with a different paper texture. Open a new document and 
choose your art materials. Now, play back the script. Watch Painter repeat your drawing 
with chalk.

To make a script where you can change art materials on playback, you must disable the 
Record Initial State option on the Script Options dialog before you record the script.

Scripts are a great educational tool. Playing the script of an art project lets you see the 
step-by-step process in which the image was created. The art appears, develops, and 
matures almost by magic. Its as if you are looking over the artists shoulder.

Scripts are particularly useful for working with movies. When you have an operation you 
want applied to each frame in a movie, record the set of commands in a script. You can 
then apply the script to the entire movie at one command.

When you play a script, you can output it to a movie. Every action you take becomes a 
frame in the movie. This is a great way to create special effects for your Video for 
Windows movies.

How Scripts Work
The Script Recorder saves each instruction you give Painter, including what values, locations, 
colors, and textures are used. By repeating the instructions, Painter can reproduce the artwork 
"from scratch".

Because Painter saves instructions, scripts are efficient and flexible. For example, you can play a 
script one instruction at a time. You can also edit scripts, taking a few instructions from one script 
and inserting them in another one.



Applying Scripts to Movies
Painter lets you apply a script to a movie. This feature is particularly useful when you have a 
script that functions as a macro. 

For example, you might want to apply an effect like Glass Distortion to a video clip. You can 
record a script that applies the Glass Distortion effect to a single image. Then choose Movie 
menu> Apply Script to Movie, and select the Glass Distortion script. With this one command, 
Painter will apply the script to each frame of the movie. 

See Also:
Scripts Palette
S. List Palette



Scripts Palette
The Objects: Scripts Palette provides the basic tools for recording, playing, and storing scripts.

To open the Objects: Scripts Palette, click the Scripts icon on the Objects Palette. 

Five buttons on the bottom of the palette make it easy to stop, play, record, pause, and step 
forward when youre working with scripts.

Replaying a Script at a New Resolution
Replaying a script at a higher resolution is a good way to create a high resolution image. When 
you create, you get the smooth, responsive performance of working at low-resolution. When you 
play back the script at a higher resolution, you get the benefit of a higher quality image. 

Converting a Scripted Session into a Movie
You can replay a script into a Painter movie and, if you like, save it as a Video for Windows 
movie. Every action you take becomes a frame in the movie. This is a great way to create special 
effects for your Video for Windows movies.

For more information about frame stacks, onion skin, and movies, see    Digital Video and 
Animation.

Script Libraries
Setting up script libraries helps you organize your sessions--for example, by client, project, or 
function. As with all Painter libraries, its best to keep script libraries small so that you can easily 
locate the script you want.



S. List Palette
The S. List Palette offers tighter control in developing and playing scripts. The palette lets you 
view the instructions that comprise a script. You can then select and play individual instructions, 
or cut and paste them to edit the script.

To display the S. List Palette, click the S. List icon on the Objects Palette. 

You may record a script using the tools in the window. 

The window will be empty until you load a script. 

New scripts are saved to the current library. You can move a script to a different library using the 
Script Mover. 

If you record a script into a file of the same dimensions but with a higher resolution (set in the 
New Picture dialog box), there will be no noticeable difference in the resulting image--except that 
the image will print at an appropriately smaller scale. In order to increase the size of the artwork, 
the dimensions of the playback file must be greater than the original scripts reference rectangle.

Remember, a script can only be played back at a new resolution if a reference rectangle was 
recorded at the outset.

Painter always records every action you take in the always script. This script appears as (Current 
Script) in the Open Script dialog. If you open this script, you can copy elements from it, but you 
will not be able to cut, paste, clear or edit elements. This allows you to copy elements from the 
current script and paste them into a new script. In this way, you can easily encapsulate recently-
taken steps into a script. 
Because Painter always saves your script data, this data can build up in your Painter Script Data 
file. You can control the number of days these scripts persist in the file by entering a number of 
days into the Auto Save box in the General Preferences dialog.

You can edit the script in the S. List. Change the variant, or another element and play the script 
back.



Mosaics
The Make Mosaic feature and its companion, Make Tesselation, help you create tile mosaics and 
stained-glass window formations. 

The Mosaic feature lets users design imagery in the style of historic tile mosaics. You can start 
with a blank canvas or work from a cloned photograph, and simply paint with mosaic tiles. Each 
tile is an independent object that knows about every other tile, and carves its shape so that it fits 
perfectly with existing tiles. Tiles can be erased and/or reshaped to create the perfect mosaic 
design.

The Make Tesselation tool creates tile inlay patterns for use in mosaics.

The mosaics can utilize cloning features, so you can easily translate an existing image to the 
mosaic medium. 

After creating a mosaic, you can give them a three-dimensional appearance. This can produce 
some wonderful results. You may also apply brush strokes to the mosaic. A brush like Distorto will 
smear the tile colors.

See the Render Tiles to Mask command for instructions on adding dimension to the tiles. 

The mosaic feature differs from the other Natural-Media tools slightly. While working in the 
mosaics medium, you must have the Make Mosaics dialog open, and you may not access any 
other tools or features--except the Art Materials: Color Palette. 

When you bring up the Make Mosaics window, you are working in a different mode. In this mode, 
you can only create, erase, reshape and recolor mosaic tiles. There are two aspects to the way 
that mosaics are created and displayed. Each mosaic tile is stored as a resolution-independent 
object within Painters image database. This means that if you resize an image composed of 
mosaic tiles, your image can be displayed in the same quality as if it was originally created at 
higher resolution.

The image that you see displayed is the set of all mosaic tiles rendered as an image onto the 
canvas. RIFF file mosaics can be re-rendered at any time. Once you exit the Make Mosaics 
window, you can treat this rendered image just like any photograph or painting. You can paint on 
it; run effects on it; float portions of it; increase canvas size, etc. However, once you cause the 
mosaic tiles to be re-rendered (by choosing Re-render Mosaic, for example), Painter will erase 
any imagery that is not tiles or grout.

The first thing Make Mosaic does is cover the entire canvas with grout. This obliterates images 
that may be on the canvas. Objects that hover above the canvas, floaters and shapes, will not be 
obliterated but will cover up the mosaic you are working on. For these reasons, Mosaic and 
Tesselation are generally reserved for working in a separate document. 

See Also:
Compositing a Mosaic
Fitting Tiles Together
Tile Settings
Mosaic Commands
Tesselation Mosaic



Compositing a Mosaic
The Mosaic feature works with the entire canvas. You cannot create mosaics inside a floater. 

If you want to composite a mosaic with some other image, you have several options:

Create the mosaic in its own document. When youre satisfied with the result, float and 
copy the mosaic to the document where you want to composite it. 

Float the non-mosaic portion of the image. Create the mosaic on the canvas. When you 
are satisfied with the mosaic, you can drop the floaters.

If a mosaic already exists in the document, Painter does not apply new grout when you 
open the Make Mosaic window (Painter assumes you want to keep existing tiles). You 
can use this feature to create a mosaic on top of another image. Create a mosaic, then 
close the Make Mosaic dialog. Fill, paint, and drop floaters to create your background. 
When you return to Make Mosaic, your background image remains and you can tile over 
the top of it. Removing tiles placed on an image reveals the grout, not the image.

The only file format that will save the resolution-independent mosaic tile objects is RIFF. 
Saving in any other format prohibits you from resuming the mosaic process. All file 
formats will, of course, save the rendered image of the mosaic tiles on the canvas.

If you save a mosaic in the RIFF format, you can open the file at a later date, choose 
Canvas menu> Make Mosaic and continue working. The tiles are still there. You may 
change their color, remove a few, and apply new ones.



Fitting Tiles Together

When working with real ceramic tiles, it is physically impossible to merge tiles. You can put them 
really close to each other, but you cant make them occupy the same space. Likewise, Painters 
mosaic tiles respect each others space. Tiles dont overlap or merge. Painter adjusts the shape of 
the tiles to fit them together while maintaining the grout lines

Because of this quality, when you want to re-lay the tiles in an area, you must first remove the 
existing tiles.

To remove all the tiles in a mosaic, use Reset Mosaic from the commands pop-up. This command 
clears all the tiles so you can start over.

If you only want to remove tiles selectively, use the Remove Tile Tool. 

Tile Color
Tile color is determined by the selected primary color on the Art Materials: Color Palette. 

You might want to add some color variability to build visual interest. In this case, each tile is given 
a slightly different color at random.

To use multi-colored tiles: Adjust the settings for Color Variability on the Art Materials: Color 
Palette. Try setting hue variability to 10%, with the others at zero. This creates a variety of tile 
colors within a reasonable range.

When working in a clone document, you can color the tiles based on the clone source. To do this, 
enable the Use Clone Color option on the Art Materials: Color Palette. You must expand the 
palette using the grow box in the upper right corner. Remember to set up your clone source and 
destination file before choosing Make Mosaic in the destination file.

Normally, each tile is given a single color. If you want more options for coloring tiles, render the 
tiles to the mask. You can then use the mask to paint on the tiles or convert the mask to a 
selection to fill with a pattern, weave, gradation, or image.

Grout Color
Anywhere that tiles are not placed is considered grout. Therefore, the mosaic background is given 
the grout color when you begin working.

To change the grout color, click the Grout Color square. Use the Color Picker to select a grout 
color. You can change the grout color at any time. However, changing the grout color will re-
render the mosaic automatically.



Tile Settings
Tile shapes have two categories of control: Dimensions and Randomness. Use the Settings pop-
up menu to choose which category you want to change.

Dimensions
The Dimensions sliders let you control the basic size of the tiles and grout spacing..

Width
Width sets the width of the tiles in pixels.

Length
Length sets the length of the tiles in pixels. 

Pressure
Tile width depends on stylus pressure. This Pressure slider allows you to control the width 
variance under differently weighted strokes.

With the Pressure slider set at zero, a light stroke produces narrow tiles, and a heavier stroke 
creates wider tiles. 

Increasing the Pressure slider makes Painter consider the stroke that much harder when 
calculating the width of the tiles. By increasing the Pressure setting, you can prevent Painter from 
creating narrow tiles in response to a light stroke. One-hundred percent pressure will create 
uniformly wide tiles regardless of the pressure.

Grout
Grout sets the spacing between tiles in pixels.

Randomness
The Randomness sliders allow you to control the uniformity of the tile shapes. increasing 
randomness makes the shapes more erratic--each different from the last.

For example: If the Length Dimension is 10 pixels, a Length Randomness of 25% creates tiles 
that are randomly given a length from the range of 7.5 to 12.5 pixels.

Width
Increasing Width randomness allows the width to vary by the set percentage..

Length
Increasing Length randomness allows the length to vary by the set percentage.

Cut
With Cut randomness at zero, the ends of the tile are created perpendicular to the stroke. 
Increasing Cut randomness allows the angle of the tile ends to vary. 

Grout
Increasing Grout randomness allows the spacing between tiles to vary by the set percentage.



Tips for Working With Mosaics
Traditionally, mosaics are pictures created from ceramic tile and grout. If you are either cloning 
from an existing image or creating a mosaic design from scratch, you want to follow a few 
common-sense rules:

Use your first few courses of mosaic tiles to delineate the most important contours of your 
subject. Just as if you were drawing with a pencil, describe the most important lines of 
your scene first. Additional courses of tiles will follow these initial contours.

Use larger tiles in areas of flat color and smaller tiles in regions where you need to 
capture more detail. In flat color areas its effective to introduce some color variability. 
Tiles used in traditional mosaics rarely had uniform color.



Mosaic Commands
The Mosaic Commands pop-up provides access to the remaining mosaic features.

Reset Mosaic
This command removes all tiles from the document. Painter clears the canvas to the grout color. 

Re-Render Mosaic
This command re-creates the mosaic from the grout color and the tile object information. Re-
rendering will first fill the image with the grout color, and then re-render the mosaic tiles at the 
resolution of the document. This command allows you to change the resolution of the tiles, after 
you change the resolution of your document. 

Render Tiles into Mask
This command places the tile shapes in the background mask. 

This feature has several uses. The most common is adding depth to the tiles.

With the tiles in the mask, you may use the mosaic pattern as a selection. Or invert the mask to 
use the grout as a selection. This can be particularly interesting when working with a tesselated 
mosaic.

In most cases, youll want the Picture slider at 100%. See Image Editing and EffectsImage Editing 
and Effects    for more information on surface texture options.

Because Painter uses the tile shapes (from the mask), the resulting surface texture gives the tiles 
an excellent 3-D appearance.

Start with Triangle
Start with Triangle is an option. When it is enabled, Painter creates a triangle as the first tile in 
each stroke. This is particularly useful when filling a V shaped space with tile.

Respect Edge of Image
Respect Edge of Image is an option. When it is enabled, Painter maintains a grout line at the 
perimeter of the image. Tiles you create at the edge of the image will not violate the grout line.

Stroke Selection and Fill Selection
The Stroke Selection and Fill Selection commands are provided for applying mosaic tiles to 
selections. 

Use the Mosaic Commands pop-up, to select the command you want: Stroke Selection or Fill 
Selection.

Stroke Selection creates one row of tiles along each selection path.

Fill Selection applies multiple rows of tiles, working in from the path, until the selected area is 
filled with tiles.

In some cases, Painter might not put a tile in every space. You can fill openings by choosing the 
Apply Tiles Tool and stroking them in yourself.

If you dont like the way Painter filled an area, you can use the Remove Tiles Tool to clear it. Then 
you can re-apply tiles by hand.

Note:    Stroking a selection and filling it only makes sense when you change some parameter 
between operations. For example, you might change the tile color or dimensions. If stroke and fill 
is something you are going to do, remember to stroke first, then fill.



Tesselation Mosaic
A tesselation is a type of mosaic that uses non-rectangular tiles. Painters Make Tesselation 
feature gives you extraordinary power to create mosaics of differently shaped tiles. 

The Make Tesselation feature works by dividing the canvas into polygonal shapes, which become 
the mosaic tiles. The polygons themselves are sets of points, connected by line segments. You 
can control the number of points and their distribution. You also may choose the rule for 
connecting them. After closing the Make Tesselation window, the polygons appear as mosaic 
tiles--given the primary color, and surrounded by the grout lines described in the Make Mosaic 
window.

You might want to convert a regular image to a tesselation. If so, set up the image as the clone 
source. Enable the Use Clone Color option on the Colors Palette. Then proceed to make the 
tesselation

During tesselation, a working view covers the document composed of dark lines on a white page. 
This is a working view. It wont destroy floaters. When you finish with the tesselation, mosaic tiles 
are rendered and take over. The regular image returns.

You make a tesselation by creating points, which Painter connects to form the polygons. You can 
create points in two ways: 

Drag in the document to create points. Drag again to add more points. The points 
accumulate.

Choose one of the Add Points commands from the pop-up. You may add 500 points 
randomly, evenly spaced, or based on a clone source document.

Adding points based on a clone source is a powerful option. The 500 points are distributed 
according to the luminance of the clone source. Lighter regions receive a greater density of 
points, and so, smaller polygons. 

Repeat an add-points command to create more points. You can alternate between dragging and 
using an add-points command. The points accumulate. 

The number of points appears in the corner of the Make Tesselation window.

To clear all points, choose Reset from the commands pop-up.

Try this: Start with a clean slate. Add 500 points at random or evenly spaced. Now stroke letters 
in the document. This increases the point density along your stroke. The letters will appear as a 
swath of smaller polygons.

It is possible to create a huge number of points. More points mean more polygons, which 
increases the time it takes to convert to a mosaic. Keep this in mind to avoid overwhelming your 
system.

Display
Painter forms polygons by connecting the points according to the Display rule. 

To change the rule, select the shape you want from the Display pop-up: Triangles, Cracks, or 
Pieces.

Finishing a Tesselation



When you finish creating the polygon mesh, click Done to close the Make Tesselation. Painter 
works for a moment, converting the polygons to mosaic tiles, then rendering the mosaic image to 
the canvas.

After the tesselation appears as a mosaic, you may open the Make Mosaic window and modify 
the tile colors.

Tesselation tiles are subject to the same rules as the rectangular mosaic tiles. You may use the 
tools on the Make Mosaic window to remove them and change their color. You cant re-apply 
them, however.

Try creating a complex tesselation using the grout color as the tile color--black, for instance. After 
conversion to a mosaic, the image appears totally black, as though empty. Its not. Open the Make 
Mosaic window, choose the Change Tile Color tool, set the primary color to a bright color and 
stroke in the document. Colored, tessellated tiles will appear beneath your stroke.

The following Mosaic commands are available for tesselations: Reset Mosaic, Re-Render Mosaic, 
and Render Mosaic into Mask. The other mosaic commands relate to creating tiles, so they dont 
apply to tesselations.



Image Hose
The Image Hose is a milestone in the evolution of art tools. Instead of painting with color, the 
Image Hose paints with images. And not just one or two images at a stroke, but a variety of 
changing images. 

The images flowing from the hose change as you stroke the brush. Painter gives you complete 
control of the changes. For example, by increasing stylus pressure, you can hose larger images--
or more colorful ones. Or by changing the direction of the stroke, you can change the angle of the 
images. This is just a sample of the possible controls. By creating your own sets of images, 
anything is possible. 

The Image Hose deposits 24-bit images with an 8-bit mask. The mask enables you to layer the 
images gently, without aliasing. The images build to form coherent. 

You can load the Image Hose with leaves, bark, grass, stones, people--images of any description. 
And when you paint with these image elements, you can build them into coherent shapes--a tree, 
a hill, a cobble stone street, a crowd of people.

Then, just as easily, you can take the trees, hills, and streets you create, load them into the hose, 
and paint with them. There is no limit to the variety of images you can paint from the Image Hose.

How the Image Hose Works
The Image Hose is a brush. To use it, you must first load it with images. The images are kept in 
special Nozzle files. 

A nozzle is what you attach to a garden hose to control the flow of water. So a Nozzle is what you 
attach to the Image Hose to control its medium--images.

A Nozzle file may contain any number of images. Usually, the images are similar and form a 
logical series--that is, the images progress along some order. For example, the images might 
increase in size, or advance in angle. 

It is not necessary that images progress in a logical series, but the Image Hose is more powerful 
when they do. Progression allows you to subtly control the images that flow from the hose. 

The images are indexed so that Painter can locate and hose specific images on request. As you 
paint with the Image Hose, you can request specific images from the Nozzle index by varying 
your input. Increasing an input value takes images from later in the series. For example, you can 
set up the Nozzle so that by pressing harder with the stylus, you paint with larger images.

Indexing refers to the method Painter uses to select particular images from the many images in a 
Nozzle file.

You control which input factor to use for indexing on the Nozzle Palette. You can hose images 
sequentially, at random, based on pressure, stroke direction, and several other factors.

You control the images themselves in the Nozzle file. If you want more variety in the images, 
create more images in the Nozzle file. 

As your Image Hose requirements become more exacting, you can create complex Nozzles that 
involve two progressions--for example, images get larger and change angle. In this case, youll 
use one input factor, to determine image size, and use a second factor to determine image angle. 
This creates a 2-Rank Nozzle. 



See Also:
Using the Image Hose
Controlling the Image Hose Brush
Controlling the Image Hose Nozzle
Creating Nozzles for the Image Hose



Using the Image Hose
To use the Image Hose: get a Nozzle, choose the Image Hose variant, and stroke the brush in 
your document. Of course, you have a number of options along the way.

The first time you load a Nozzle, Painter may ask for some information on the images 
construction. This is covered in the section on creating Nozzle files.

Keep Nozzle files in the Nozzle folder (in the Painter application folder) for easy retrieval.

Choosing an Image Hose Brush Variant
After loading a Nozzle file, all you have to do to start painting is choose the Image Hose brush 
and one of the variants. 

About the Variants
Like Painters other brushes, the Image Hose has several variants. These built-in variants 
combine Nozzle Control factors with brush settings to create different hose effects. 

The following descriptions will give you an idea of the effect of each variant.

Small, medium, and large refer to image spacing. Small variants space images closely. Large 
variants space images widely. See Controlling the Image Hose Brush    for more information on 
spacing images.

Random, Sequential, Directional, Pressure, and (Source) Luminance refer to the indexing rule by 
which images are selected from the Nozzle file. See Controlling the Nozzle for more information.

Spray and Linear refer to the placement of images in relation to the stroke. Spray variants scatter 
images. Linear variants place images directly on the stroke path. See Controlling the Image Hose 
Brush for more information.

You can use these variants as a starting point, then adjust the brush and Nozzle controls to hose 
the images just as you want them. 

The Controls Palette: Brush Tool 
You can use the sliders on the Controls> Brush Palette to adjust the opacity of Nozzle images 
and to mix them with the secondary color. 

The Opacity slider allows you to make Nozzle images semi-transparent. If you move the slider all 
the way to the left, the images become invisible. 

The Grain slider allows you to mix the secondary color with the Nozzle images. If the slider is set 
to 100%, the Nozzle images remain pure. As you move the slider to the left, more of the 
secondary color appears in the images. If the slider is set to 90%, Painter mixes 10% of the 
secondary color to 90% of the image. This can be a handy to use, to adjust the shading of image 
elements.

Controlling the Image Hose
The Image Hose has three components of control: The Image Hose Brush, the Nozzle controls, 
and the Nozzle file. 

Youll adjust the brush to determine the placement images in the stroke.

Youll set the Nozzle control palette sliders to change the scale and to set the rules for 
indexing.



Youll create your own Nozzle files to determine the image content and dimensions of 
progression.

These control components ascend in complexity, so youll probably want to tackle them in this 
order.



Controlling the Image Hose Brush
Brush controls for the Image Hose primarily affect where the images appear in the stroke. For 
example, whether the images are scattered or closely spaced. 

Spacing Images 
You control the space between images with the Size/Spacing slider on the Brush Controls: 
Spacing Palette. Moving the slider to the right increases the spacing between image elements.

Because spacing is based on the diameter of the brush, the Size slider in the Brush Palette: 
Controls menu: Size Palette also affects image spacing. Increasing the brush size adds space 
between hosed images.

The Size slider does not affect the size of the image elements themselves. For this control, use 
the Scale slider on the Nozzle Palette.

Randomizing placement
You control the proximity of images to the stroke path with the Dab Location Placement slider on 
the Random palette. When the slider is all the way to the left, images are hosed directly in the 
stroke. Moving the slider to the right increases the scattering of the images.

Sliders Palette 
The Sliders palette offers dynamic control over the brush settings described above. This can lead 
to a very complex brush, but not necessarily a useful one. 

When youve mastered the controls for the Image Hose brush and the Sliders palette, you might 
find a useful way to combine the tools.

Not all features of the Sliders palette apply to the Image Hose brush. 



Controlling the Image Hose Nozzle
 You can control the size of the Nozzle images and their rules for delivering them with the sliders 
in the Nozzle Palette. 

Scale
The Scale slider lets you control the size of image elements delivered by the Image Hose. Drag 
the slider to the left to shrink the images. Drag it to the right to grow them. At 100%, the images 
equal their size in the Nozzle file.

Indexing
As you paint with the Image Hose, Painter selects images from the Nozzle file based on one or 
more rules. This selection process is called indexing. The Nozzle Palette lets you change the 
rules for indexing the images. 

Image Nozzle files may be created with one, two, or three image progressions. The dimensions of 
progression are identified as ranks, so each Nozzle file can be identified as a one, two, or three-
rank Nozzle.

Learn more about the rank system in Creating Nozzles for the Image Hose. 

Nozzle Options
The Brush Controls: Nozzle Palette has two check box options for the Image Hose.

Use Brush Grid
When Use Brush Grid is enabled, the Image Hose places images in a regular grid pattern. The 
grid size follows the grid in the Nozzle file.

Add to Mask
When Add to Mask is enabled, the images you paint with the Image Hose are painted to the mask 
layer as well. That is, the mask of each Nozzle image is added to the mask layer.



Creating Nozzles for the Image Hose

Designing an image nozzle: 1, 2, or 3 ranks
A Nozzle file contains a series of images arranged in a regular grid. Usually, the images are 
progressive in terms of size, shape, angle, or color. Progression is not necessary, but it increases 
the sophistication of the Image Hose. For example, with Nozzle images progressing in size, 
greater stylus pressure paints incrementally larger images.

A one-rank Nozzle has one progression.

What if you want a two-dimensional progression? Image elements increase in size and/or change 
angle. To do this, youll need to set up your images as a 2-Rank Nozzle file. Painting with a two 
rank brush, you can control where your image comes from in terms of both progressions. In this 
case, you use a different input factor to control the location in each rank.

For information on setting the control factor for each rank, see Controlling the Nozzle.

You can extend the Nozzle to a third progression, creating a 3-Rank Nozzle. Again, you use a 
separate input factor to control the location in each rank.

If you use one input factor to control two ranks, some image elements become unavailable.

Consider the way you will control each rank before building a Nozzle. The way you lay out the 
images can limit the ways you can control the indexing.

Before you begin building a Nozzle, youll need to decide what rank level you need. 

Youll need to have an idea of how many elements you want in each progression.

Understanding the Ranking System
A one-rank indexing system is simply a numbered sequence. You can locate any element in the 
sequence by giving its number. For example, Item 3.

A two-rank indexing system is used two perpendicular sequences. A two-rank system is used in 
chess to identify the squares on the board. From Whites side, the columns are labeled 
alphabetically, left to right, and the rows are numbered moving outward. Each of the 64 squares 
on the chess board can be located, given the letter of its column and the number of its row. For 
example, Square c-5. (Conventional chess notation omits the hyphen.) 

A three-rank system adds another dimension to a two-rank index. To visualize this, imagine a 
stack of chess boards. Use the two-rank system to locate a square on the top board, then count 
down through the stack to locate the same square on a deeper board. For example: The White 
Queen starts out on square d-1. If you have a stack of four chess boards, the White Queens 
square on the bottom board can be located as d-1-4.

Preparing Images
Regardless of the rank level of the Nozzle you are making or the method you use to build it, the 
following tips will help you develop the individual images.

Each element in an Image Hose Nozzle must be masked. The mask allows you to paint with 
images of irregular shape. Only what is inside the mask will flow from the Image Hose.

You might want to work by creating a silhouette of the image shape with a mask, then fill in the 
color information later.

With soft edges to the mask, you can hose images that are automatically anti-aliased. This 



improves the continuity across an area of hosed images.

As you create image elements, turn them into floaters. If the floater looks good when dropped on 
different backgrounds, the image will look good as a Nozzle element. Building a Nozzle      from 
floaters offers advantages in convenience as well.

Float the image on a black background and add a drop shadow. This will enhance the three-
dimensionality as image elements build up in layers. When all elements have the shadow in the 
same position, it appears the light source is the same across the painted area.

The first time you load the Nozzle file, the Nozzle Definition dialog box appears asking you for 
some important information. By providing it, you inform Painter of the math you did when you 
created the file--the size of each cell and how many image elements there are. Painter needs this 
information to index images correctly.

Item width and height describe the cell grid size. Enter the values you set in the Nozzle file.

Index rank describes the number of progressions. Enter 2 for a 2-Rank Nozzle.

In the columns on the right, enter the number of image elements in each dimension. 

When youre done with the Nozzle Definition dialog, click OK.

If the values you enter do not describe the file, Painter will not accept them. In other words, the 
number of items multiplied by the item size must equal the dimensions of the Nozzle file.

Remember, youll still need to set the sliders in the Nozzle palette to describe the control factors 
for each rank.



Image Editing and Effects
Many of Painters effects are inspired by traditional artistic methods. 

The Effects menu offers features for electronic retouching, color correction, sharpening and 
softening focus, adding lighting with control over direction, color, and intensity. Orientation effects 
include rotate, scale, and flip. 

Special effects range include glass distortion, embossing, posterizing, color overlays, and 
warping. Youll find tools to create growth patterns, marbling, Van Gogh effects, and even blobs.

In some cases, effects involve other Painter features such as clones, special brushes, or floaters. 
Where possible, we have tried to provide enough information that you can select and experiment 
with an effect without having to refer to other sections of this manual.

See Also:
Applying Effects
Effects 
Tonal Control
Surface Control
Focus
Esoterica



Applying Effects
 Most of Painters effects are applied by making a selection, choosing a command from the Effects 
menu or one of its submenus, setting options, and clicking OK. If you do not make a selection, the 
effect will be applied to the entire image.

There are some Painter-specific features you should review before using the Effects menu. These 
include some selection tips, how effects dialog boxes work with other open palettes, using the 
Fade command to partially undo effects, the location of recently used commands in the Effects 
menu, and descriptions of the Using pop-up menu. These areas are discussed in the next few 
sections.

Selecting Where to Apply Effects
You can apply Painters special effects to a selection, to a floater, or to the entire image. 

If you want to apply an effect to a region of the Canvas, select that area before choosing 
an effect command. You may use any of Painters selection tools, including the 
Rectangular Selection Tool, the Oval Selection Tool, the Lasso and the Magic Wand.

If you want to apply an effect to an image floater, select that floater before choosing an 
effect. Painter applies the effect to the entire floater.

Effects and Open Palettes
You can use all of the effects dialog boxes with the Art Materials palettes without closing the 
dialog box. For effects that use color or paper texture, this means that you can change those Art 
Materials while you are experimenting with the effect, and see your changes update interactively.

Suppose, for example, you are adding a Color Overlay to an image. The overlay effect depends 
on a selected paper texture and primary color. If you open the Paper Palette and the Color Palette 
when you choose Effects menu> Surface Control> Color Overlay, you can select and/or change 
paper grains and colors. These changes can then be seen in the Preview Window of the Color 
Overlay dialog box. If necessary, you can open color sets, or paper texture libraries while the 
Color Overlay dialog remains open.

You can move effects dialog boxes out of the way, if necessary, for full access to other palettes.

Using Fade to Partially Undo Effects
The Fade command allows you to undo any percentage of your last effect. This is a great way to 
achieve just the right amount of an effect.

Recently Used Effects Commands
The Effects menu consists of several submenus. Sometimes while you are working, you want to 
use the same effect multiple times. Painter makes this easy. As you work, youll notice that the 
menu items for the last effects commands youve used are available at the top of the Effects 
menu. This makes it easy to choose the commands again.

Shortcut: Painter provides keyboard shortcuts for the two most recently used effects:
Access the last effect used by pressing x-/.
Access the second to last effect used by pressing x-;.

About the Using pop-up menus
In many of Painters effects dialog boxes, youll see a pop-up menu named Using.

This menu lets you specify the source that Painter uses as a model for applying an effect. The 
model tells Painter how much of the effect to apply to different areas of the image. Areas of high 
luminance in the model apply a greater degree of the effect in the image.



The Using options vary between effects. They include Paper Grain, Mask, Image Luminance, 
Original (clone source) Luminance, and Uniform. These are described in the sections explaining 
the different effects.

In most cases, you can see the results of choosing different options in the Preview Window of an 
effects dialog. The best way to see how these commands affect your images is to try them.

Orientation
You can manipulate part or all of your images orientation by rotating, scaling to a larger or smaller 
size, or flipping horizontally or vertically.

These commands are located under Effects menu> Orientation.

Rotate
You can rotate all or part of an image.

Scale
The Scale command lets you change the dimensions of part or all of an image. This command 
also works on grouped floaters.

Distort 
You can distort the shape of an image or part of an image. Distort will work on a selection within 
the canvas or on a floater.

Flip Horizontal
Flipping an image horizontally creates the mirror image across an imaginary vertical plane down 
the center of the image. The flip commands work on a selection within the canvas or on a floater.

Flip Vertical
Flipping an image vertically creates the vertical mirror image of itself flipped across the horizontal 
plane. 

Transform Features
The transform effects are for Reference Floaters.

Free Transform converts an image floater into a reference floater. This enables you to 
resize, rotate and slant it by dragging the handles.

Set Transform lets you perform these same transformations numerically.

Commit Transform converts the (transformed) reference floater back into an image 
floater.



Effects 
Painters Effects fall into several categories. Here are some of the tasks you can accomplish with 
the many options of the Effects menu.

Tonal Control  lets you adjust brightness/contrast, adjust color values (HSV) for an entire 
image or part of it.

Surface Control refers to changing surface textures, embossing, adding color overlays, 
lighting effects, and warping.

The Focus commands let you soften or sharpen the focus, add glass distortion or motion 
blur effects.

Esoterica commands let you create some unusual and innovative image-editing 
techniques including automatic cloning, an automatic Van Gogh effect, blobs, marbling, 
and highpass.

Third-Party Plug-Ins
Additional effects features may be provided by third-party plug-ins. Usually, these are purchased 
separately. You can access third-party plug-ins from within a document by using the Effects 
menu.

You can also use the File menu> Acquire or File menu> Export commands to send images in and 
out of Painter by way of plug-in devices, such as scanners, film recorders, color printers, and 
so on.

See Also:
Tonal Control
Surface Control
Focus
Esoterica



Tonal Control
The Tonal Control commands in the Effects menu let you adjust or alter colors in an image. 

Correct Colors
Color correction lets you make adjustments in the relative amounts of the color components in an 
image. Color correction is often used to improve a color-casted or washed-out scan. It can also 
be used to create surreal color effects. 

If a floater is selected, color correction applies within the floater. If no floater is selected, it applies 
to the entire image.

Contrast and Brightness
The Contrast and Brightness method provides sliders you can use to adjust the curves. These 
controls leave the black point at black and the white point at white.

Increasing contrast makes dark areas darker and light areas lighter. Decreasing contrast pushes 
colors closer to midtones, but not necessarily uniformly.

Increasing brightness makes the colors lighter. Because dark colors have farther to go to reach 
maximum, they are increased more.

Curve
Curve lets you push and pull the curve where you want it. 

Position the cursor precisely on the curve--the cursor takes on the Floating Selection tool 
shape--and drag the curve where you want it.

The Effect slider controls how much of the curve moves in response to your dragging. 
When the slider is all the way to the right, the entire curve moves. As the Effect value is 
reduced, less of the curve moves. You can use lower Effect settings to create small 
change sin the gamma curve.

The Curve panel also provides buttons for setting the black and white point.

Auto Set automatically determines the black point and white point for the image.

Set Black makes the current color the blackest point. (You should use the Dropper Tool 
to pick a color from your image before opening the Color Correction window and 
choosing this command.) All colors equal to or darker than the current primary color are 
assigned black.

Set White makes the current color the whitest point. (You should use the Dropper Tool to 
pick a color from your image before opening the Color Correction window and choosing 
this command.) All colors equal to or lighter than the current primary color are assigned 
white.

Freehand
Freehand lets you draw the curve as you want it. This method is particularly useful when you 
want posterized or solarized effects.

Advanced
The Advanced method allows you to set the red, green, and blue curves numerically at five 
points: Shadows, 1/4 Tone, Midtone, 3/4 Tone and Highlight. These points coincide with the 
vertical grid lines.



Adjust Colors
The Adjust Colors command lets you control the hue, saturation, and value of an image in much 
the same way as you would adjust your TV. 

Adjust Selected Colors
Adjust Selected Colors is similar to the Adjust Colors command, but it works only on a specified 
range of colors within an image. You choose a color in an image and adjust colors within a range 
of that color. You could, for example, turn yellow peppers to red peppers.

You can adjust colors that are exactly the same as the color you select, or you can choose colors 
within a range, based on proximity (on the color wheel or color space) to the selected color. 

Brightness/Contrast
The Brightness/Contrast window adjusts the brightness and contrast of the overall image in the 
RGB format. Alternatively, the Adjust Dye Concentration command 
converts the image to a dye density domain and adjusts it there. 

Equalize 
The Equalize effect improves contrast, adjusting black and white points and distributing the 
brightness levels throughout the entire range of available levels. To achieve this, Painter creates a 
histogram showing the number of pixels for each brightness level value. Equalize allows gamma 
adjustment, which lightens or darkens an image without changing highlights or shadows.

Negative
Choose Effects menu> Tonal Control> Negative to turn part or all of your image into a negative. 
The Negative effect will simply invert all the colors in your image. 

Posterize
Posterizing adjusts the number of color levels an image contains.

Posterize Using Color Set
Painter can posterize your image based on a color set. This allows you to create an image with 
only a specified set of colors in it. This is useful for multimedia work as well as applications like 
silkscreening.

The image is reduced to the colors in the current color set.



Surface Control
 Some of Painters most unusual image-editing effects are in the Surface Control submenu of the 
Effects menu. You can manipulate paper, color, and light t to produce a variety of interesting 
visual effects. Many of these effects will allow you to add texture to an image, which can give the 
illusion that it was created on canvas or paper.

Apply Lighting
The Apply Lighting effect lets you shine one or more light sources on part or all of your image.

Apply Lighting is comparable to hanging your artwork in a gallery and adjusting colored spotlights 
to illuminate it.

You can choose different lighting effects from a Library provided, or you can create your own 
effects by defining brightness, distance, color, and other characteristics. Once you have achieved 
a lighting effect you like, you can save it in a Library for use with other images. 

Customizing Lighting
You can use the controls in the Apply Lighting dialog box to achieve other lighting effects. The 
Preview Window shows your changes, so you can experiment and see the results. 

Setting the Light Source 
The Preview Window shows one or more light indicators. You can add and delete lights if you 
want. The small part of the indicator points in the direction that the light is shining; the large part 
shows where the light actually is.

To move the indicator, drag its large end.
To change the light source direction, drag the small end.
To create another indicator, click anywhere else in the Preview Window.
To delete an indicator, click the indicator to select it. Then press Delete or Backspace. 
To change the settings for a light, click on the indicator to select it. Then adjust the sliders to 
set the color as described below.

Use the following guidelines to adjust the sliders:

Brightness is like a dimmer knob. Moving it to the left turns down the light source, moving it 
to the right increases brightness.
Distance controls how far the light is from the image. If you move the light source closer, you 
may have to change the images exposure (see below).
Elevation sets the lights angle in relation to the canvas. At 90 the light is shining straight 
down, and at 1 its very shallow.
Spread sets the angle of the light cone.
Exposure is the images brightness as in photography. Moving the slider to the left decreases 
exposure, moving it to the right increases exposure. Increasing the exposure lightens the 
image as a whole. Decreasing exposure darkens it.
Ambient is the surrounding light in an image. If you had no individual lights in your image, the 
ambient lighting would govern the overall lightness of the image. Moving the slider to the left 
darkens the overall lighting; moving it to the right increases the light.

Setting the Light Color 
Click the Light Color square and choose a color for the light source in the Color Picker. Then click 
OK or press Return.

Setting the Ambient Light Color
Click the Ambient Light Color square and choose a color for the surrounding light in the Color 
Picker. Click OK or press Return. 

Saving Lighting Effects 



When you have adjusted lighting and created an effect you like, you can save it. In the future, 
your saved lighting environment will be available in the library at the bottom of the dialog.

When you have finished making changes in the Apply Lighting dialog box, click OK or press 
Return.

Creating Lighting Effects Libraries 
You may create your own lighting library. Click Library. Painter displays a dialog that lets you 
create a new library or load an existing one. To access the Lighting Mover, choose Shift-x-L.

Apply Screen
Apply Screen is another way to add texture to an image. It combines luminance, the selected 
paper texture, and the three colors you pick in the Apply Screen dialog box to add a three-color 
screen to an image.

Apply Surface Texture
Painter lets you add a three-dimensional surface texture to your image. You can use this feature 
to apply a paper texture across the image, to give depth to the brush strokes of an oil painting, 
and to make the tiles of your Mosaic three-dimensional. 

Reflection Maps
The Reflection slider in the Apply Surface Texture dialog maps the clone source onto the surface 
at a variable percentage.

Embossing
You can use the Effects menu to add an embossed effect to your images.

In order to create an embossed effect, you must begin with a clone document. Painter uses the 
original luminance--the brightness of the source document--to create the surface texture in the 
clone. See    Cloning and Tracing, for more complete information about cloning.

The clone becomes an embossed version of the original.

Three-dimensional Oils Effect
The 3D Brush Strokes option makes brush strokes appear to be three-dimensional, giving them 
the illusion of oil paints. In order to create this effect, you must begin with a clone document. 

The difference between the clone and the original defines the three-dimensional texture in the 
clone. See Cloning and Tracing, for more complete information about cloning.

Color Overlay
Use the Color Overlay command to simultaneously add color and texture effects to an image.

Dye Concentration
The Dye Concentration effect adjusts color intensity and adds surface texture by adjusting 
pigments. You can use it, for example, to lighten an underexposed photo or to darken an 
overexposed one. 

Express Texture 
Express Texture generates a high contrast version of an image in grayscale. With this feature, 
you can create a visual effect similar to a custom halftone screen, like a mezzotint or line screen. 

Express texture is similar to Apply Screen with anti-aliasing built in. 

If you want to add color back in after using this effect, try using the Edit menu> Fade command. 
This will bring back the original colors of the image. 

If you want to add a new set of colors, you can apply a gradation to the image. First, choose a 



gradation, then select Art Materials Palette: Grads menu> Express In Image.

Image Warp
The Image Warp command lets you distort the surface of an image as if it were a sheet of pliable 
film. With this command, your images can look as though theyre reflected in a fun house mirror. 

QuickWarp
The Effects menu> Surface Control> QuickWarp feature lets you easily create some of the basic 
distortions. These distortions are useful in preparing images for the Surface Texture Reflection 
map feature.

The Amount and Angle Factor sliders control the warp effects. 

Sphere warps the image spherically, like a reflection on a polished silver ball. 

Bump warps the center of the image toward you, making it appear convex.

Valley warps the center of the image away from you, making it appear concave.

Swirl distorts the image in a spiral. The Angle Factor controls how many times the image 
spirals.

Ripple distorts the image in concentric rings, like a reflection in a pool of water when you 
drop in a stone.



Focus
The Focus commands in the Effects menu let you create sharpening, softening, motion blurring, 
and glass distortion effects. 

Glass Distortion
Glass distortion offers powerful tools for distorting an image. You can use it put your image behind 
the pebble glass of a shower door, or you can distort your image beyond recognition. 

A myriad of effects are possible with Glass Distortion. So many, in fact, that youll probably want to 
experiment for a while before settling on the effect you like.

Glass distortion works by relocating the pixels of the image. Painter lets you control the rules 
used for relocating the pixels. The primary controls are the displacement map type and what 
information it uses to create the map.

Motion Blur
This effect makes an image appear as if it has been blurred by movement.

Sharpen
This effect heightens contrast by intensifying highlights and shadows.

Soften
This effect increases the transition from one part of your image to another, enhancing the anti-
aliasing of strokes.



Esoterica
Esoterica holds some of the more interesting and specialized effects. 

Apply Marbling
Marbling creates intricate distortions of the image, following a technique that dates back to the 
12th century.

Think of a fork dragging through a mix of chocolate syrup and melted ice cream at the bottom of 
the bowl. Only instead of syrup and ice cream, the rake drags through your image.

Each time the rake drags through the image is called a step. You may create marbling recipes 
that include several steps--each time dragging with a different rake, direction, and waviness. 
When you create such a multi-step marbling recipe, you can save it for later use.

The Marbling Recipe

Using AutoClone
You can have Painter clone brush strokes for you, rather than creating them yourself with a 
Cloner brush. See Cloning and Tracing, for information about cloning.

Using Auto Van Gogh
The Effects menu> Esoterica> Auto Van Gogh effect works with the Auto Van Gogh variant of the 
Artists brush. This algorithmic approach to placing directional brush strokes results in a Van 
Gogh-like rendition of an image.

Using Blobs
This effect is a good step to take before doing marbling because it involves simulating a pattern in 
paint floating on liquid in a pan, modeling the way that traditional marbling is done. It takes 
whatever you copy or cut to the Clipboard (or uses the current color if the Clipboard is empty) and 
puts it in a swirling pattern by placing blobs into the liquid image. 

Hint: Try using a circular selection shaded like a sphere (instead of a recognizable 
element) using the Airbrush before choosing Edit menu> Copy. This produces bubblelike 
elements. 

Highpass
Highpass suppresses low frequency areas containing gradual or smooth transitions of brightness 
levels. This leaves high frequency areas, or just the edges of an image, containing stark shifts 
between brightness levels. 

Grid Paper
Using Grid Paper in the Effects menu, you can add horizontal or vertical lines or a grid to part or 
all of your image. The lines become part of the image canvas, and thus become an element in 
your design. 

Align moves selected floaters and shapes into positions relative to one another.    See    Floaters 
for more information.

Drop Shadow 
Drop Shadow automatically creates a drop shadow for floaters. You can add a drop shadow to a 
single floater or to a group. If you wish to apply a drop shadow to several floaters at once, group 
the floaters before applying the shadow. 

The drop shadow is a separate floater that is grouped with the original floater. Check Collapse to 
One Layer in the Drop Shadow dialog box if you want the floater and its shadow to be one floater 
when the operation is complete.



Art Materials Palatte
Painters Art Materials Palette holds the controls for creating and choosing colors and color sets, 
paper textures, gradations, patterns and weaves.

Painters art materials are stored in several palettes located inside the Art Materials palette. These 
palettes can be considered subpalettes of the main Art Materials palette. The subpalettes of the 
Art Materials Palette are the Color, Paper, Grad, Pattern and Weave Palettes.

Art Materials Basics
If you do not see the Art Materials Palette on your screen, you can display it by choosing Window 
menu> Art Materials. 

The Color, Paper, Pattern, Grad, and Weave palettes have menus at the top that offer additional 
options. You can use the menus above the subpalette icons to design and store your own 
versions of these materials in libraries.

Painters Art Materials 
The Art Materials palette organizes all of Painters art materials. It can be displayed in a variety of 
ways. In its smallest form, you see the face of the drawer displaying the subpalette icons. 

Clicking one of these icons displays the selected icons materials. For example, clicking the Grad 
icon reveals gradation information.

Some palettes contain additional materials inside a drawer. You can open the drawer by clicking 
the pushbar. Inside the drawers are the contents of a library of art materials. The Library button 
provides access to additional materials grouped in libraries.

Many palettes can be expanded to show further controls. Clicking the grow box in the upper right 
corner of the palette will expand or contract the palette. 

You can tear off the subpalettes to view them side-by-side.

 Some palette drawers contain a Library button. The Library button allows you to open a new 
library containing additional Art Materials. Libraries are stored as files on disk. When you click a 
Library button, you see an open file dialog asking you to locate the desired file. Once youve 
located the file, click OK. The Library is opened and its materials fill the drawer. 

Creating Libraries 
Libraries provide another way of organizing groups of materials. You can use a library to group 
similar materials. You might want to create a library of gradations used for a specific project. 
When you are not using these materials, they are conveniently put away.

Libraries are available for papers, gradations, weaves and patterns. Libraries are used throughout 
Painter. All libraries are accessed, saved and moved in the same way. See Libraries and Movers.

See Also:
Working with Colors 
Color Sets 
Gradations 
Paper Textures
Weave Palette
Working with Patterns
Applying Art Materials





Working with Colors
 In Painter, you can add color to images by using brushes to make marks and you can fill an area 
by using the Paint Bucket Tool or the Fill command (x-F). You can use the Dropper Tool to sample 
or pick up a color for use elsewhere.

A feature unique to Painter is the ability to set color variability. The Color palettes contain sliders 
to adjust variability. Variability allows you to create brush strokes of several color levels. The best 
way to understand color variability is to take a look at it.

Using the Color Palettes
The Color Palette is the main way to select colors. As described in Painter Basics, when you click 
the Color icon on the Art Materials Palette, the Color Palette appears.

Painter provides three different types of Color palettes for you to use: Standard Colors, Compact 
Colors, and RGB Colors. You can choose between palette displays on the Art Materials Palette: 
Color menu. 

The Standard Color Palette is shown and described below. 

The Compact Colors Palette straightens the hue ring into a single bar.

The RGB Colors Palette provides simple RGB sliders for choosing color.

Click the grow box in the upper right corner to expand the palette and to see the 
variability sliders.
 

First you select the hue on the color ring, then you select the color on the triangle.

Within the triangle, the colors are organized by value and saturation. Values span the triangle 
from top to bottom, with the top of the triangle being the highest value (white), the bottom the 
lowest value (black).
Saturation levels go from left to right. Dragging to the right gives the purest color within the 
predominant hue. Dragging to the left gives muddier or grayer colors.

Primary/Secondary Color Rectangles 
The color you select appears on the front rectangle in the pair of overlapping rectangles. The front 
rectangle shows the selected primary color. The back rectangle shows the selected secondary 
color. Whenever you start Painter, black is the selected primary color and white is the selected 
secondary color. 

Most of the time youll work with the primary color. The secondary color is for multicolor brush 
strokes, two-point gradations, and Image Hose effects. 

You can change the secondary color by clicking on the back rectangle, then picking a color.

After changing the secondary color, click the front rectangle again. 

Copying Colors 
In addition to choosing colors from the Art Materials Palette: Color Palette, you can use the 
Dropper Tool to pick up a color from an existing image and use the color elsewhere. You can also 
choose the Use Clone Color option to use colors from the clone source image.

Cloning Color



The Use Clone Color option is another way to choose color. This feature lets the brush pick up 
color from the original (source image) while staying true to its own nature. Use Clone Color takes 
averaged samples of color from the clone source, resulting in an approximation of the original. 
See Cloning and Tracing for information on cloning.

Setting Color Variability
Use the Art Materials Palette: Color Palette to set up multiple colors for any of Painters brushes.

To display the Art Materials Palette: Color Palette, click the Color icon on the Art Materials Palette 
and expand the palette if necessary.

The ±HSV sliders control ranges of hues, saturations, and values. Moving the ±Hue slider to the 
right increases the number of hues in the brush stroke. These colors are the ones adjacent to the 
selected color on the color wheel.

Moving the ±Saturation slider to the right increases the variability in the color intensity of the 
brush stroke.

Moving the ±Value slider to the right increases the variability in the brightness of the brush stroke. 

You can try different ±HSV slider settings with any of the brushes to get some interesting results. 
Moving these sliders to the right is most useful when youre working with brushes like Painters 
Loaded Oils brush, the Van Gogh and Seurat variants of the Artists brush, and the Hairy Brush. 

Using Two Colors at Once
Usually you work with only the primary color, the front rectangle of the two overlapping rectangles 
in the color palettes. Using one color produces a solid brush stroke.

By selecting a secondary color, you can determine the colors for multicolored brush strokes. Most 
brush variants are able to paint with a variable range of colors. 

The settings for the brush on the Brushes Palette: Controls menu> Sliders Palette determine how 
Painter decides when to use one color or the other. For information on this palette, see    
Advanced Painting.

You might want to try a different setting for the Color slider. Try Pressure instead of Direction. 

For more information, see the Sliders Palette discussion in Advanced Painting.

Printable Colors
Your monitor may display more colors than can be printed on an offset press. The overlapping 
rectangles on the Art Materials Palette: Color Palette, the Controls: Dropper Palette, and the 
Controls: Brush Palette can be set to show how a selected color will print. The rectangles can 
display the printable color that is closest to the on-screen color you select.

Once you select the Printable Colors Only option on the Color Palette, color will be restricted to 
showing only printable colors. 

Displaying Images in Printable Colors
If you forget to check Printable Colors Only before you paint part or all of your image, you can 
still display the colors as printable colors.



Video Legal Colors
Painter also has the ability to set up colors for use in video. Painter supports both the NTSC 
(U.S.) and PAL (European) video systems. Only bright yellows and cyans are not video-legal.



Color Sets
 Color sets are used to organize groups of colors. Some color sets, like the Pantone color set, are 
organized both by name and color relationship. 

You can customize your own color sets to control the colors in particular projects or create groups 
of your favorite painting colors. You might call one color set shades of purple. You might call 
another color set crayon set or watercolor set. 

Displaying Color Sets
Painter provides two color sets--Painter Colors and the Pantone Matching SystemÆ. The name 
of the current color set appears at the top of the Art Materials Palette: Sets Palette. The Library 
button gives you access to other color sets. 

Note: You can set a default color set in the Preferences dialog box. For more information, 
see Setting Painter Preferences.

Finding Colors
There are two ways to find a color on a color set--by searching for the color name or by matching 
the current color.

Customizing Color Sets
You can rearrange color set layouts, create new color sets, and add and delete colors from color 
sets.

Customizing Color Set layouts 
You can arrange a color set in a variety of ways. You can specify the number of rows and 
columns, the size of the color swatches, whether or not there are grid lines, and whether or not 
the colors are named. 

You can make changes in any order until the color set is exactly the way you want it. The 
numbered steps in the next set of instructions give you a place to start.

The Art Materials: Color Set Palette provides tools for selecting and arranging color sets. 

Creating Color Sets
You can make your own color sets. The colors can come from an existing color set, from the 
selected color on the Art Materials Palette: Color Palette, or from an image.

If you want to pick up colors from an image, open the image before you begin creating the color 
set. You can customize the swatch size, grid lines, and names as described in the previous 
section.

Adding and Deleting Colors from a Set
Customize color sets further by changing, adding, or deleting colors. 

Annotating Colors
Painters Annotation feature uses the color names to label the colors in your images. You can hide 
or show these labels in your on-screen or printed image. (Only color sets with names will 
annotate properly.) Annotations can be up to 31 characters long.



Annotations and other Painter Features
Annotations float in a separate layer on top of the image and can be saved in the RIFF format 
with your image. 

Annotations are included when you record a session, and they are properly scaled when you play 
back at a different resolution.

When you move a floater, its annotations go with it. If you move an annotated floater on top of 
another, the visible annotation might actually belong to the underlying floater, even though it 
appears to be labeling the top one. 



Gradations

 
A gradation is a gradual transformation of one color into another. Sometimes they are called 
blends or fountains. Painter provides several different types of gradations: linear, radial, spiral and 
circular. You can fill areas with these gradations or express them in an existing image.

Although Painter comes with libraries full of gradations, youll want to create some of your own. 
You can define two colors and create a gradation between them. You can also capture gradations 
from existing images (even from imported art) and save them for use in other images. You can 
save your gradations in your own libraries.

See Also:
Working with Gradations
Filling with Gradations
Creating Gradations
Creating Gradations with the Gradations Editor
Capturing Existing Image Gradations
Mapping a Gradation to Image Luminance (Express Gradation in Image)



Working with Gradations
Use the Art Materials Palette: Grad Palette to select and adjust Painters gradations. To open the 
Grad Palette, click the Grad icon on the Art Materials Palette.

Across the drawer front are some gradations. Open the drawer to see more gradations. Click the 
gradation you want to use and close the drawer.

In the center of the palette, the Preview Window shows how the current settings affect the 
selected gradation. 

The Rotation Ring changes the angle of the gradation. Click anywhere in the ring to change the 
angle. The red ball shows the selected angle. The numeric value appears below the preview. 
Rotation RingRotation RingRotation RingRotation RingRotation Ring

The gradation types on the right of the palette let you select from four types of gradations--linear, 
radial, spiral or circular.

The gradation orders at the bottom of the palette determine how a gradation behaves. The 
preview strip (above the gradation orders) shows the selected gradation order

The top row (from left to right) orders the current gradation from left to right, left to right and 
mirrored, and right to left. The bottom row orders the current gradation from left to right and 
doubled, right to left and mirrored, and right to left and doubled. 



Filling with Gradations

After selecting a gradation, you can use it to fill all or part of an image. See Filling an Area, for 
information about selecting what you want to fill and what you want to fill it with.

If you would like to practice using gradations, you can use the Rectangular Selection tool to 
define an area to fill. You can also fill the entire image area if you want.

You might want to tear off the Color Palette to work with it alongside the Grad Palette. 



Creating Gradations

You can create your own gradations from simple to complex. For a simple gradation, choose 
primary and secondary colors to define a two-point gradation. For more complex gradations, use 
the Gradation Editor or capture gradations from existing artwork.

Creating a two-point gradation
You can define a two-point gradation by defining two colors in the Art Materials Palette: Color 
Palette and then having Painter create the gradation between them.

You might want to tear off the Grad Palette or the Color Palette, so you can see both at once. 

You can use the gradation to fill a selected object. See Filling with Gradations,      for more 
information. See Capturing existing image gradations.



Creating Gradations with the Gradations Editor

Use the gradations editor to create new gradations or edit simple, two-point gradations into a 
more complex blend. You can also select an existing gradation, one from Painters default library 
for example, and use the gradations editor to make color changes or blend adjustments. 

Changing color control points
To change a control point color, click a color control point to select it. You can then change the 
color for this control point by selecting a new color from the Color Palette. To start with a two-point 
gradation, click on the far right control point and then choose a color. Click on the far left control 
point and choose a different color. Now you could generate additional colors in between by 
adding new control points.

Adding and deleting color control points
You can easily add new color control points by clicking in the gradation bar. Click anywhere in the 
bar and a new control point is added without changing the color at this location in the bar. If you 
Option-click in the bar, a new control point is added and set to the current color. You can also hit 
the Delete key to remove the selected color control point. 

Using the Linear check box
Leave the Linear check box checked to create ramps that blend linearly between colors. When 
editing non-linear gradations (Linear is unchecked), all ramps within the gradation are non-linearly 
blended using smooth curves. When using non-linear ramps, you should use the Color Spread 
slider to control the color smoothness at each color control point.

Changing the color space
The square boxes above the ramp are located at the midpoints between the adjacent color 
control points. Click on a square box to select it. When one of these boxes is selected, you can 
change the color space for the corresponding color ramp segment. The RGB option will blend 
directly between the red, green, and blue components of the two colors. The Hue Clockwise and 
Hue Counterclockwise options will blend between the endpoint colors by rotating around the color 
wheel. For a better understanding of this concept, see the standard Color Picker and note the 
order of the colors on the wheel.

Notice that as you change the parameters within the Edit Gradation dialog, the gradation 
previews are updated within the Grad Palette. Click OK when youre finished. If you want to save 
your new gradation, click the Save button in the Grad Palette, name it and click OK.



Capturing existing image gradations
You can use any existing imagery as a source for creating new gradations. You could capture the 
colors in a photo of a sunset or paint your own range of colors as the content of a gradation.

See Also:
Libraries



Mapping a Gradation to Image Luminance (Express Gradation in 
Image)

You can also map a gradation to an existing image, replacing an images luminance values with a 
gradations luminance values. For example, using a black-to-white gradation to replace color in an 
image will produce a black-and-white rendition of the image. 



Paper Textures
Paper textures are useful in many ways. Painters brushes interact with the grain just as natural 
tools react with the texture of the surfaces on which you mark. Paper grains are also useful in 
applying Surface Texture and other Effects, like Glass Distortion.

When you choose a paper texture and a brush that interacts with paper grain, you see the results 
with each stroke. If you find a brush and paper combination you like, you can save it as a brush 
look. 

You can select different paper textures, modify them, organize them in libraries, and even create 
your own custom textures. 

When you click the Paper icon on the Art Materials Palette, the Art Materials Palette: Paper 
Palette appears. Additional papers are stored inside the drawer. Click the grow box in the upper 
right corner to expand the palette. 

The Paper Palette is where all your paper textures are stored. In addition to using it to select 
papers, you can use this palette to invert or resize the grain and to open other paper libraries.

Inverting Paper Grain
You can think of paper grain as a three-dimensional landscape. Usually brushes react to paper 
texture by coloring the peaks and ignoring the valleys. Checking the Invert Grain checkbox makes 
color fill the valleys and ignore the peaks.

Heres a trick for getting two-colored paper textures. After selecting a paper texture and painting in 
the image with one color, check Invert Grain, pick another color, then drag in the same area. You 
now have a two-tone texture in your image.

If you want paper grain to appear uniformly across the image, you should create the artwork first, 
then apply the grain as a surface texture. 

Scaling Paper Grain
Use the Scale slider at the bottom of the Paper Palette to resize the paper grain. With the slider at 
100%, the texture is the one shown on the Paper Palette. You can scale the texture down to 25% 
and up to 400%. 

Capturing Paper Textures
The Capture Texture command lets you turn a section of an image into a paper texture, available 
on the Paper Palette.

Your texture appears in the Paper Palette drawer and is added to the current library.

Making Paper Textures
The Art Materials Palette: Paper menu> Make Paper Texture command lets you make homemade 
paper textures. 

Make Paper Texture dialog box allows you to create your own Painter textures based on the 
patterns in the Pattern pop-up menu.

Changing Paper Color 
You can change the paper color of an open document. 



Using the Eraser will now erase to the new paper color.

Setting a Random Paper Grain
Normally, paper grain is fixed--the texture is in the same position each time you apply a brush 
stroke. You may change this if you want the grain to move randomly.



Weave Palette

The Weave Palette is, in effect, a virtual loom you can use to create weaves to use as fill 
patterns.

Two libraries of weaves are included with Painter. You can modify a weave by changing its fiber 
type, the scaling and thickness of its threads, or its color. You can also create and save new 
weaves of your own.

To open the Weave Palette, click the Weave icon on the Art Materials Palette. Then click to 
expand the palette.

Below the drawer are controls that let you preview a selected weave pattern, choose its fiber type, 
change colors, vary the scale of the weave and the thickness of its threads, and access the 
advanced editing palette.

You can also change fiber type or edit the weave in other ways.

Filling with Weaves
After selecting a weave, you can use it to fill all or part of an image. See Filling an Area,    for 
information about selecting what you want to fill and what you want to fill it with.

If you would like to practice using weave, you can use the Rectangular Selection tool to define an 
area to fill. You can also fill the entire image area if you want. 

Changing Weave Fiber Type
Painter can display a weaves pattern as two-dimensional or show the interwoven threads three-
dimensionally, complete with shadows.

Depending on which weave is selected, you may or may not see a change in the Preview 
Window. For different two- and three-dimensional effects, you can adjust the scaling and 
thickness sliders at the bottom of the Weave Palette.

Adjusting Scaling and Thickness
The four sliders at the bottom of the Weave Palette control the thickness of threads and the 
spacing between them. The top two sliders control horizontal dimensions; the bottom two control 
vertical dimensions. By adjusting these sliders, you can create a wide variety of weaves with any 
one of the patterns supplied.

Editing Weave Colors
Each weave uses its own color set. You can display the color set used for a weave, change the 
colors in the set, and apply them to the weave pattern. Remember that you can tear off palettes to 
see more than one at a time.

To change the color patterns within a weave, you must work in the Edit Weaving window.

Saving Weave Changes
After altering the scaling and thickness or color of a weave, you can save your changes as a new 
weave pattern.



Advanced Weaving 
The Edit button on the Weave Palette opens the Edit Weaving dialog box. This is where you can 
create your own patterns, using Fractal Designs own weaving language.

When you click the Edit button, Painter displays the controls for drafting a weave on Painters 8-
harness, 8-treadle loom. The Edit Weaving window lets you create woven fabrics of virtually any 
description. You can create fabrics for wall papers, carpets, clothes and furniture.

About weaving
A weaving consists of vertical warp fibers and horizontal weft fibers that are interconnected on a 
loom to form a fabric. 

Each warp thread is connected to exactly one harness in the loom. The harnesses are connected 
in a pattern to treadles. Pressing a treadle raises a set of harnesses, lifting the associated warp 
threads. A weft thread is then passed horizontally through the loom. The particular set of 
harnesses that are raised determines which warp threads are in front of the weft thread and which 
are behind. 

For the next weft thread, a different treadle is pressed, raising a different set of harnesses and, 
hence, a different set of warp threads. 

The Tieup
The tieup is an 8 by 8 array that describes which harnesses (on the left) are connected to which 
treadles (across the top). A black cell indicates that the harness is connected for the 
corresponding treadle. A white cell means the harness is not connected.

During weaving, a black cell places the warp thread in front. A white cell places the weft thread in 
front. Only the thread that is in front is visible at that point in the weaving.

You can change the tieup by clicking on the cells, which flip between black and white. 

The Warp and Weft Expressions
The warp and weft expressions (in the panels to the left of the draft design window) use the 
information in the tieup to extend and evolve the weaving into larger and more complex patterns.

In terms of traditional weaving, the warp expression is the threading sequence, and the weft 
expression is the treadling sequence.

Warp
The threading sequence describes which warp threads are connected to which harnesses. 

For example, a warp sequence of 234123 means to...

Connect warp thread #1 to harness #2 
" thread #2 to harness #3 
" thread #3 to harness #4 
" thread #4 to harness #1 
" thread #5 to harness #2 
" thread #6 to harness #3. 
The sequence repeats for subsequent threads.

" thread #7 to harness #2 
" thread #8 to harness #3 



" thread #9 to harness #4 
continuing....

Notice that this threading sequence has a length of 6. This means that the pattern runs for 6 
threads before repeating.

Weft
The treadling sequence determines which treadle is pressed (and therefore which harnesses are 
raised) for each successive weft thread.

For example, a weft sequence of 654 means to...

"Press treadle #6 for weft thread #1.
" #5 for weft thread #2
" #4 for weft thread #3
The sequence repeats for subsequent threads.

" #6 for weft thread #4.
" #5 for weft thread #5
" #4 for weft thread #6

repeating....

Changing the warp and weft
You can change the threading and treadling sequences by editing the warp and weft expressions 
in the weaving draft design window. To simplify the process, Painter allows you to work in a 
pattern expression language. 

For example, 1223334444333221 can be expressed in the pattern language as (1-4-1)[](1-4-1).

The following section describes the weaving pattern language in detail.

Working with pattern representation symbols can be far easier than the number jumble of the 
expanded sequence.

As you create a warp or weft sequence, the Expands to n message above the panel changes to 
give the length n (number of digits) of the expression. This describes the number of threads in the 
sequence.

When Painter cannot resolve the expression, the expansion length is given as ! (infinite).

The Tromp as Writ button copies the warp expression to the weft expression.

Changing thread colors
Both the warp and the weft threads may be colored. You may use one color for all the warp 
threads and another for all the weft threads, or you may set up a sequence of colors. 

The pattern language is recognized for thread color sequences. The colors must be identified 
alphabetically, so you are limited to 26 colors in the weaving.

In the warp and weft color panels, create expressions that describes the color sequences you 
want. Use any letters you like; you can change the associated color later.

Refer to Editing Weave Colors,    for information on editing the colors in the color set.

To open the color set for the weave, click Get Color in the weave edit palette. Painter displays the 
color set. 



In order to see the letters associated with each color, open the Art Materials Palette: Color Sets 
Palette and enable the Display text check box at the bottom left corner.

For example: [B 8 D 4] means to Use color B for 8 threads, use color D for 4 threads.

For example: ABC[]248 expands to [A2 B4 C8]

Getting into the Weaving Pattern Language 

The domain
The Painter Weaving Pattern Language is designed around a group of values, called the domain 
of the pattern. For the warp or weft sequences, the domain is the numbers 1 through 8, which 
correspond to the harnesses and treadles in the tieup. 

Patterns wrap around on their domain. For example, ...5678123... or ...3218765....

Precedence Ordering
When several operators are used in an expression, they are evaluated in order of precedence. 
That is, some operations are performed before others. Where precedence does the wrong thing, 
or where it is unclear, use parentheses to bring out the intended order of evaluation.



Working with Patterns
A pattern is a repeating design. The smallest unit of a pattern is known as a tile. When you fill with 
a pattern, the tile is repeated across the area. Painter saves tiles in separate files and in libraries. 
The program provides you with several patterns. You can create your own pattern tiles.

Patterns are created by repeating a rectangular image tile across the area. Ideally, the images are 
created so that they tile seamlessly. Painter provides several features to help you generate 
seamless tiles.

You can define a file as a pattern so you can paint off the side and your stroke will appear on the 
opposite side of the canvas. Or you can capture the pattern after you create it and manipulate it to 
be a half-drop design, traditionally used in wallpaper design.

When no file is selected as the clone source, the current pattern is used in any operation referring 
to clone source colors or luminance. This means you can paint with the pattern using a Cloner 
brush.

The palette shows a preview of the pattern, gives the dimensions of the tile image (Rows and 
Columns describe the number of pixels horizontally and vertically), and gives you options for 
scaling and arranging the tile in fills.

Rectangular places the tile in a regular grid for fills. The Offset slider does not apply.

Horizontal allows you to offset the tiles in subsequent rows. The Offset slider controls the amount 
of offset.

Vertical allows you to offset the tiles in subsequent columns. The Offset slider controls the amount 
of offset.

When youve set these options, you can use the pattern. To test it, open a new image. (To see the 
tiling, the image must be larger than the tile.) Choose Edit menu> Fill. In the Fill dialog, choose 
Pattern as the art material source.

Check Out Pattern
If the preview isnt enough, you can open the pattern tile in its own window.

In the patterns palette, select the pattern you want to look at.

Choose Art Materials Palette: Pattern menu> Check Out Pattern.

Painter opens the selected pattern tile in its own document window.

You can edit the pattern tile as you would any image. To put the modified pattern back in the 
palette, youll need to use the Add Image to Library feature. If you dont save, Painter will remind 
you that this will replace the pattern you checked out. If this is what you want, click OK.

Creating Patterns
Painter offers three ways to create patterns:

By defining the current image as a pattern and adding it to the pattern library.
By creating a rectangular selection and capturing it as a pattern.
By making a fractal pattern and adding it to the library.

After creating a pattern tile, youll probably want to work with it to improve the way it tiles. See Tips 



for Creating Seamless Tiles,    for tips.

Caution: Creating patterns can become addictive. Its a good idea to keep libraries small. Use the 
Patterns Mover to create new libraries and delete unwanted patterns. You can switch libraries 
whenever you want to use a different set of patterns.

Define Pattern
You can give any image the pattern file characteristics. This will help if you want to create 
seamless tiles. 

Open the image file you want to work with. 

Choose Art Materials Palette: Pattern menu> Define Pattern.

Defining the image as a pattern gives it the pattern tile wrap-around characteristics:

A brush stroke dragged off the edge reappears on the opposite side of the image.
With the Grabber Tool selected, you can hold down the Shift key and drag the seams to 
the center of the image. (For best results, do this at 100% scale, not when youre zoomed 
in.)

If you want the defined pattern in your Pattern Palette drawer, youll need to add it to the library.

Add Image to Library
Open the image you want to add to the pattern library. 

Choose Art Materials Palette: Pattern menu> Define Pattern.

Choose Art Materials Palette: Pattern menu> Add Image to Library. Painter prompts you to name 
the pattern.

Give it a descriptive name and click OK. If a pattern of that name already exists in this library, 
Painter will ask if its okay to replace it. If not, click No and try again with a different name.

Tips for Creating Seamless Tiles
Patterns are created by repeating a rectangular image tile across an area. When you develop 
patterns, youre creating images for tiling. Ideally, the images will tile seamlessly. That is, the eye 
will not be able to distinguish between tiles. Painter provides several features to help you 
generate such pattern tiles.

To help in making seamless tiles, Painter gives documents defined as pattern tiles two special 
characteristics: wrap-around colors and wrap-around seams. 

Wrap-around colors means that a brush stroke dragged off one edge of an image 
appears on the other side. This makes it easy to paint seamless, self-tiling patterns. 

You can even drop floaters on the far edge, half on and half off of the canvas. The portion of the 
floater off of the canvas will reappear on the opposite side. 

The wrap-around seams feature lets you move the edges of the pattern tile to the center 
of the image, where their tonal differences are more apparent and easier to correct.

You can paint over the seams to get wrap around seams.

You might paint out the lines using any color brush or smear across them with a Water or 
Drip brush. 



Floating a copy of a selection and moving it over the line is another good choice. 
Sometimes feathering the floater and reducing its opacity can help produce a clean 
transition. Youll probably want to hide the selection marquee while you work. Drop the 
floater when youre satisfied.

See Also:
Make Fractal Pattern



Make Fractal Pattern
Make Fractal Pattern is a pattern generator that creates interesting landscapes. These 
topographic patterns can be filled with color and embossed with a paper texture.

Choose Art Materials Palette: Patterns menu> Make Fractal Pattern. Use the preview to design 
your pattern.

The Power slider controls the intricacy of the patterns definition, as if you were zooming in and 
out on a textured surface with a microscope. Move the Power slider to the right to zoom out and 
you will see many, smaller patterns. Move the Power slider to the left to zoom in and you will see 
few, larger patterns.

The Feature Size slider defines the number of prominent features within the tile. Move the slider 
to the left to increase the number of repetitions per tile.

The Softness slider adjusts the softness of the edges of the pattern. Size describes the exact size 
of the tile you are creating. If you have a lot of memory, you can make a larger file with a higher 
resolution. 

Channel Options
Painter uses four channels to store graphic information: Red, Green, Blue, and Alpha (or Mask). 
Information other than color values can be placed in these channels as well. The channel options 
allow you to visualize this information in new and different ways. 

Height as Luminance
Height as Luminance displays pseudo-height information as luminance. Images generated with 
this option are useful in conjunction with the Apply Surface Texture feature. White areas are 
represented as peaks, and dark areas become depressions.

You can also create interesting patterns by choosing a colorful gradation and using the Art 
Materials Palette: Grad menu> Express in Image command.

Gradient Bearing
Gradient Bearing uses the Red channel to display the bearing of the down angle of a height field.

Surface Normal
Surface Normal uses the Green and Blue channels to represent the X and Y components of the 
surface normal (angle perpendicular to the surface at a given point) of the height field. (Green=X, 
Blue=Y)

These two latter options for viewing a fractal texture are offered for purely aesthetic reasons. One 
way to take advantage of them is to create color variations of the texture with the Adjust Colors 
feature. Other Effects can lead quite a ways from the original image. 

When you are satisfied with the adjustments you have made to the pattern, as displayed in the 
preview, click OK. 

Wait a moment while Painter creates your new pattern file. When Painter is finished, your pattern 
file will be displayed in its own window. 

The fractal pattern is grayscale. To colorize it, choose an appropriate gradation and use the 
Express in Image feature.





Applying Art Materials
 Art materials, including color, gradations, weaves, and patterns can be applied to your images in 
a variety of ways. Most commonly, you can fill selected areas with the Paint Bucket tool or the Fill 
command. 

Painter also provides a number of special effects methods for using art materials.

Filling an Area
To fill an area with color, gradations, a weaving or pattern, use the Paint Bucket on the Tools 
Palette or the Fill command on the Effects menu. 

When you want to use the Paint Bucket, click its icon on the Tools Palette. Selecting the Paint 
Bucket displays the Controls Palette: Paint Bucket Tool. This palette shows choices for what to fill 
and what to fill with. The current fill is shown on the left of the palette.

Advanced Filling Techniques
The next section gives examples of using the Cartoon Cel fill method. A better understanding of 
masks may help you to follow this discussion, see Selections and Masks for more information.

Using theCartoon Fill Method
The Cartoon Cel fill method is especially good for producing solid fills within sections surrounded 
by anti-aliased lines that otherwise would have white space showing between the color and the 
line. These solid fills are facilitated when you mask lines using Edit menu> Mask> Auto Mask. 
Once your line work is in the mask layer, you fill using the Cartoon Cel fill method. Image sections 
may be refilled infinitely without damage to the line work.

If you are recording your session as a script, Cartoon Cel fills are captured as well. When playing 
back at a different resolution, Cartoon Cel fills (and their limiting rectangles) are properly scaled. 
See Scripting, for information on recording and playing back sessions. For information on limiting 
rectangles, see Leaky Line Work. 

Depending on the color you choose, everything but that color will be filled.

Mask Threshold and Lock-Out Color
The Mask Threshold dialog box appears when you double-click the Paint Bucket Tool. 

The Mask Threshold slider controls how much the Cartoon Cel fill respects the mask. At zero, the 
fill will overrun the mask boundaries. Higher threshold values force the fill to respect the 
boundaries.

When you protect non-black lines with Generate Mask using Image Luminance, the line masks 
are varying levels of transparency. Only black lines receive solid masks. Moving the Mask 
Threshold slider to the right compensates for the transparency of the line mask.

Youll have to experiment with the Mask Threshold slider settings until the fill is limited to the area 
within the line.

If you enable the Lock-Out color option, Painter protects areas that are the same color as the 
color square next to the Lock-Out color checkbox.

Use this feature to lock out the black in a line drawing or when working on detailed art where 
clicking in small spaces is difficult. To avoid accidentally filling the adjacent space, lock its color.

To change the locked-out color, pick another color, then click Set. To turn off locked-out color, click 
the checkbox next to it. 



Leaky Line Work
In complex drawings, the lines dont always meet where they are supposed to. This creates a leak 
that can send Cartoon Cel or contiguous pixel fills into areas where you dont want them--
sometimes even through the whole image.

Sometimes you cant tell if theres a leak just by looking at your image. But if you click in a small 
area and see the prompt, Now Looking for Extent of Fill, there probably is a leak and Painter is 
preparing to fill a bigger area than you had in mind. To abort the fill, press x-. or choose Edit 
menu> Undo (x-Z) if you dont catch it.

Closing the Leaks
When you use the Cartoon Cel fill method, you can fix leaks by hand by editing the lines mask 
with a masking pen or brush.

To hide the red mask, click the first Visibility button.

Tying Up Loose Ends
In typical cartoon line work, open areas--for example, hair, tail feathers, and brush bristles--
sometimes need to be filled. You can use the above techniques to make these items appear to be 
closed off. This technique works only with Cartoon Cel.



Advanced Painting

Customizing Painters Brushes
All of Painters brushes are adjustable in a myriad of ways. In fact, the default variants in the 
Brushes Palette are just saved settings from Painters vast collection of brush controls. 
While these default brushes do excellent work, youll probably want to adapt them to a particular 
need or refine them to you own style. You can change brush size, shape, angle, how color flows 
from it, and much, much more. This section describes the many features for customizing Painters 
brushes.
Changes you make to brush variants, including the basic controls like size and opacity, apply only 
as long as that variant is selected--they disappear as soon as you switch to another variant or 
select a different tool (this ensures that the brushes are clean every time you reach for them). If 
you want to keep the changes, you must save them. Painter allows you to save customized 
brushes as the default variants, as new brush variants, or as Brush Looks.

In this section youll learn...
_ About dabs and strokes (Size, Spacing, Bristle, Rake, Well, Random, Water)
_ Making brushes sensitive to input (Sliders)
_ About brush methods
_ How to use the Brush Look Designer
_ How to save custom brush variants (and how to modify the default variants)
_ Captured brushes
_ Creating new brushes and managing brush and looks libraries

See Also:
Brush Controls
Size Palette
Spacing Palette
Random Palette
Bristle Palette
Rake Palette
Well Palette
Water Palette
Sliders Palette
Brush Methods
Using the Brush Look Designer
Saving, Restoring and Deleting Brush Variants 
Capturing Brushes
Creating a New Brush
Brush and Brush Looks Libraries



Brush Controls
Although brush strokes appear as a continuous swatch of color, they are actually created by 
laying down a series of closely spaced individual dabs. Painter lets you control both the dab 
shape and the way its repeated to create the stroke. 

Controls of the dab are located primarily on the Size and Bristle Palettes.
 
Controls for the stroke are located primarily on the Spacing and Rake palettes.

The Well palette controls the medium (usually color) that flows from the brush. 

The Random palette has one control for the stroke and several for the medium.

The Water palette has special controls for brushes of the wet method (water color).

The Sliders palette can be used in many ways to affect the dab, stroke, and medium.



Size Palette
The Brush Controls: Size Palette accessed from the Brushes Palette: Controls menu lets you 
control the brush width and tip. Its here that youll sharpen your pencils. 

Preview
The Preview Window in the center of the palette shows how your changes affect the brush dab. 
Clicking in the Preview Window lets you toggle between hard and soft views of the dab. 

In the hard view, concentric circles show the minimum and maximum size of a brush. The inner 
(black) circle shows the minimum dab width. The outer (gray) circle shows the maximum dab 
width. Remember that some brushes vary the line width based on pressure or stroke speed. The 
difference between the diameter of the two circles shows the range in which the stroke width will 
vary. 

In the soft view, shading shows the density distribution of the brush tip. The density distribution 
describes how much of the medium is conveyed by a given point on the brush dab. For example, 
an individual pad made by an airbrush produces a soft-edged circular mark with minimum density 
at the outer edge of the pad. Density increases inward to a maximum value at the exact center of 
the pad.

Brush Tips
The brush tip profile shows a cross section of density distribution across the diameter of the dab. 
You can think of a brush tip profile as a bell curve graph representing the density spread across 
the brush pad. 

Different mediums have different density distributions. Changes in the density distribution produce 
different marking qualities in a brush stroke.

To change the density distribution, click the icon for the brush tip profile you want.

Pointed profile
Pointed profile provides maximum density at the center with rapid fall-off to the edge.

Medium profile
Medium profile has a wide area of greater density at the center with rapid fall-off to the edge.

Linear profile
Linear profile provides maximum density at the center with an even fall-off to the edge.

Dull profile
Dull profile provides maximum density at the center with a high density weighting to the edge.

Watercolor profile
Watercolor profile provides maximum density at the outer edge in a ringlike fashion with medium 
internal density.

1-Pixel Edge
1-Pixel Edge provides maximum density throughout with a rapid fall-off at the edge, producing a 
one-pixel, anti-aliased edge.

Size 
The Size slider controls the width of the brush dab and, therefore, the brush stroke. Moving the 
slider to the right makes a brush wider. Moving it to the left makes it narrower.

You dont need to open the Brush Controls: Size palette to adjust the size of a brush. Use the 
brush sizing shortcut: Hold down the x-Option keys and drag in the document window. A circle 
that represents the brush diameter appears beneath the cursor. When youve dragged the circle to 



the size you want, release the button. In some cases, the brush must be built. Press x-B to build 
the brush. If you try to paint with an un-built brush, Painter will alert you.

±Size
The ±Size slider controls the difference between the minimum and maximum width of a stroke. 
Remember that some brushes vary the line width based on pressure or stroke speed. The 
difference between the diameter of the two circles shows the range the stroke width will vary. 
Moving the slider to the right increases the difference between the narrowest and widest portions 
of a stroke.

Size Step 
The Size Step slider controls the transition between the narrow and wide sections of a stroke. 
Moving the slider to the right makes the transition appear more abrupt. Moving it to the left makes 
the transition smoother.

Build 
When you finish making changes on the Brush Controls: Size Palette, you may need to click Build 
(if the button is raised and highlighted) to create the brush shape. Pressing x-B or choosing 
Brushes Palette: Brushes menu: Build Brush types also builds the brush.
Relax, some brushes may take a little while to build--especially if youre working on a slower PC. 
Larger dab and ±Size values increase build time.

Adjusting the Angle
Expand the Brush Controls> Size Palette by clicking the grow box in the upper right corner. The 
Angle Control sliders and Dab Type buttons appear.

Squeeze
The Squeeze slider controls the shape of the brush dab. Squeezing a brush changes it from 
round to elliptical. Moving the slider to the left makes a dab more elliptical and moving it to the 
right makes a dab more round.
Squeezing and angle control are not valid for Bristle and 1-Pixel dab types. 

Angle 
The Angle slider controls the angle of an elliptical brush dab. Moving the slider to the right rotates 
the dab clockwise. Moving the slider to the left rotates the brush counterclockwise. 
The angle describes the length of the ellipse. 

Ang Rng 
The Angle Range slider lets you specify a range of dab angles that may appear in a brush stroke. 
Setting this slider to 180_ means you can get every angle between 0_ and 180_ in your stroke.

To take advantage of this feature, youll need to set up the brush to base the angle on some 
factor, like stroke direction or randomness. Youll do this in the Sliders palette.

Ang Step
The Angle Step slider controls the increment of change for brushes with an Angle Range greater 
than 0_. For example, setting the Angle Step to 5_ means that you get a brush dab every 5_ 
within the current angle range setting. Moving the slider to the right results in fewer brush dab 
angles. Moving the slider to the left creates more brush dab angles. 

Dab Types
Brushes use one of the following dab types: Circular, 1-Pixel, Bristle, or Captured.

Circular
Circular dabs are controlled by the Size Palette. 

1-Pixel
A 1-Pixel dab consists of one pixel. You cant change its size. Youll use 1-pixel brushes mostly 



when you zoom in to edit at the pixel level.

Bristle
Bristle dabs are controlled by the sliders in the Brushes Palette: Controls menu: Bristle Palette. 
When you select Bristle Dab, the soft view of the Preview Window on the Size Palette displays a 
Bristly dab. 

Captured
Captured dabs are dab shapes that you create and capture with Brushes Palette: Brushes menu> 
Capture Brush. 
You can choose the dab type for a variant youre creating at the bottom of the expanded Size 
palette.



Spacing Palette
A brush stroke is created with a series of dabs. By adjusting the spacing between dabs, you can 
control the continuity of the brush stroke. 

Spacing/Size 
The Spacing/Size slider controls the distance between the brush dabs in a stroke. When the 
Spacing/Size slider is at 100%, the size of the dab equals the spacing. For example, a dab thats 
10 pixels across is repeated every 10 pixels. As the Spacing/Size slider is moved to the left, the 
distance between dabs is less and they begin to overlap. Overlapping increases the density of the 
stroke and makes it look more continuous.

Min Spacing 
The Minimum Spacing slider specifies the minimum number of pixels between dabs. If you dont 
want a continuous stroke, move the Minimum Spacing slider to the right. In this way, you can 
create a dotted or dashed line. Each dot or dash is made by one brush dab.

Stroke Types
Expanding the Brush Controls> Spacing Palette reveals the Stroke Types buttons. The Bristles 
slider, at the bottom of the palette, controls the number of dabs used for Multi-stroke and Rake 
brushes.

Single
A Single stroke brush has one dab path. 
You can use Bristle and Captured dabs with the Single stroke option to create the effect of 
multiple bristles. 

Multi
A Multi-stroke is made by dragging a set of randomly distributed dabs. The several dabs leave 
strokes that are not parallel, and they may overlap. Each time you apply a multi-stroke brush, the 
result may differ.

Each stroke in a Rake or Multi-stroke brush can have a different color. Increase Color Variability 
on the Art Materials> Color Palette to color the strokes differently.

Multi-stroke brushes must be precomputed, which generates a delay in their appearance on the 
screen. Because of this delay, Multi-stroke brushes, such as the Van Gogh brush, work best when 
you apply them in short strokes.

Rake
A Rake stroke is made by dragging a set of evenly distributed dabs. The several strokes in a rake 
brush are parallel. All other rake control is done with the Brushes Palette: Controls menu> Rake 
Palette. 

Hose
The Hose is a single stroke composed of the current Image Nozzle file. See Image Hose to learn 
more about the Image Hose and Nozzle files.

Bristles
The Bristles slider controls the number of bristles or dabs used for Multi-stroke and Rake brushes. 



Random Palette
Painter uses randomness to introduce an accidental quality in color and stroke. Randomness 
contributes to the appealing, unique look of artwork done in Painter. You can control brush 
randomness with the Random Palette. 

Randomness of the primary color is controlled from the Art Materials> Color Palette. 

Dab Location Placement
The Dab Location Placement slider introduces a randomized jitter to the brush stroke. Instead of 
appearing directly along the stroke, dabs appear randomly outside the brush stroke path. Move 
the slider to the right to increase deviation from the stroke path.

Clone Location
The two Clone Location sliders work with brushes of the Cloning method. 
A cloning brush takes color information from a source image and applies it to a destination image. 

One of the popular uses for cloning is translating a photographic image into a painted image. The 
type of brush you use determines the paint medium.

Variability 
When Variability is zero, the pixels of the source and destination images correspond precisely--
using a cover brush at full opacity (and no grain) will simply recreate the source image.

Introducing a degree of randomness disturbs the pixel-to-pixel correspondence. The resultant 
variations in the image distance of the clone from its photographic source, which can contribute to 
the natural media appearance.

The Variability slider lets you randomly offset the location where the clone brush samples the 
source. Moving the slider to the right increases the range (distance) the sample may be offset. 

How Often
The How Often slider controls the period between random offsets. Moving the slider all the way to 
the left sets the period to zero--every sample is offset. This gives the clone image a rough, 
distorted look. 

Moving the How Often slider to the right increases the period--samples are offset less frequently. 
This keeps the clone image closer to the source.

Random Brush Stroke Grain
Normally, when you make a brush stroke, the paper grain is fixed--the bump areas will always be 
bumps. Strokes repeated over an area will bring out the same grain.
The Random Brush Stroke Grain option randomizes the paper grain beneath the brush. The 
Spatter Airbrush is an example of Random Grain brush. 

Random Clone Source
Random Clone Source randomly samples the source document. Theres no correspondence 
between the samples taken from the source and where they are placed on the clone. The result is 
a random pattern of the predominant colors in the source. The brush and stroke determine the 
nature of the pattern. 

You might use Random Clone Source with a faint, stipple brush to add noise to an image. In this 
case, the clone source image merely contains the noise colors you wish to add.



Bristle Palette
Bristles recreate the look of a real brush, complete with the striations that hairs on a real brush 
make. Use the sliders on the Bristle Palette to design the many individual painting tips in a single 
brush dab. 

To see the effect of the Bristle sliders, keep the Size palette open. Click in the preview window to 
show the soft view of the dab. The bristled dab changes as you move the sliders.

Thickness 
The Thickness slider controls the diameter of the separate bristles. 

Moving the Thickness slider to the left reduces the density of the medium left by the stroke. When 
the slider is fully to the left, the brush will leave a faint stroke--even if Opacity is 100%.

Clumpiness 
The Clumpiness slider applies a random proportional variance across the bristles. This produces 
an effect that looks like some of the bristles have clumped together. 

Hair Scale 
The Hair Scale slider controls the density of bristles in the brush dab. If you want a fine-hair 
brush, move the Hair Scale slider left. 

Scale/Size 
The Scale/Size slider controls the degree of size variation applied to a bristle set. At 0% there is 
no size change applied to the bristle set. Setting this slider to a value greater than 0% creates a 
set of scaled iterations of the bristles dab. 

The Scale/Size control is invalid if the Size Palette is set at the minimum value of 1.00. 



Rake Palette
The Rake palette lets you control the sophisticated features of the Rake stroke. maintains the 
angle of the brush head as the stroke changes direction. As the brush turns, bristles come in and 
out of contact.

The number of dabs in the rake brush is set in the Spacing palette. 

Contact Angle 
The Contact Angle slider adjusts how much of the brush touches the painting surface. Moving the 
slider to the left creates a low contact angle--few of the dabs are in contact with the paper. 

Moving the slider all the way to the right creates a high contact angle--all of the dabs contact the 
paper.

Brush Scale 
The Brush Scale slider controls the spacing between the individual dabs that comprise the Rake 
(the size of each dab is determined in the Brushes Palette: Controls menu> Size Palette). 

When the scale is 100%, the stroke width equals the dab width times the number of dabs. When 
the scale is less than 100%, the dabs overlap. Overlapping dabs create a natural, subtle stroke 
when used with Turn Amount and Soften Bristle Edge.

Turn Amount 
When you turn a real brush to paint a curve, bristles at the edges move in and out of contact with 
the painting surface, depending on the brushs location on the curve (inside or outside). The Turn 
Amount slider simulates this bristle displacement. As the turn amount increases, the rake bristles 
displace changes based on the direction of the brush. 

Spread Bristles
The Spread Bristles option dynamically adjusts the brush scale based on pressure. The harder 
you press, the more the brush fans out. 

Soften Bristle Edge
This option makes a brushs outer dabs semi-transparent. This option is particularly nice when 
used with Turn Amount.



Well Palette
The Well Palette controls how a brush conveys its medium (color) to the paper. The Resaturation, 
Bleed, and Dryout controls work together to determine how much color a brush has at the start 
and finish of a stroke. 

To understand Well, open the Brush Look Designer. Make a stroke then watch it update as 
adjustments to Well are made.

The Well has no effect on brushes that smear existing color, like the Eraser and Liquid.

Resaturation
Resaturation controls the amount that color is replenished in a stroke. If Resaturation is zero, the 
brush will never get any color. When Resaturation is below 10% (and Bleed is less), the brush 
stroke fades in gently.

Bleed 
The Bleed slider controls how much the brush colors mix with the underlying colors--including the 
paper color. Moving the slider to the right increases the extent of bleed. 
When Bleed is higher than resaturation, more color bleeds than covers, so the stroke will never 
reach full opacity.

Dryout 
The Dryout slider determines how quickly a brush runs out of its medium. Dryout is measured in 
pixels. Moving the slider to the left makes a brushs reservoir empty more quickly. This can lead to 
brush strokes that fade out gently.

When the slider is set to the far right, the brush never runs out of color. 

Dryout works in conjunction with Bleed, so Bleed must be above zero to take advantage of 
Dryout. You can modulate the Dryout effect by changing the Bleed setting. Use the Brush Look 
Designer to see the results of different Bleed/Dryout settings.



Water Palette
The Water Palette works with Painters wet layer. The wet layer adds a color layer to an image 
that allows for transparent washes of color without overwriting the underlying image.

Diffusion
Diffusion controls the amount a stroke spreads out and blurs. High diffusion creates wonderful, 
soft edges that feather into the grain. In terms of natural watercolors: low Diffusion is like painting 
on dry paper, and high Diffusion corresponds to painting on wet, absorbent paper. 

You can post-diffuse the wet layer by selecting the area you wish to diffuse further and hitting the 
Shift-D keyboard shortcut. Repeat the command until youre satisfied with the result.

Wet Fringe 
Wet Fringe controls the pooling of colors. When you paint with the Water Color variants, youll 
notice that color collects at the edges of the stroke. This follows the behavior of natural 
watercolor. 

By adjusting the Wet Fringe slider you can control the amount of color at the edge for all strokes 
in the wet layer. You cant adjust pooling after you dry strokes. 
Watch the edges of your watercolor strokes darken as you drag the slider to the right. To minimize 
pooling, move the slider to the left. 

To get different pooling amounts for individual strokes: Adjust the Wet Fringe slider for one or 
more strokes, then dry them. Paint more watercolor strokes, and adjust the Wet Fringe slider 
again. 



Sliders Palette
The Sliders palette lets you control brush effects based on a number of input factors. For 
example, many brushes vary their opacity or width in response to changes in stylus pressure. 
This is merely their default setting. You can use the sliders to vary these effects in response to 
other factors, like stroke direction or velocity. This is the kind of modification youll want to make if 
youre using a mouse to draw with and dont have access to pressure information. 

But the sliders have far more interesting and sophisticated uses. For example, you can base dab 
angle on the clone source. See Size Palette for information on dab angles and setting the Angle 
Range. See Cloning and Tracing for information on cloning. This is particularly interesting when 
the stroke has enough spacing to separate the dabs. As you stroke the brush in the clone 
document, Painter sets the dab angle based on luminance of the Source (for a shortcut, record a 
stroke and use Auto Playback). The dabs look like paint strokes that are contoured to the image.

The Sliders palette is set up as a matrix. Drag the slider for one of the eight main brush 
components to link it to one of the eight control factors. 

Control Factors

Random
Random adjusts the component at random.

Source
Source adjusts the component based on the luminance of the clone source. Higher luminance 
(closer to white) increases the setting for that component--for example, a wider stroke. 

If you set a component to source, but the brush effect is opposite of what you want; invert the 
source image. Choose Effects menu> Tonal 
Controls> Negative. 

Bearing
Bearing adjusts the component based on the direction in which the stylus points. Not all stylus 
models convey this information. 

Tilt
Tilt adjusts the component based on the angle of the stylus from the tablet. Not all stylus models 
convey this information.

Pressure
Pressure adjusts the component based on stylus pressure. Greater pressure increases the 
setting for that component.

Direction
Direction adjusts the selected brush component based on the direction of the stroke.

Velocity
Velocity adjusts the component based on the dragging speed. Dragging quickly minimizes the 
setting. Dragging slower increases it.

None
None applies no adjustment to the component.

Brush Components

Size
The Size slider determines how Painter should vary the width of the brush stroke. The range from 
minimum to maximum is determined by the ±Size control in the Brushes Palette: Controls menu> 



Size Palette. The most common source for size variance is Pressure. The Scratchboard Tool is a 
good example of a brush with Size based on Pressure.

Jitter
The Jitter slider determines when (how often) Painter should jitter the brush stroke. The amount 
of jitter is controlled by the Dab Location Placement slider on the Brushes Palette: Controls 
menu> Random Palette. A typical source for controlling jitter is Velocity. Jitter will reduce as the 
brush speeds up.

Opacity
The Opacity slider determines how Painter should vary the density of the medium. The Opacity 
slider in the Controls Palette: Brush Tool will establish the maximum opacity of the brush. The 
opacity of the Airbrush is determined by pressure. More pressure yields more opaque strokes. 

Grain
The Grain slider determines where Painter should reveal paper texture in a brush stroke. The 
Grain slider in the Controls Palette: Brush Tool sets the maximum amount of grain in the brush. 
The Colored Pencil variant has its Grain component determined by pressure. Increasing pressure 
causes the pencil to dig into the paper. 

Color
The Color slider determines where Painter should use the primary or secondary color. You can 
create a duotone effect by setting color to Original Luminance and painter into a clone. The color 
of the brush will be determined by the light and dark areas of the source.

Angle
The Angle slider determines how Painter orients the brush dabs. The Ang Rng setting in the 
Brushes Palette: Controls menu> Size Palette must be greater than 0.0 and Squeeze must be 
less than 100% in order for brush angles to vary. The Impressionist and Oil Pastel variants will 
change dab angles based on the direction of the stroke. 

Resat
The Resaturation slider determines how Painter controls resaturation--how much color is 
replenished in a stroke. Resaturation amount is set in the Brushes Palette: Controls menu> Well 
Palette. When used in conjunction with Bleed, setting the Resat component to Pressure can 
create a brush that behaves like a drying Sharpieô.

Bleed
The Bleed slider determines how Painter controls bleed--how much colors mix. Bleed amount is 
set in the Brushes Palette: Controls menu> Well Palette. When used in conjunction with Resat, 
setting the Bleed component to Pressure can create a brush that behaves like a drying Sharpieô.



Brush Methods
The brush method describes the basic nature of a brush. All of the many brush control settings 
flow through the method to determine the brush effect. 

The Image Hose has a unique method.

Understanding the methods and being able to vary them gives you more options for creating new 
brushes or editing existing ones. For example, some brush controls and effects are invalid under 
certain methods, so by changing the method, you can radically alter a brush.

To display the methods, click the grow box in the upper right of the Brushes palette. You can 
change the method category and variation by using the pop-up menus.

There are seven method categories:

Buildup
The Buildup methods produce brush strokes that build toward black as you overlay them. Felt 
Pens are an example of buildup brushes.

Cover
The Cover methods produce brush strokes that cover underlying strokes. Chalk is an example of 
a cover brush.

Eraser
The Eraser methods either erase, lighten, darken, or smear the underlying colors.

Drip
The Drip methods interact with the underlying colors to distort the image.

Mask
The Mask methods paint directly into Painters masking layer. Masking is covered in detail in 
Selections and Masks.

Cloning
The Cloning methods take a clone source and re-create it in another medium. 

Wet
The Wet methods work in the wet layer to produce watercolor effects.
Each method category is further divided by its variations. The following terms are used in 
describing the variations:

_ Soft methods produce smooth, anti-aliased strokes.
_ Flat methods produce strokes with hard, pixellated edges.
_ Hard methods provide brush strokes with semi-anti-aliased edges 

In a few instances, youll see the words edge and variable in a method. Edge means strokes are 
thick and sticky looking. Variable means a brush stroke starts off a bit more transparent.

Last, theres grainy. It means the brush reacts to the paper grain.

So putting together the method categories and their variations results in the specific brush 
methods. For instance, Grainy Hard Cover means that brush strokes interacts with paper grain 
and have semi-anti-aliased strokes that hide underlying ones. Grainy Hard Cover is the default 
method for Chalk and Charcoal.



Changing Methods
Its good to know how to juggle methods. Lets say you want a Charcoal-looking stroke, but instead 
of hiding underlying strokes, you want brush strokes to muddy to black. you can get this effect by 
changing the method to Grainy Hard Buildup. 

Now lets say you want a smoother, anti-aliased stroke. Change the method to Grainy Soft 
Buildup. The stroke still isnt quite right--you dont want to see paper texture. So you choose the 
Soft Buildup variation. Your stroke has smooth, anti-aliased edges and turns builds to black. Soft 
Buildup is the default setting for Medium Tip Felt Pens. You can change the method category and 
variation by using the pop-up menus. 



Using the Brush Look Designer
You dont need to use the Brush Look Designer to customize and save brushes. If you prefer, you 
can adjust controls, then draw in your document to see their effect. The Brush Look Designer isnt 
necessary for adjusting brushes, but it does make the job easier. 
From the Brushes Palette, choose Brushes Palette menu> Brush Look Designer. The Brush Look 
Designer window appears with a sample brush stroke on the scratchpad.
You can change backgrounds by clicking the boxes at the bottom of the window. For example, 
use the striped background to see the smear of drip method brushes. If youre working on an 
eraser, you wont see its stroke on the white background. Use a colored or striped background 
instead.

To change the background color, select a color on the Art Materials> Color Palette, then click the 
Set Colors button on the Brush Look Designer window. 
Use the features described here to customize the brush. You dont necessarily have to know what 
a slider does. Just try it. If you like the result, keep it. If not, set it back to where it was.

You might want to draw strokes on the scratchpad to test the feel of your brush.
Most of your changes show up on the Brush Look Designer scratchpad right away. To see 
changes you made on the Brushes Palette: Controls menu> Size Palette, however, you must first 
click Build or press x-B. 

No matter what changes you make, you can restore the default values by momentarily switching 
to another tool or variant. 

Brushes have a great number of options. Some have meaning only in conjunction with certain 
others. Eventually, youll find a control that doesnt seem to do anything. Such a control relates to a 
different brush type or is significant only when some other control is in a different position. 

When youve got the brush variant working the way you want it, you can save it as a Brush Look 
(see below) or click Done to close the Brush Look Designer. You must close the Brush Look 
Designer before you can save the variant.



Saving, Restoring and Deleting Brush Variants
When youve customized a brush the way you like it, you can use it immediately. Unless you save 
them, changes you make to brushes disappear as soon as you switch to another variant or brush. 
If you want to keep a brush, save it--either as a variant to an existing brush, a variant to a new 
brush or a brush look. These three options are called: Save Variant, Save Built Variant and Save 
Brush Look.

Save Variant
This command creates a new variant under the current brush category. For example: You started 
with the Pencil brush and modified it to resemble a grease pencil. Choose Brushes Palette: 
Brushes menu> Variants> Save Variant and Painter opens a dialog where you can name the 
variant Grease. From now on, youll find your Grease Pencil alongside Painters default Pencil 
variants.

Save Built Variant
This command saves your changes to the current variant. This is the command youll use to 
modify Painters default variants. For example, you might decide that the Oil Paint brush variant is 
too big. Select it and modify the brush size. Choose Save Built Variant. From now on, youll find 
the Oil Paint variant as you defined it.

Restore Default Variant
To return the current variant to the factory settings, choose Brushes Palette: Brushes menu> 
Variants> Restore Default Variant.

Delete Variant
To Delete the Variant, choose the variant from the Variant pop-up menu.    Choose Brushes 
Palette: Brushes menu> Variants> Delete Variant. Painter asks you to confirm that you want to    
delete the variant. Click Yes to delete the variant.

Save (Brush Look)
This command is available on the Brush Look Designer window. A brush look is a variant that has 
a paper texture attached to it. A variant does not know about texture. A particular variant will have 
different behavior on different paper textures. The Brush Look, on the other hand, associates a 
particular texture with the particular variant to save a look. Regardless of a documents current 
paper texture when you select a Brush Look, you will be using the texture thats part of that look. 

The content of the scratchpad becomes the icon of this Brush Look in the Looks palette. This is a 
handy visual reminder of what this Brush Look does.

In the case of the Image Hose brush, the brush look may have a particular Nozzle file attached. 
See The Image Hose, for more information on working with the Image Hose and Nozzle files.



Capturing Brushes
You can create your own brush shapes. Any brush shape is possible. 



Creating a New Brush
You can add your own brush categories to Painters Brushes Palette. You might want to create a 
brush if youve customized a medium and you wanted to keep its tools organized. Your new brush 
will appear at the same level as Pencil, Chalk, Crayons.
When you create a new brush, it starts with zero variants. The first thing youll want to do for your 
new brush is to create and save some variants to it.

If the variants you want for this new brush already exist--but under other brush categories--you 
can use the Brush Mover to bring them in. 

For efficiency on systems with limited RAM, keep brush libraries small. Painter will be more 
efficient if you store the brush variants you create into several libraries. When you want to use 
these special brushes, load the alternate libraries.



Brush and Brush Looks Libraries
A library is a saved collection of similar tools. For example, Painters built-in brushes (and their 
variants) are contained in the default brushes library. Brush Looks are stored in a different library.

You can create new libraries for brushes and brush looks and add your custom brushes to them. 
You can create as many brush libraries as you want, but only one will be open at a time.

Its a good idea to limit the number of tools in a library. This makes it easier to find a particular tool 
and helps Painter manage memory.

Brushes are loaded into memory when you launch Painter, so adding brushes to the default brush 
library increases Painters need for RAM. If you are working close to the memory threshold, youll 
want to organize new brushes into secondary libraries. When you want a different brush set, 
switch libraries. This will help Painter be efficient with memory.

Accessing Default Brush and Brush Looks Libraries
The Brush Library is contained in the Brushes Palette. To access one of Painters default Brushes, 
simply click a brush on the drawer face or open the palette drawer and click a brush.

The Brush Looks Library is found under the Brushes Palette menu. Select Brushes Palette: 
Brushes menu> Brush Looks and the Brush Looks portfolio appears. Once the portfolio is open, 
click a brush look and paint on the canvas.

Switching Libraries
You can create as many different libraries as you like, but only one (of each type) can be open at 
any time. When you want to work with a different set of brushes or Brush Looks, open its library.

Creating New Libraries
Use the Brushes Palette: Brushes menu> Brush Mover command or the Brushes Palette: 
Brushes menu> Brush Look Mover command to create a new library. 
The Brush Mover or Brush Look Mover lets you manage the contents of the library by moving 
existing brushes into it and deleting brushes from it. 

If you want to rename a selected brush or Brush Look, click Change Name. In the dialog box that 
appears, type the new brush or Brush Look name and click OK or press Return. When Painter 
asks if youre sure you want to change the name, click Yes.

If you want to change the current picture in the Brushes Palette for the selected brush, select the 
image you want for the new picture before you open the Brush Mover. Then click Change Picture 
to replace the brushs current picture. When Painter asks if youre sure you want to change the 
picture, click OK or press Return.

If you want to delete a selected brush or Brush Look, click Remove. Be careful. If you remove one 
of Painters default brushes by mistake, the only way to retrieve it is to reinstall Painter. When you 
reinstall Painter, youll lose any of the custom variants, brushes, or Brush Looks, or you created.

If you want to move a brush or Brush Look to another, existing library, click Close to close the 
open library on the right-hand side of the dialog box. Then click Open. Locate the library you 
want, click it, and click Open or press Return. Then follow the earlier instructions for moving a 
brush or Brush Look.

When you have finished making changes in the dialog box, click Quit or press Return.
To delete a library, use the Windows 3.1 File Manager or Windows 95 Explorer.



Digital Video and Animation
Painter offers a number of cool features that give you the power to work with video and create 
animations. Among the special features are onion skinning and rotoscoping. Onion skinning is a 
feature for animators. Rotoscoping is the ability to paint on and apply effects to existing movies. 
Painters controls allow you to clone, trace, edit and composite movies.

Video
Painter offers certain ways of working with video that other Video for Windows applications dont. 
You can use any of Painters brushes, textures, and effects to modify a Video for Windows movie. 
You can paint directly into video frames, you can clone video using Natural-Media, and you can 
composite portions of one video clip with another.
When you open a Video for Windows movie, Painter automatically converts it to a frame stack. 

Painter does not provide features for working with audio.

When youre finished with the movie in Painter, you can save it as a Video for Windows file. You 
can then open the Video for Windows movie in a video-editing application, like Adobe Premiere or 
Avid VideoShop, where you can add sound effects and other finishing touches.

Animation
Painter has powerful features that simplify animation and help you get the best quality possible. 
You can use Painters Natural-Media tools to create your own animations with a traditional look. 
Onion skinning allows you to see multiple frames at the same time. In Painter, you can view up to 
five frames at a time, the current frame and four other frames adjacent to it. This will help you 
determine where the next frame of motion should be drawn. You can play back your animation 
over and over as you create it, to be sure you have the correct flow of movement.

Movies and File Size
Before making movies, understand that video and animation can produce huge files. When 
planning a project, be careful that you dont over-estimate your available disk space. To get an 
idea of disk requirements, consider this example: Each 640 x 480, 24-bit color frame is 1.2 MB. At 
this size, a 12 fps, 30-second animation would consume more than 400 MB of disk space. 

You can calculate the disk space required for a frame stack as follows:

(Frame Width) x (Frame Height) x (Bytes per Pixel) x 
(Frames per Second) x (Seconds) = Bytes required to save the frame stack

Divide by 1024 to convert to kilobytes.
24-bit color with an 8-bit mask is 4 bytes per pixel.

When a movie is saved as Video for Windows, the file size may be reduced by compression. 
For example, the movie created in the animation tutorial is 4MB as a frame stack. 

See Also:
Navigating through a Movie
Onion Skin
Modifying Existing Movies
Animating from Scratch
Frame Rate and Animations In Painter
Examining a Typical Animation Project 
Automatic Masking and Scripting for Efficiency



Navigating through a Movie

The Frame Stacks Palette
In Painter, digital video and animation files are called movies or frame stacks. Whether youre 
working with imported video or building a new animation, the tools youll use are the same. Theyre 
found on the Frame Stacks palette and on the Movie menu.

Painters frame stack format is a series of images, each equal in size and resolution. The Frame 
Stacks Palette appears whenever you open or create a movie file. The Frame Stacks Palette 
must stay open while you work with a movie.

Youll work in one frame at a time--the one appearing in the Image Window. The Frame Stacks 
Palette helps you navigate the images in the stack and choose which frame to modify.

You can modify all frames in a stack with a single command by applying a recorded script to the 
movie. See Rotoscoping for tips on applying scripts to a movie.

The Frame Stacks Palette displays thumbnails of several frames. The frame numbers appear 
under the thumbnails. The current frame is shown with a red triangle over it. 

The number of thumbnails is determined by the layers of onion skin youve chosen. By default, 
Video for Windows files are opened with two layers of onion skin. More information on onion skin 
appears later in this section.

You can select a particular frame by clicking its thumbnail.

To jump to a particular frame, choose Movie menu> Go To Frame and enter the number of the 
frame you want. 



Onion Skin

Traditional cartoon animators work on an onion-skin paper that allows them to see a sequence of 
frames through the transparent layers. They then draw successive frames using the previous 
frames for reference. Seeing the several images superimposed helps in incrementing the action 
evenly.

Painter allows you to work in two to five layers of onion skin. You select the number of layers 
when you open a frame stack.

To use the onion-skin feature, simply turn on Tracing Paper. 

In the image window, the current frame appears darkest. Each frame moving away is 
progressively fainter. 

The Frame Stacks Palette displays a linear view of the onion-skin layers. Each thumbnail 
represents one onion-skin layer, and the thumbnail of the current frame has a red triangle above 
it. 

You may view with the current frame in any position of the onionskin sequence. Use the controls 
on the Frame Stacks Palette to set the onion-skin layers.
 
For example, if you want to display the reference frames before the current frame, set the current 
frame to the far-right position in the palette. If you want to display the frames before and after the 
current frame, set the current frame to the middle thumbnail in the palette.



Modifying Existing Movies

Rotoscoping
Rotoscoping is the process of painting on a movie or compositing a portion of the images from 
one movie with the images of another. This is often done to put the action of a person filmed in 
one place on a background filmed in another. You can also use rotoscoping to remove an element 
from a video clip. As an example, we made a short movie of paint pouring from a Painter paint 
can.
We filmed the pouring sequence against a white backdrop. After capturing the video digitally, we 
imported it into Painter and removed the hands frame by frame using Painters masking tools. We 
then replaced that area of the image with a frame containing the empty background. Play the 
movie, Pour it on, with the mask turned on. Youll see exactly where the hands were.
Rotoscoping is also useful for adding the background to animations created in Painter. The 
process is the same whether youre working with digitized video or painted animation cels. 

Creating an Animation
An animation is a series of drawings with progressive change. When viewed in rapid succession, 
they create a moving image.
Because Painter has its full complement of Natural-Media tools and effects available for each 
image in a frame stack, its an extraordinary program for creating original animation. 
Painter offers several methods to create animations:

_ By cloning from video using any cloning brush
_ By tracing over video
_ By manipulating floaters
_ By drawing each frame by hand
_ By recording a script and playing it back into a frame stack.

Each method has advantages--and limitations. Complex animations will use a combination of 
methods. The following sections explain the methods and discuss the advantages and limitations 
of each.

Animations Based on Movies
Cloning from one movie to another is almost exactly like cloning from one image to another. The 
only difference is that you must identify to Painter that you want to clone from one sequence of 
frames to another sequence of frames. In this case, by advancing one frame in the clone frame 
stack, Painter automatically advances one frame in the source frame stack.
If you have a Painter movie open and you choose File menu> Clone, Painter will create a clone 
only of the frame in the image window. 
For information on cloning brushes, see Cloning and Tracing.
You can control the areas cloned by setting up a mask in the clone movie. See Selections and 
Masks for complete information on masking techniques.
When youre finished cloning in one frame, advance to the next one. Painter automatically 
advances the clone source to maintain the correspondence. 
You can use AutoClone to do the cloning. You also can record an AutoClone script and apply the 
script to the new movie with a Cloners brush selected.

Tracing a Movie
Have you ever wanted to animate your own cartoon but didnt know where to start? Painters 
Tracing Paper option makes it possible to trace the contents of a movie into a brand new 
animated feature. This is particularly useful with video as the source.
For best results, the source should have the same frame rate you intend for the animation. See 
Frame Rate, a matter of timing, in this section, for more information on frame rates.

Animating Floaters
The simplest animation you can create in Painter is by moving a floater across a series of frames.



You can group floaters and move them together, but be careful. As soon as you leave a frame, 
the floaters in it are dropped and the changes are saved. For this reason, you want to work from 
the background forward. (Start by animating whats farthest from your point of view.)

The more you work with floaters, the more creative ways youll find to animate them.    Create a 
Floater Library for the project. For sophisticated animations, create a library of body parts and 
gestures for each character. This will help you manage the multitude of floaters with which youll 
be working.



Animating from Scratch

A more challenging animation technique is to draw each frame by hand. At 10 to 12 frames per 
second, the prospect may be daunting. Fortunately, you can harness some of Painters digital 
power to pull you through.

Cloning, masking, the Image Hose, tracing paper, onion skin, record/playback stroke, 
record/playback script, and floaters can all be used as shortcuts in the animation process.

Duplicating a Cycled Action
A blinking eye is an example of an action that cycles. You want only to draw the cycle once, then 
duplicate it as many times as needed. 

The beginning and ending images need to be the same--for example, the eye in the open 
position. This way, when the end of one cycle is hooked up to the beginning of the next, the action 
continues smoothly.

Scrolling a background is another example of a cycled action. Commonly, a subject remains in 
one place while the background slides by. A sliding background is easy: Create the background 
image several times wider than the frame. Float the background image and incrementally nudge it 
through the frames with the arrow keys. Refer to the description of animating floaters above.

Color
You might want to create a color set for the animation. Creating a color set helps you better 
control the use of color. For example, you wouldnt want the colors of your characters shifting 
between frames. Using a particular color set prevents this from happening.

Not all colors are video legal. See Applying Art Materials for more information on colors.

You might want to set up an image of each character with annotations to specify which colors to 
use in which areas.

Frame Rate--A Matter of Timing
To understand the process of creating an original animation, you need to look at the implications 
of frame rate. Frame rate describes the number of image frames displayed per second (fps).

If your animations are going no farther than the computer, frame rates of 8, 10, and 12 fps are 
good choices.

If you intend to create your work for NTSC video, 15 fps is a good choice. If youre less concerned 
with quality, you might use 10 fps.

The frame rate of film is 24 fps.

The frame rate of NTSC video is 30 fps (29.97 fps in broadcast video). This is the video 
standard used in the United States

The frame rate of PAL video is 25 fps.

These frame rates are sufficient to produce smooth, continuous motion with filmed or video-
recorded subjects. 

Animation drawings contain far less detail than live-action images. The difference in the level of 
detail allows animations to be produced at frame rates significantly below those designed for live 
action. Because of the smoothness of color fills and continuity between images, animations can 
look quite nice at rates between 10 and 15 frames per second.



Because all of the display devices (movie projectors and VCRs) are built for displaying live-action 
material, animations must be adapted to the live action frame rate. This is traditionally done by 
photographing animation cels on twos. This means that each drawing in the animation appears 
twice in a row. In the case of film, the practical frame rate (what the animation artists create) is 12 
fps, but because its on twos the display rate is still 24 fps.

The    twos    rule is occasionally violated during high-speed action, like falling. When the subject 
moves faster, the eye is more forgiving of changes between drawings. In this case, the drawings 
might be created on threes. The artists create drawings at 8 fps, which are repeated three times 
each to reach the display rate of 24 fps (film).

Conversely, when animators want to show subtle expressions or must move a complex, textured 
image, they might work on ones. Each drawing created corresponds to one film image. This 
wouldnt be done in made for TV animations--only in high-quality films.



Frame Rate and Animations In Painter

Painter is an animation creation tool. You need to consider frame rates to know how many 
drawings are needed to make actions smooth, natural, and consistent throughout the project. 

The computer can display frames at any reasonable rate. Youll define the rate after creating the 
artwork. The Frame Stacks Palette does not provide control over frame display rates. For more 
control over display rates, save the movie as Video for Windows.

When you save as Video for Windows, you can specify the rate of display. This doesnt 
necessarily mean that what you specify is what youll experience. Factors like frame size, 
compression method, and computer speed can prevent some movies from achieving their set 
rate.

You cant display different sections of a movie at different rates. What you can do is create 
sections separately at different rates, then modulate them to the same rate before joining them. 
This is the kind of work youll do in your video-editing application. 



Examining a Typical Animation Project

If you would like to be taken through an animation project step by step, see the Painter for 
Animation lesson in your Tutorial guide. The following section examines techniques for creating a 
professional animation with Painter.

Creating an Animation Frame Stack
Open a new Painter frame stack with the dimensions you want. If you intend to save the 
animation as Video for Windows, then output it to video, you should choose a frame size 
consistent with video: 640 x 480 or 320 x 240 (to be doubled). You only need to start with a 
couple of frames, youll add more later. You may want all five onion-skin layers. As the storage 
type, choose 15-bit color with a 1-bit mask or 24-bit color with an 8-bit mask. Youll need the mask.

Drawing Frames: the extremes and in-betweens
Start by roughing out the animation. Draw the extremes first. Extremes are drawings at the start 
and finish of an action. For example, in the action of reaching to open a door. The extremes are 
(1) standing with the hand at the side and (2) the hand on the doorknob.

Remember, animations usually consist of a foreground image that moves and a background 
image that doesnt. Youre only going to paint the background once, then hold it for the duration of 
the scene. In this rough draft, only sketch the background in the first frame in which appears.
When youve finished creating the extremes for the entire animation, you can go back and start 
filling in the in-betweens. 

Inbetweening
At this point, you must decide on a frame rate. A rate of 12 to 14 frames per second will provide 
excellent motion. Not every PC is fast enough to play a large frame at a high rate. Experiment 
with your system to determine an optimum setup.

Once you begin inbetweening at one rate, you will have difficulty changing.
Decide how long each action should take. You might want to time someone reaching for a 
doorknob to get a better idea. Timing the actions gives you an idea of how many in-between 
drawings you need. 

Animators typically create the sound track first, and then create the images that synch to it. This is 
far easier than working the other way.

You might want to create a detailed script with lots of timing instructions before starting to animate 
in Painter. For example, you decide that it should take three-quarters of a second (0.75 sec) to 
reach for the door. Youre working at a 12 frame per second rate, so you know that it should take 
nine frames (0.75*12=9) to complete the action. The end extreme (the hand on the doorknob) is 
part of those nine, so you know you should space the action across eight in-between frames.
If you are planning a long animation, you can manage memory better by working in segments. 
When each clip is finished, you can add them together.

Add the frames you need for the in-betweens and sketch the important parts of these drawings. 
You dont need to draw the areas that dont change. This draft is just a guideline for the painting.

Use the onion skin (Tracing Paper) to help you space the action across the several frames. In 
general, the spacing of the action between frames should be about the same. This will give a 
smooth action when played. For an advanced technique, you can decrease the increment in the 
frames approaching the end extreme. This will slow the action as it completes. 



Play the movie as often as you like to check smoothness and continuity. As you get closer to 
fixing the number of frames for the animation, you might want to save the frame stack as a Video 
for Windows movie and test the way it plays.

Drawing the Foreground and Background
In separate image files, create a background image for each scene. Youll use these a bit later.

When you are ready to paint the foreground characters, you have a choice of how to proceed. 
You can paint directly into this movie, replacing the rough sketches with final art. Or you can use 
the Tracing Paper feature to paint your final art in a new movie, using the rough-sketched movie 
as a guideline.

You might want to see the background while you work on a frame. Open the background image 
file and set it as the clone source. In the frame stack, you can turn on Tracing Paper and see the 
background ghosted.

Any artistic technique is possible. The common Saturday-morning-cartoon technique uses black 
lines to border shapes that are filled with color. If this is what you have in mind, the following 
suggestions will help you get there:

Create the black lines with a non-grainy brush. You want them solid. 

To fill your shapes, use the Cartoon Cel fill option. This will help avoid aliasing artifacts. 
The Cartoon Cel feature requires you to Auto Mask (by image luminance) the lines before 
filling. To expedite the process, you can record a script and apply it to the movie.

See Applying Art Materials for more information on using Cartoon Cel fill.

When your foreground characters are finished, youre ready to composite them with the 
background. To do this, use the rotoscoping technique. Because your foreground images 
are all on a white background, you can automate the masking by recording an 
appropriate Color Mask script and applying it to the movie. 

When youve cloned the backgrounds around your characters, youre done in Painter. Save the 
movies as Video for Windows so you can open them in your video-editing application to add 
sound and other post-production effects.



Automatic Masking and Scripting for Efficiency

Work with a separate, sample image to determine which masking feature works best with your 
image. You can use Auto Mask or Color Mask. 

When youve determined the settings for the best method, start over. This time, record the 
masking process as a script. When youve finished creating the mask, stop recording. Save the 
script. 

Open the frame stack you wish to mask. Choose Movie menu> Apply Script to Movie. In the 
dialog, select the masking script you saved.
Painter applies that script to each frame in the stack. 



Cloning and Tracing
Cloning is the process of taking data from one image and re-creating it in a new image. For 
example, with cloning you can retouch photographs by removing certain elements from a scene. 
The image you clone from is the clone source. The image you paint on is the clone destination.    
If you are cloning within the same image, the clone source and clone destination are the 
same file. 

With Painters cloning features, you can transform any image--a scanned photo, for example--into 
any art medium you can think of. You can use cloning to:

Trace an original photograph or piece of art to create an entirely new image.
Turn photographs into anything from pencil sketches to oil paintings, based on your brush 
strokes.
Combine elements from many files into one.
Automatically transform part or all of an image into a Natural-Media-style painting.

Cloning is usually accomplished using the Cloning brush variants. These variants are found under 
the Cloning brush in the Brushes Palette. They take color and image information from the clone 
source and reproduce it in the clone destination. The source image is effectively filtered through 
the characteristics of the cloning brush, allowing you to reproduce an original using paper grain, 
or in an artistic style. For example, you can turn a photograph into a painting in the style of Van 
Gogh or Seurat using Painters cloning features.

Cloning is a two-step process. First you set the clone source and then you work in the clone 
destination. The next few sections discuss different ways to set up cloning. Youll learn how to 
clone within a single image, to clone between two images, to work with different brushes in the 
clone document or to let Painter do the cloning for you. Lastly, youll see the special effects you 
can achieve when you base Painters effects on the clone source document. 

For more information on setting the clone source, search on Setting the Clone Source.

See Also
Creating a Clone Document
Making an Existing Document 
a     Clone   
Using AutoClone



Setting the Clone Source

If you want to copy an element within a single image, or duplicate a small element from one file to 
another, you will need to manually set the clone source.

The point at which you click is the origin point for cloning. If you move your brush to the right you 
will clone what is to the right of the origin point.

If you would like to see the source area being cloned, select the checkbox Indicate clone source 
with crosshairs while cloning in the General Preferences dialog (found under the Edit menu). A 
crosshairs will move as you move your brush to indicate what part of the image you are painting 
with. If you are cloning from one file into another, offset the file windows so you can see the 
crosshairs moving on the source while you paint the destination. 

When two or more documents are already open, you can establish one as the source document 
by choosing File menu> Clone Source and choosing the desired document. The active window 
automatically becomes the destination document. You can clone one file into several files by 
opening all the files at once, setting the clone source and then painting into the others.

Painting with the Cloning Brushes
Painting with the cloning brushes is similar to painting with any of Painters tools, except the 
cloning variants take their color information from a clone source instead of the Color Palette.

The Cloning Variants 
The variants of the Cloners brush in the Brushes Palette have been set up to provide the media 
with which youre most likely to want to clone. When you paint in a cloned image with them, they 
pick up color from the original while you control the direction of brush strokes. Many behave like 
their plain brush counterparts--for example, the Chalk Cloner produces the same effect as the 
Artist Pastel Chalk variant of the Chalk brush.

Cloners
You can add to and refine the Cloner variants with Painters other customizing functions that are 
described in Advanced Painting.

The following sections describe the variants in the Cloners variant pop-up menu. See Advanced 
Painting for more information about using the Brush Controls Palette to set up different effects 
with Cloners. 

When working with the Cloners, keep in mind that if you dont like the strokes youve made, you 
can delete them and try again, as long as the original document stays open. You dont remove the 
original image by cloning it.

Felt Pen Cloner
Re-creates felt pen strokes that get darker as you draw. To keep the colors from darkening too 
quickly, move the Opacity slider in the Controls: Brush Palette to the left.

Pencil Sketch Cloner
Imitates pencil lines. To get a quick-sketch effect with uneven lines, open the Brushes Palette: 
Controls menu> Random and move the Clone Location How Often slider all the way to the left.

Hairy Cloner
Paints like the Hairy Brush variant of the Brush, producing somewhat anti-aliased strokes that 
show the brushs hair lines and react to paper grain. This brush is useful with oil painting. 



Oil Brush Cloner
Gives you anti-aliased brush strokes that hide underlying ones. This is another good brush to use 
with oil painting. Short strokes work best with the Oil Brush Cloner. How quickly you drag the 
mouse or stylus determines the width of the stroke. Drag slowly for thick strokes, quickly for thin 
ones. Oil Brush Cloner

Chalk Cloner
Draws like the Artist Pastel Chalk variant of the Chalk brush.

Hard Oil Cloner
This brush gives you a harsh stroke with a hard edge that interacts with paper grain and hides 
underlying strokes. Its good for oil painting and works best with short strokes. How quickly you 
drag the mouse or stylus determines the width of the stroke. Drag slowly for thick strokes, quickly 
for thin ones. This brush interacts with paper texture. Choose different ones in the Art Materials 
Palette: Paper Palette for unusual results.

Van Gogh Cloner
Paints multicolored brush strokes in the style of Vincent Van Gogh. 

Melt Cloner
Melts an image so that it looks like its dripping, and works the way the Distorto variant in the 
Liquid brush works. When you use this brush with oil painting, it looks like you applied paint with a 
palette knife.

Driving Rain Cloner
This variant clones your image as it would look through a window during a rainstorm.

Straight Cloner
Duplicates the original image without changing it. Simply click and drag in the clone and youll see 
your original image come through. This brush is great for getting back your image if you decide 
you prefer the original to the changes youve made.

Soft Cloner
Gives you airbrush-style strokes that softly return the source image. The edges of the Soft Cloner 
brush are soft, allowing it to blend realistically with an existing background. This variant is a good 
one for cloning between photographs.

Impressionist Cloner
Uses the directions of your brush strokes to place many short dabs in varied colors based on the 
original image.

Using Tracing Paper
After creating a source and clone document, you can set up an on-screen light box using Painters 
Tracing Paper. To use Tracing Paper, the source and clone documents must be the same size. Its 
best if you open the document you wish to trace and choose File menu> Clone to generate the 
destination file.

Alternatives to Tracing Paper
If you don't want to use Tracing Paper to see the image you are tracing, you can work in your 
clone image using other techniques. One alternative is to trace directly on top of your clone 
image. This useful when using Auto Van Gogh. Another possibility is to lighten the entire image to 
use it as a first layer of your work. 



Turning Painters Other Brushes into Cloners
You can turn almost any brush into a Cloner by setting the Use Clone Color option in the 
expanded Color Palette.

Using Clone Color
The Use Clone Color option lets a brush pick up color from the original image while staying true to 
its own nature. Use Clone Color uses a single, averaged color from the source document for each 
brush dab, resulting in an approximation of the original. The Use Clone Color option is a good one 
to use when you are trying to create an artistic impression of an original.

Using Cloning Methods
The Cloning methods give you brush strokes that are closer in nature and color to the source 
document than the Use Clone Color option. Because the cloning methods use a full set of pixels 
from the original document for each brush dab, you get a truer copy of the original than you do 
with Use Clone Color. Also, unlike using clone color, cloning methods preserve the original 
images texture in the clone. Cloning methods are good to use when you want to re-create 
portions of the source image very accurately.

Cloning Methods
Heres a brief description of the cloning methods. For a more in-depth discussion of methods, see 
Advanced Painting.

Hard Cover Cloning
Gives you semi-anti-aliased brush strokes that hide underlying strokes. 

Soft Cover Cloning
Produces anti-aliased brush strokes that cover layered ones.

Grainy Hard Cover Cloning
Works like Hard Cover Cloning but brush strokes also interact with paper grain.

Grainy Soft Cover Cloning
Works like Soft Cover Cloning but brush strokes also interact with paper grain.

Drip Cloning
Pushes color around as if it were wet, cloning the original with distortion based on your stroke.

Fine-Tuning the Cloning Methods
Four settings on the Random Palette, found under the Brushes Palette menu> Controls> 
Random, can affect the results of the cloning methods.

_ Moving the Clone Location: Variability slider to the right softens brush strokes and works 
best with the bristle brushes for creating an impressionistic effect.

_ Moving the Clone Location: Variability slider a bit to the right and the Clone Location: How 
Often slider to the left gives drawing tools a sketchy feel.

_ Clicking Random Clone Source makes the cloning methods randomly pick up pieces from 
the source document. What you get with your brush is random snippets of the image.



_ Clicking Random Brush Stroke Grain makes the cloning methods pick up paper grain at 
random from the current paper grain.

See Advanced Painting for more information about these settings. 



Creating a Clone Document

You can set up an entire document as the clone source. In this case the upper left of the 
document is the origin point for cloning. 

Once you have a clone of your original image, you can use Painters cloning brushes to re-create 
it in a different medium, and you can use Painters special effects to embellish it. 

Keep your original document open while you work in the cloned image to maintain the computer 
link between the two documents. Both files must be open to access the cloning effects.



Making an Existing Document a Clone

After youve worked with cloning a bit, youll want more flexibility in setting up cloning relationships. 
For instance, what if you close your source and clone documents and open them again? Youll 
need to re-establish the link between them when you reopen. What about working with two open 
documents? Cant one be the source and the other the clone? What if you want to reverse 
clones--that is, make a clone into the source document and open the original as the clone?



Using AutoClone

Using a cloning brush can take a long time if youre working on a large area. You can have Painter 
make the strokes for you by using the AutoClone feature. This is an automated process, and it 
may look best if you fill in the details with some of your own brush strokes after running 
AutoClone.

If you apply AutoClone to a large area, the paint may fill smaller rectangular tiles one at a time. If 
you click to stop the AutoClone, it stops where it left off. It wont automatically finish the final tile of 
the overall selected area. To fill in non-rectangular areas, you can use AutoClone with selections. 
For more information, see Selections and Masks.

When you use AutoClone with the Felt Pen Cloner and other tools that turn black as you repeat 
strokes, areas darken rapidly. You can slow down the color buildup and still use AutoClone by 
lowering the Opacity slider on the Controls Palette, or by dimming your original image as 
described in Alternatives to Tracing Paper.

AutoClone works with the Seurat tool in original images, too. Just select the Seurat 
brush:AutoClone andSeurat brush:AutoClone andSeurat brush:AutoClone 
andSeurat brush:AutoClone andSeurat tool, the area and the color you want to fill it with, 
and choose Effects menu> Esoterica menu> AutoClone. Multiple dots will fill the area. This is 
great for creating new textures in color. 

Using Auto Van Gogh
The Effects menu> Esoterica menu> Auto Van Gogh effect works with the Auto Van Gogh variant 
of the Artists brush. This algorithmic approach to placing directional brush strokes results in a Van 
Gogh-like rendition of an image.
The effect requires two passes. When applied, your image will be rendered in a set of 
directionalized brush strokes.

Embossing
You can make a clone document look like it was embossed using Painters Apply Surface Texture 
effect with the Using pop-up set to Image Luminance. Painter uses the brightness of the source 
document--to create the surface texture in the clone. 




